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Notice

Oslo, 13-December-2019

Visma Document Center 14.10.0

All information in this documentation may be changed without warning and does not represent an obligation
on the part of the manufacturer.

All material in this documentation and the programs it concerns are protected by copyright legislation and
the specially entered into Agreement concerning usage rights and maintenance. All rights to this material are
the property of Visma Software International AS. Any copying or duplication of the material in this book,
including without limitations, text, screen appearance, icons or methods, is prohibited.

As part of its continuous development of the system, Visma Software International AS may change the
composition of packages, modules and functions. Visma Software International AS waives any responsibility
for any errors or omissions in the system, apart from what is clearly described in the current Agreement on
usage rights and maintenance. Use of the system on other computers than the system is licensed for is illegal
and will be reported to the police and compensation will be claimed.



Introduction

This News and Improvements document, includes information about new and changed features, fixed issues
and known issues or limitations in this latest version of Visma Document Center.

We recommend that you read through the document so that you are familiar with the changes that have been
made in this version before you start using it.

It is especially important that you read the Installation guide before you upgrade.

Visma application compatibility
When you are installing multiple Visma products you must make sure they are compatible.

Visma Business product line compatibility

Visma Business, Visma Reporting, Visma Document Center, Visma ERP POS and Visma User Directory are all a
part of the Visma Business product line. Within the product line all products with the same major version number are
compatible.

The version numbers for all products in the product line consists of major, minor and patch number separated by
periods.

When installing more than one of the products in the product line, the major version and the first digit of the minor
version of the products must be the same.

I.e. Visma Business 13.10.0 will work together with Visma Document Center 13.10.2, but the compatibility of Visma
Business 14.00.0 and Visma Document Center 13.00.0 is not supported.

Other Visma applications compatibility

When you install Visma Document Center version 14.00.0 you must upgrade your other Visma products to the
following versions or later.

Application Version Comment

Visma Global 13.13 (14.00 if using VUD) Visma Global 11.15.0 is not
compatible with VUD 12.00

Visma Nova 9.8

Visma User Directory 14.00

AccountView 9.7 service pack A

Visma Contracting 13.00.02 and 13.10

Platform compatibility

Application Version Comment

Windows Server 2016, 2019

MS SQL Server 2014, 2016,2017,2019 • Currently, SQL Server is the only
database system supported by
Visma Document Center.

Windows 8.1, 10

Note:  Refer also to the software compatibility documented for the integrated ERP. This may vary between
Visma Business, Visma Global, Visma Contracting and Visma Nova.
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.NET

Required versions of .NET are shown in the table below.

Component .NET requirements

Visma Document Center Required version: 4.6

Network

Visma Document Center requires a TCP/IP network.

Port: It is possible to run Visma Document Center and the ERP system on separate machines. This requires ports to be
opened in the firewall (port forwarding). Default port for Visma Document Center is 2001.

Network domains

The machines running Visma Document Center server and clients must be registered in the same domain.

Resource Access Control (RAC)

• RAC is only supported when Visma Document Center is integrated with Visma Global version 7.80.1 and later.

Note:

If you enable RAC after you have started using Visma Global and Visma Document Center then there is an
issue with synchronizing users between Visma Global user table, and Visma Document Center user table. This
is because the userID has changed in RAC. You must map the user and user role in Visma Document Center
after enabling RAC. All historical user information will be incorrect.

Companies created after enabling RAC are not affected.



Chapter

1
Visma Document Center 14.10.0

Topics:

• New features 14.10.0
• Improvements 14.10.0
• Known Issues, Limitations

& Restrictions 14.10.0

In version 14.10.0 of Visma Document Center we have introduced a
number of new features, implemented a number of important bug fixes and
made some other improvements which are described in this section.
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New features 14.10.0

Common Visma Document Center

Support for PEPPOL BIS 3
Full support for the receipt, interpretation and display of XML invoices using the PEPPOL BIS 3 format has
been implemented. A default PEPPOL BIS 3 stylesheet will be applied.

Note:  The PEPPOL BIS 3 format eliminates the VAT amount from the invoice line. VDC
will calculate the line level VAT amount.

Check supplier against VAT registry
If an invoice issuer is not in the governmental VAT registry, the issuer is not allowed to collect VAT, and the
receiver is not allowed to deduct VAT. This feature will make you aware of invoices containing VAT but the
supplier is not allowed to collect VAT.

The check occurs during interpretation for invoices containing VAT. The check is not restricted to invoices
received through Visma AutoInvoice but includes invoices received manually and through auto-import.
The results of the VAT check will be recorded as a comment on the invoice. For Visma Approval users this
comment will appear as an alert/comment.

This feature is valid for Norway, Sweden, Finland and Denmark. This feature is only available if VDC is
integrated with Visma AutoInvoice. By default this feature is not enabled. To enable the feature check the
box labeled Enable VAT registry check of supplier found on the General tab of the Tools/System
settings/Preferences form.

Display document origin on the document list
Often times both an XML rendered invoice and an image of the invoice is available in VDC. (Image files
include PDF’s JPEG, TIFF and other image files.) It was not clear which document should be considered
the “original” sent by the supplier. An Origin column has been added to the Document list indicating which
invoice document is the supplier’s original. The value will either be XML or Image. Note: The value Not
set will appear on invoices received prior to this feature.

Alert if supplier bank account doesn’t match invoice
When an incoming invoice/credit note is interpreted, the supplier's bank account number from the document
is compared with bank account number associated with the supplier in the ERP system. If there is a
mismatch between the document and ERP then this is flagged.

Previously the accountant only saw this alert on the interpretation results form. This was very inefficient
as the accountant must scroll through the document list opening the interpretation results form for each
document to see if there is an issue with the bank accounts. To improve this process the bank account
mismatch condition is viewable from the document list. An orange warning triangle will now appear in the
Document list against invoices whose bank account does not match. The warning triangle will disappear
once the mismatch is corrected.

Note:  Interpretation must be performed before any mismatches of bank accounts can
be determined. If either the bank account or the supplier are missing, the bank account
mismatch indicator is not displayed.

Visma Business product line

Use the new Update Supplier Transaction processing if voucher uses interim account
If a batch contains an interim GL account number then the batch should not be updated using the standard
Visma Business batch update process. The batch should instead be updated using the update Supplier
Transaction processing process in Visma Business.

This will be controlled by a new setting called Enable update Supplier Transaction processing found
on the General tab of the Tools/Preferences form. This new setting is used in combination with the
existing Automatic batch update setting.
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The following table describes which process is run in Visma Business based on the setting configuration.
(Refer to the Visma Business documentation for further details of the different processes.)

Table 1: Automatic Update Settings

Automatic
batch
update

Enable
automatic
update
supplier
transactions

Processing used

Y Y The processing is split based on a check for interim accounts on all invoice
lines.

• Invoices with final booking (no interim accounts used) will transfer with
the Standard batch update process.

• Invoices containing an interim account on any line will use the Supplier
Transaction process

Y N • Invoices with final booking (no interim accounts used) will be
transferred with update batch.

• Invoices containing an interim account will be transferred without
update (transferred but not updated).

N Y All invoices use the Supplier Transaction process. No check for interim
accounts are performed.

N N No automatic updates performed

Order match based on supplier setting in Visma Business
Individual suppliers can be excluded from the automatic order match by configuring a new order match
setting found on the Supplier options form in Visma Business. It is set by checking the box labeled Do
not run automatic order match. Automatic order match is enabled in VDC by checking the Perform
automatic order match for supported document box found on the Order match tab of the Tools/
Preferences form.

Visma.net AutoPay view document feature support
Visma.net AutoPay will be offering the ability to view the invoice image. This feature is only available
if Visma Document Center version 14.10 or higher is used along with Visma.net Approval and Visma
Business.

Visma Nova

Create suppliers from Visma Document Center

VDC will now automatically create suppliers in Visma Nova if a supplier can not be found for an incoming
invoice. VDC must be able to interpret both the organization number and bank account number before
creating the supplier. If the supplier name could not be interpreted, then a generic name is assigned
indicating the supplier was automatically created.

A "New supplier - please review!" comment is added to the invoice that triggered the supplier creation. This
comment will be visible in Visma Approval.

The automatic creation of suppliers is turned on at the company level by checking the Automatic supplier
creation checkbox (Tools > System settings > General tab).

A supplier can also be created manually by clicking the New Supplier button found at the bottom of the
Interpretation Results screen.

Suppliers can only be created through the new supplier window. Any editing of existing suppliers must
be done through Visma Nova. A supplier can be created if there is an existing supplier with the same
organization number or bank account but not both.
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Visma Global

Create suppliers from Visma Document Center

VDC will now automatically create suppliers in Visma Global if one can not be found for an incoming
invoice. VDC must be able to interpret both the organization number and bank account number before
creating the supplier. If the supplier name could not be interpreted, then a generic name is assigned
indicating the supplier was automatically created.

A "New supplier - please review!" comment is added to the invoice that triggered the supplier creation. This
comment will be visible in Visma Approval.

The automatic creation of suppliers is turned on at the company level by checking the Automatic supplier
creation checkbox (Tools > System settings > General tab).

A supplier can also be created manually by clicking the New Supplier button found at the bottom of the
Interpretation Results screen.

Note: Suppliers can only be created through the new supplier window. Any editing of existing suppliers
must be done through Visma Global.

Improvements 14.10.0

General

Accounting grid - cursor jumping to next line on enter in voucher date
There was an error related to accounting grid where the cursor was jumping to next row instead of next
column. This is now fixed.

One Of The Group Approves
The One Of The Group Approves setting was not working properly causing the flow to wait for additional
approvers. This is now fixed.

VDC Approval form changes
The Approve Document form has been simplified for those using the approval flow within VDC. The Role/
Referrer table has been removed.

Issue with importing XML and PDF documents
The manual import process was not linking the XML and PDF files connected to the same document. This
should occur when the XML and PDF have the same filenames. This is now fixed.

Scanning options not working
The following scanning options available in the "Documents" folder have been fixed:

• Append
• Insert
• Replace

Ctrl-Enter doesn't set the right approver
There was a scenario where changing a cost unit with an assigned responsible and then use Ctrl-Enter to
send it on flow would result in the original approver getting the document. This is now fixed.

Incorrect currency code
There was a scenario where the incorrect currency code would display in the bottom right hand corner of
the screen. The problem occurred if the server and clients were installed in different countries with differing
currencies. This is now fixed.

Merge document shortcut Alt+S enabled
The Alt+S combination now works for all languages.

OCR template with OCR.English gives wrong date format
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When using OCR.English and templates for interpretation of date, the date is formatted as US English with
mm.dd.yyyy instead of dd.mm.yyyy. This behavior only occurred when using a template. This is now fixed.

Not possible to Interpret invoice number with 2 digits
It was not possible to interpret invoice numbers containing only 2 digits. This applied only when using the
Swedish OCR language. This is now fixed.

Country code in the create supplier window
The country description has been added to the country code drop-down list in the create supplier form. Also
the postal code has been moved to before the city.

Amount excluding VAT added to report
The Documents on flow per person report now also displays the amount excluding VAT.

Attach files to documents from within the ERP
From within the ERP (Visma Business, Visma Global,Visma Nova) you can either import a new document
into VDC or attach a file to an existing document.

Issue with large attachments
There was a scenario where selecting a document in the document list would hang if the document
contained multiple large attachments. This is now fixed.

Upgraded TLS support
Following Microsoft's Transport Layer Security (TLS) best practices with the .NET Framework, Document
Center is now able to run in and interact with environments where TLS 1.0 is disabled.

Visma Business

Error message when opening document viewer from Visma Business
There was a scenario where an error would occur if the ERP client was changed while the document viewer
was open and undocked from the ERP. This has been fixed.

Document viewer language
When starting the Document Viewer from Visma Business, it will now display in the same language as set
in Visma Business.

Visma Global

Amount excluding VAT is not updated
The amount excluding VAT was not updated when entering a GL account with a VAT code. This is now
fixed.

Reading the client name from Global
The client name displayed in VDC has been changed to show the display name set in Visma Global.

Visma Contracting

Import and interpretation of Autofakt invoices
There was an issue where Autofakt invoices imported from Visma Contracting did not get a debit GL
account assigned from the ERP’s voucher type. This is now fixed.

Use Phase/Point sent from Visma Contracting on the accounting line
There was a scenario where Autofakt invoices received from Visma Contracting would not get the Phase/
Point properly updated on the accounting line. This is now fixed.

Check for recharge during interpretation
When interpreting an invoice the check for recharge will stay on regardless of the order status.

Visma Nova

Invoice reference and Nova AP (SDK)
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The invoice reference now sets the Purchase Note field in Nova purchasing.

Known Issues, Limitations & Restrictions 14.10.0
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in the "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Restart of Visma Document Center server
It is not recommended to restart the Visma Document Center server. If you need to restart, it is
recommended to stop and then start it again.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exists, then
it will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Visma User Directory

Upgrade when VUD active
Active companies will not be visible in Select ERP client form after upgrade, unless you manually add the
companies in VUD management console > Application instances > Registered companies.
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AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents causes an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.6
The platform has been updated to use Microsoft .NET Framework 4.6. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.

Adobe PDF Reader

PDF invoice opens outside of Visma Document Center
If you encounter the PDF document opening outside of Visma Document Center when clicked on then this
may indicate that the Adobe reader plug-in for Internet Explorer has crashed. A solution is to restart the
computer. If this does not fix the issue then a re-installation of Adobe Reader should solve the issue.

PDF invoice opens download window
If clicking on a PDF document triggers the file download window then the Adobe reader may not be seen
as the default program for opening PDF files. If Adobe Reader was recently reinstalled the computer
should be restarted or the user can go to the Windows Control Panel and choose Programs>Default
Programs>Associate a file type or protocol with a program and scroll down
to .PDF. Select Adobe Reader as the default program
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Chapter

2
Visma Document Center 14.01.1

Topics:

• Improvements 14.01.1
• Known Issues, Limitations

& Restrictions 14.01.1

In version 14.01.1 of Visma Document Center implemented a number
of important bug fixes and made some other improvements which are
described in this section.
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Improvements 14.01.1

General

OCR/interpretation improvements
Several issues in the OCR/interpretation process has been fixed. These include improving getting invoice
dates and organization numbers from PDF documents and interpreting bank account numbers from Dutch/
international invoices.

Document viewer related error when changing company
The VDC client would throw an exception when switching companies while having an undocked viewer
open. This would also prevent the workflow recipient list from refreshing properly. This has been fixed.

VDC client stops working, error value cannot be null
There was a scenario where the accountant would get an error due to a null value. This has been fixed.

Known Issues, Limitations & Restrictions 14.01.1
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in the "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Restart of Visma Document Center server
It is not recommended to restart the Visma Document Center server. If you need to restart, it is
recommended to stop and then start it again.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exists, then
it will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.
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Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Visma User Directory

Upgrade when VUD active
Active companies will not be visible in Select ERP client form after upgrade, unless you manually add the
companies in VUD management console > Application instances > Registered companies.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents causes an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.6
The platform has been updated to use Microsoft .NET Framework 4.6. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.

Adobe PDF Reader

PDF invoice opens outside of Visma Document Center
If you encounter the PDF document opening outside of Visma Document Center when clicked on then this
may indicate that the Adobe reader pluggin for Internet Explorer has crashed. A solution is to restart the
computer. If this does not fix the issue then a re-installation of Adobe Reader should solve the issue.

PDF invoice opens download window
If clicking on a PDF document triggers the file download window then the Adobe reader may not be seen
as the default program for opening PDF files. If Adobe Reader was recently reinstalled the computer
should be restarted or the user can go to the Windows Control Panel and choose Programs>Default
Programs>Associate a file type or protocol with a program and scroll down
to .PDF. Select Adobe Reader as the default program
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In version 14.01.0 of Visma Document Center we have introduced a
number of new features, implemented a number of important bug fixes and
made some other improvements which are described in this section.
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New features 14.01.0

Common Visma Document Center

Warning during VDC server upgrade if SQL authentication is not default

To encourage the best practice of using SQL password authentication with an encrypted password, a
warning is displayed if windows authentication is set as default in the server installer.

If the Use Windows Authentication option is checked then the following dialog is displayed when clicking
"next" in the Database settings configuration page.

Recommended database authentication is Password authentication with encrypted password. This is
currently not enabled. Do you wish to continue? Yes/No

• Clicking Yes will advance to the next installation page
• Clicking No will keep the user on this page allowing changes in the set-up

Visma Business product line

AutoFlow handling of new bank account numbers from supplier invoices

Until now, invoices which are received with bank account numbers which differ from what is found on the
supplier are prevented from being automatically sent for approval using AutoFlow rules.

Enabling this new feature allows an invoice with a differing bank account number to be sent on AutoFlow
allowing the approver to review the new bank account (in Visma Approval).

When the invoice bank account does not match the bank account on supplier (Visma Business) then:

• A comment is created stating: "New bank account" (this will be viewed in approval)
• The invoice is sent for approval (via AutoFlow rules)
• The bank account on the supplier is updated ONLY if the invoice is received approved from Visma.net

Approval. If the invoice is rejected then the supplier is not updated.

This feature is controlled by a new setting on the AutoFlow configuration window.

Approving payments in Visma.net Approval
Visma.net Approval will be providing the ability to approve payments while approving the invoice. To use
this feature version 14.01 or higher of the Visma Business product line must be installed. This includes
Visma Document Center version 14.01 or higher.

Visma Contracting

Transfer invoices lines with zero amount in product lines to Visma Contracting
Lines with a zero amount on XML interpreted lines can now be sent to Visma Contracting. The feature is
enabled when the Allow zero amount invoice checkbox is set in the System settings > General
tab.

Improvements 14.01.0

General

Interpreting the company registration number
For some invoices it was not possible to interpret the company registration number as the organization
number. This has now been corrected.
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OmniPage updated
The OmniPage OCR component has been upgraded solving some PDF import issues including problems
with interpretation and display of values.

Restricted archive access for approvers
There was a scenario where an approver could view documents in the archive which the approver was not
part of the workflow. This has now been corrected.

Invoice date is not interpreted correctly
We now check that the interpreted invoice date is not later than the current date.

Missing rule GL account name in Autoflow Rule configurator
In the Autoflow Rule Configurator table the Supplier Name and Cost Unit name are not displayed, only the
GL account number is shown. This has been fixed. The GL account number and the name in brackets [ ] are
now displayed.

Dialog box heading missing from Creating a flow-group
When creating a new flow-group the heading was missing from the dialog box. This has now been
corrected. The default positioning of the cursor has also been improved.

Logon option removed
The feature labeled Log on under the File menu has been removed. The Ctrl-L shortcut has also been
disabled. The feature is rarely used and provides little benefit and in some cases can cause issues. (Similar
feature has been removed from Visma Business and VUD).

File-> print not working
The print option under the File menu stopped working, This is now fixed.

Automatic OCR and interpret after document import not working for XML
Automatic OCR and interpret would not run after manual document import even though the default setting
was automatic interpretation. This is now fixed.

DoAction command in document menu
The recipient has the option to approve or review a document using the functionality from Processing menu.
This option has been renamed from DoAction to Handle document in order to be more intuitive.

Splitting documents in VDC
There was a scenario where splitting documents with many pages would result in large TIFF files which
would impact performance. This has been fixed.

Documents with many attachments are not going to Visma.net Approval
Documents with many or large attachments did not always arrive in Visma.net Approval. This has been
fixed.

Documents coming from Visma.net Approval with 0 amount
Some order match documents were returning from Visma.net Approval with 0 amounts or missing lines.
This has been fixed.

Client installer crashes on Verify
Clicking the Verify button during the client installation would cause the process to crash. This has been
fixed.

Send on flow errors
An error would sometimes occur when sending a document on flow (often using the Ctrl-Enter shortcut). A
message indicating a failure to save the row would appear along with an exception which closes the client.
This has been fixed.

Visma Business

Deleting documents from the Visma Business document viewer
If multiple documents are imported into the document viewer and then the user tries to delete the second
document it is the first document that is actually deleted. This has now been corrected.

Change of voucher date did not update the exchange rate
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There was a scenario where changing the voucher date did not get the currency exchange rate in effect on
that date. This has been fixed.

Country select when creating a supplier
The country can now be selected from a drop-down selector.

Error message when changing ERP client
There was a scenario where an error would occur if the ERP client was changed while the document viewer
was open and undocked from the interpretation results screen. This has been fixed.

VDC window causing Visma Business to crash
If VDC was opened from Visma Business and then the e-mail client started, then Visma Business could
crash if the VDC window was closed prior to the e-mail client closing. This has been fixed.

Visma Global

Error upgrading sysdb

Script sysdb0186 and sysdb0191 fails with a syntax error on database names that starts with a
number. This has been fixed

Visma Contracting

Assigning accounts with line import
There was a scenario where account numbers were incorrectly assigned with line import. This has been
fixed.

Assigning accounts to lines with negative values
There was a scenario where account numbers were incorrectly assigned when the line amount was negative.
This has been fixed.

Recalculate vat amount when vat code is changed.
You are allowed to change the VAT code on an accounting line. However when you changed the VAT code
to one with a different VAT % the VAT amount was not recalculated. This has been fixed.

Known Issues, Limitations & Restrictions 14.01.0
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in the "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Restart of Visma Document Center server
It is not recommended to restart the Visma Document Center server. If you need to restart, it is
recommended to stop and then start it again.
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SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exists, then
it will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Visma User Directory

Upgrade when VUD active
Active companies will not be visible in Select ERP client form after upgrade, unless you manually add the
companies in VUD management console > Application instances > Registered companies.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents causes an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.6
The platform has been updated to use Microsoft .NET Framework 4.6. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.

Adobe PDF Reader

PDF invoice opens outside of Visma Document Center
If you encounter the PDF document opening outside of Visma Document Center when clicked on then this
may indicate that the Adobe reader pluggin for Internet Explorer has crashed. A solution is to restart the
computer. If this does not fix the issue then a re-installation of Adobe Reader should solve the issue.
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PDF invoice opens download window
If clicking on a PDF document triggers the file download window then the Adobe reader may not be seen
as the default program for opening PDF files. If Adobe Reader was recently reinstalled the computer
should be restarted or the user can go to the Windows Control Panel and choose Programs>Default
Programs>Associate a file type or protocol with a program and scroll down
to .PDF. Select Adobe Reader as the default program
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In version 14.00.0 of Visma Document Center we have introduced a
number of new features, implemented a number of important bug fixes and
made some other improvements which are described in this section.
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New features 14.00.0
This section provides an overview of new features found in this latest release of Visma Document Center.
Please read carefully as core functionality has has been improved with new features.

Common Visma Document Center

Priority of AutoFlow rule types are now configurable

AutoFlow is an automated workflow functionality that enables the creation of a workflow automatically,
based on rules that are configured by a user. These rules can be associated to a Supplier, a Cost Unit or an
Invoice Reference.

Previously, the prioritization of these rules were hard-coded and could not be modified by a user. This
inflexibility may result in a less optimal prioritization. Another issues was that individual cost unit types
could not be prioritized. For example, often a cost unit type such as department or project should be
evaluated before suppliers.

The accountant can now set the priority in which AutoFlow rules are evaluated and are able to prioritize
individual cost unit types.

To set the priorities select the System menu and select AutoFlow and then Priorities. The rule type priorities
window will appear showing a line for each AutoFlow rule type (supplier, invoice reference and each cost
unit type). Clicking on a priority will allow you to select a priority from a dropdown. Priority 1 will have
the highest priority while 14 will have the lowest. AutoFlow rule types with a value of 0 are inactive.

Unique roles in VUD
Changes have been made in Visma User Directory where all roles will have names unique to each
application. Visma Document Center will have role names prefixed with Visma Document Center.

Progress indicator added to VUD data export/import
When enabling or disabling Visma User Directory from Visma Document Center data is either imported
or exported. For large installations this may take several hours. The added progress indicator will display
progress for this process.

Implemented improved style sheet for OIOUBL
An improved style sheet has been implemented for OIOUBL XML based invoices.

Credit notes sent to Visma Approval shall be identified as credit notes
Visma Document Center will send credit notes to Visma Approval with negative values. This will allow
Visma Approval to better identify credit notes apart from invoices.

External Archive Attachments
Any attachments are now also exported to the external archive.

Shortcut to move between documents while editing accounting grid
You are now able to maintain focus on the accounting grid while also moving through the document list.
While maintaining focus on the accounting grid:

• Press CTRL+4 to move down the Document List and load the next document's accounting grid.

• Press CTRL+5 to move up the Document List and load the next document's accounting grid.

• The View on the Document Viewer will remain as the last user selected view

Copying items (accounting numbers) to multiple accounting lines
Copying a value from one line to many lines in the accounting grid is now possible.

Using multiple screens
When users went to using fewer screens, some pop-up windows were no longer visible. This has now been
corrected.

Visma Business product line

Approve payments in Visma.net Approval
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Visma.net Approval will add a feature where the approver may also approve payment of the invoice through
Visma AutoPay. This feature is only available if you use Visma.net Approval and not through Visma
Document Center's workflow.

Note: To be able to use this feature in Visma.net Approval you must use Visma Document Center version
14.00 or higher.

Create suppliers from Visma Document Center

VDC will now automatically create suppliers in Visma Business if one can not be found for an incoming
invoice. VDC must be able to interpret both the organization number and bank account number before
creating the supplier. If the supplier name could not be interpreted, then a generic name is assigned
indicating the supplier was automatically created.

A "New supplier - please review!" comment is added to the invoice that triggered the supplier creation. This
comment will be visible in Visma Approval.

The automatic creation of suppliers is turned on at the company level by checking the Automatic supplier
creation checkbox (Tools > System settings > General tab).

A supplier can also be created manually by clicking the "New Supplier" button found at the bottom of the
Interpretation Results screen.

Note: Suppliers can only be created through the new supplier window. Any editing of existing suppliers
must be done through Visma Business.

Use interim GL account from Visma Business

Visma Business has added an Interim cost account field to their company data. If a default cost account is
not found on the voucher type or supplier cross account, then the company interim cost account will be used
if populated. Using an interim cost account will allow you to transfer vouchers to Visma Business without
needing to determine the final posting accounts. It is recommended that automatic batch updates is turned
off.

Handling other document types from Visma Scanner app

Visma Scanner will be offering the ability to take a picture of any type of document and send it to Visma
Business via AutoInvoice and Document Center. This opens a new avenue for accounting office clients to
communicate documents other than invoices and credit notes with their accountants. These documents will
transfer automatically to Visma Business with no action required in Document Center.

Note: To be able to use this feature in Visma Scanner you must use Visma Document Center version 14.00
or higher.

Improvements 14.00.0

General

Not able to Reset Notification Count for multiple suppliers

You are now able to select multiple suppliers and reset their notification counts at once in the Supplier
Activation for Electronic Invoices window.

Comment toggle button fixed

Clicking the comment toggle button will hide/display system generated comments. User created comments
are always displayed.

Sorting in the 'Select ERP Client' dialog window

There was an issue where you were unable to sort on the 'To Visma Approval' column in the 'Select ERP
Client' dialog. This is now fixed.

Stop converting files from Approval client upload

Attachments uploaded from Visma.net Approval are no longer converted to a TIFF format.
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Columns in Accounting grid not redisplayed
There was an issue where the cost unit column was not correctly displayed when going from one company
to another. This is now fixed.

Visma Global

Database upgrade fails
Databases with the characters ( ) in the name could not be successfully upgraded. This has now been fixed.

Known Issues, Limitations & Restrictions 14.00.0
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in the "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Restart of Visma Document Center server
It is not recommended to restart the Visma Document Center server. If you need to restart, it is
recommended to stop and then start it again.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exists, then
it will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".
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Visma User Directory

Upgrade when VUD active
Active companies will not be visible in Select ERP client form after upgrade, unless you manually add the
companies in VUD management console > Application instances > Registered companies.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents causes an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.6
The platform has been updated to use Microsoft .NET Framework 4.6. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.

Adobe PDF Reader

PDF invoice opens outside of Visma Document Center
If you encounter the PDF document opening outside of Visma Document Center when clicked on then this
may indicate that the Adobe reader pluggin for Internet Explorer has crashed. A solution is to restart the
computer. If this does not fix the issue then a re-installation of Adobe Reader should solve the issue.

PDF invoice opens download window
If clicking on a PDF document triggers the file download window then the Adobe reader may not be seen
as the default program for opening PDF files. If Adobe Reader was recently reinstalled the computer
should be restarted or the user can go to the Windows Control Panel and choose Programs>Default
Programs>Associate a file type or protocol with a program and scroll down
to .PDF. Select Adobe Reader as the default program
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In version 13.10.3 of Visma Document Center we have introduced a
number of new features, implemented a number of important bug fixes and
made some other improvements which are described in this section.
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Improvements 13.10.3

General

VBPL logging enabled by default
The VBPL tracing log is now enabled by default. It is based on a key added in the server config file.

Error message when sending on flow
The user would sometimes get an error stating that the row was updated or deleted by another transaction.
This is now fixed.

Slow scrolling when TIFF encountered
Scrolling through the document slowed considerably when a TIFF document was encountered. This is now
fixed.

Warnings and error texts in Norwegian
Warnings and error texts were displayed in Norwegian regardless of the language used in the screens. This
has now been fixed.

Autoflow window slow to open
Some have experienced a delay when trying to open the autoflow window. This has been fixed.

New batch validation error message
Improved error messaging when VDC gets empty response from Visma Business batch validation.

Configuring AutoFlow slow
Configuring AutoFlow rules performed very slowly if many cost units were configured. This has been
corrected.

External Archive Attachments
Any attachments are now also exported to the external archive.

Visma Global

Database upgrade fails
Databases with the characters ( ) in the name could not be successfully upgraded. This has now been fixed.

Visma Nova

VDC does not remember the invoice view selected in the order form window.
When a user opened the Order form window, the program did not remember the invoice view selected by
the user, but always opened the xml file view. This has been corrected.

Known Issues, Limitations & Restrictions 13.10.3
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in the "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
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There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Restart of Visma Document Center server
It is not recommended to restart the Visma Document Center server. If you need to restart, it is
recommended to stop and then start it again.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exists, then
it will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Visma User Directory

Upgrade when VUD active
Active companies will not be visible in Select ERP client form after upgrade, unless you manually add the
companies in VUD management console > Application instances > Registered companies.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents causes an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.6
The platform has been updated to use Microsoft .NET Framework 4.6. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.



Visma Software International AS | Visma Document Center 13.10.3

© Visma Software International AS | 33

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.

Adobe PDF Reader

PDF invoice opens outside of Visma Document Center
If you encounter the PDF document opening outside of Visma Document Center when clicked on then this
may indicate that the Adobe reader pluggin for Internet Explorer has crashed. A solution is to restart the
computer. If this does not fix the issue then a re-installation of Adobe Reader should solve the issue.

PDF invoice opens download window
If clicking on a PDF document triggers the file download window then the Adobe reader may not be seen
as the default program for opening PDF files. If Adobe Reader was recently reinstalled the computer
should be restarted or the user can go to the Windows Control Panel and choose Programs>Default
Programs>Associate a file type or protocol with a program and scroll down
to .PDF. Select Adobe Reader as the default program
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Chapter

6
Visma Document Center 13.10.2

Topics:

• Improvements 13.10.2
• Known Issues, Limitations

& Restrictions 13.10.2

In version 13.10.2 of Visma Document Center we have introduced a
number of new features, implemented a number of important bug fixes and
made some other improvements which are described in this section.
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Improvements 13.10.2

General

Server Manager shows DB password and system password as clear text
The Server Manager tool (\Server\Visma.Workflow.ServerManager.exe) that can be used for changing
password could also display the password. The password field had an eye-icon that displayed the password
as clear text. A user with access to the \Server folder would be able to see the password both for the
Database user and the Visma Business system user. This has been changed so the user is not able to see the
password.

Make SQL authentication the default
For new installations, the default database authentication has been changed from Windows authentication to
SQL Server authentication. For upgrades the current setting is the default.

Templates not working for automatic interpretation
There was a scenario where the invoice was not always interpreted using the templates during automated
interpretation. This has now been corrected.

Known Issues, Limitations & Restrictions 13.10.2
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in the "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Restart of Visma Document Center server
It is not recommended to restart the Visma Document Center server. If you need to restart, it is
recommended to stop and then start it again.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

Voucher type and organizational number search
When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.
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For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exists, then
it will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues
In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Visma User Directory

Upgrade when VUD active
Active companies will not be visible in Select ERP client form after upgrade, unless you manually add the
companies in VUD management console > Application instances > Registered companies.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents causes an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.6
The platform has been updated to use Microsoft .NET Framework 4.6. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.

Adobe PDF Reader

PDF invoice opens outside of Visma Document Center
If you encounter the PDF document opening outside of Visma Document Center when clicked on then this
may indicate that the Adobe reader pluggin for Internet Explorer has crashed. A solution is to restart the
computer. If this does not fix the issue then a re-installation of Adobe Reader should solve the issue.

PDF invoice opens download window
If clicking on a PDF document triggers the file download window then the Adobe reader may not be seen
as the default program for opening PDF files. If Adobe Reader was recently reinstalled the computer
should be restarted or the user can go to the Windows Control Panel and choose Programs>Default
Programs>Associate a file type or protocol with a program and scroll down
to .PDF. Select Adobe Reader as the default program
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In version 13.10.1 of Visma Document Center we have introduced a
number of new features, implemented a number of important bug fixes and
made some other improvements which are described in this section.
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Improvements 13.10.1

Document Viewer

Ability to merge PDF files
Previously only image documents could be merged. Now PDF files can be merged with other PDF's or
image files. The steps to merge documents have not changed.

Note:  Merging files will result in a TIFF file format. XML files cannot be merged.

Make attachments from documents in the document list
Often times many different documents are imported from the autoimport folder or dropped in the manual
import. These include both invoices and supporting documents which should be attached to the invoice.
However they all appear as individual documents in the document list. Now you are able to make selected
documents attachments to an invoice document.

To make a document in the document list an attachment:

1. Select one or more documents from the document list
2. Right-click the document and from the menu choose: Edit document\Make attachment (You

can also click Edit from the menu bar and select Make attachment)
3. A new Attach documents window is displayed which contains the selected documents (similar to the

Document merge window)
4. The first document in the list is the target document and will remain as an invoice in the document list.

Subsequent documents in the list will be moved as attachments to the target document and be removed
from the VDC document list.

5. Click the "Attach" button to execute the operation

Other options available in the Make attachment window include:

• View a document in the viewer by selecting a document in the left panel
• Change the order of the documents and target using the up and down buttons
• Add documents by clicking the "+" button
• Remove documents by clicking the "-" button
• Close the window without making any changes by clicking the "Cancel" button

Improvements with attaching documents
A button has been added to the attachment viewer which will open the file browse window allowing you to
select a file to attach.

If the document has existing attachments then you can drag-n-drop the file to the attachment list panel or
right-click on the panel which will display a context menu with an Add option. Clicking Add will open the
file browse window.

Indicate the existence of attachments on a document
Previously you would need to click the attachment button to check if any attachments existed for a
document. This was too inefficient when many invoices are being processed in the document list. Now the
number of attachments will appear on the attachment button.

Drag & drop attachment directly from MS-Outlook
There was an issue where you could not drag an attachment from an MS-Outlook e-mail and drop it on the
attachment panel. This has now been corrected.

Convert a document to a modifiable format (TIFF)
The accountant may find themselves in a situation where they need to manipulate a document in the
document list which can only done with files in a TIFF format (set first page, delete page, etc...). Giving the
accountant the ability to convert a document to TIFF will allow better handling of the process.

How to change a document into a TIFF file

1. Select one or more documents from the document list
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2. Right-click the document and from the menu choose: Edit document\Make modifiable (You can also
click Edit from the menu bar and select Make modifiable)

3. A warning is displayed: This operation will convert all documents to an image format (TIFF)
4. Click the "OK" button to complete the conversion operation or click the "Cancel" button to cancel the

conversion operation

General

Issue with splitting TIFF documents
There was a scenario where splitting a multi-page TIFF document resulted in some pages duplicated and
other pages missing. This has now been corrected.

Select ERP client performance issue
There was a performance issue where it was taking too long to display the Select ERP client window. This
has now been corrected.

Error when splitting TIFF's with dividers
There was an issue with splitting TIFF documents with blank pages. A normal split would display an error
and split with divider would not execute. This has now been corrected.

Missing settings after upgrading
After upgrading to 13.10 various settings were missing for the clients. This has now been corrected for
subsequent upgrades.

Errors when scrolling through the document list
Scrolling through the document list would sometimes either freeze or display an error, especially if the
document had many or a large attachment. This has now been corrected.

Known Issues, Limitations & Restrictions 13.10.1
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in the "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Restart of Visma Document Center server
It is not recommended to restart the Visma Document Center server. If you need to restart, it is
recommended to stop and then start it again.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.
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Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exists, then
it will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Visma User Directory

Upgrade when VUD active
Active companies will not be visible in Select ERP client form after upgrade, unless you manually add the
companies in VUD management console > Application instances > Registered companies.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents causes an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.6
The platform has been updated to use Microsoft .NET Framework 4.6. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.

Adobe PDF Reader

PDF invoice opens outside of Visma Document Center
If you encounter the PDF document opening outside of Visma Document Center when clicked on then this
may indicate that the Adobe reader pluggin for Internet Explorer has crashed. A solution is to restart the
computer. If this does not fix the issue then a re-installation of Adobe Reader should solve the issue.

PDF invoice opens download window
If clicking on a PDF document triggers the file download window then the Adobe reader may not be seen
as the default program for opening PDF files. If Adobe Reader was recently reinstalled the computer
should be restarted or the user can go to the Windows Control Panel and choose Programs>Default
Programs>Associate a file type or protocol with a program and scroll down
to .PDF. Select Adobe Reader as the default program
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In version 13.10.0 of Visma Document Center we have introduced a
number of new features, implemented a number of important bug fixes and
made some other improvements which are described in this section.
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New features 13.10.0
This section provides an overview of new features found in this latest release of Visma Document Center.
Please read carefully as core functionality has has been improved with new features.

Invoice import and document viewer

Stop converting documents manually imported or through AutoImport to TIFF file format

Visma Document Center will no longer convert any documents or attachments manually imported or
through AutoImport to TIFF file format. The original document and attachments will be made available to
the user through the viewer.

Improved image viewer

A new document viewer has been implemented to support the display and download of various file types.
The viewer supports the display of PDF, TIFF and XML invoices and attachments. Other file types can
be downloaded and viewed using your locally installed programs. The new viewer is also available from
Visma Business, Visma Contracting and Visma Global.

There are 4 new buttons located in the upper left corner of the viewer:

 XML view of the document

• The button is enabled if an XML document exists. Click the button to view the XML based document.
• The XML document can be zoomed in and out using the Ctrl + and Ctrl - keys.

 Image view of the document

• The button is enabled if the document contains an image of the invoice. The displayed document may be
PDF, TIFF, JPG, BMP or other image types. Click the button to view the invoice.

• For displaying PDF's, the new viewer uses the PDF viewer installed on the client computer. It is
embedded in Visma Document Center client. We strongly recommend using the latest version of Adobe
Reader DC. Download the free version from: https://get.adobe.com/reader/

• How the PDF is displayed can be configured in the Adobe viewer (thumbnails, reading modes,
navigation, etc...)

• Splitting a multi-page PDF document will result in TIFF images which can be further manipulated
(merge, set current page as first page, etc...).

Note:  Merging of PDF documents is not possible.

• The image document can be zoomed in and out using the Ctrl + and Ctrl - keys.

Note:  If the image document is a PDF then the zoom controls are provided by the PDF
reader installed and may not be the Ctrl + and Ctrl - keys.

Note:  The Adobe PDF viewer will make its own menus and toolbars available in
the viewer window. This is advantageous when viewing documents on a second
screen but may seem cluttered when pinned to VDC in a single screen. The Adobe
menu and toolbars can be toggled on and off by pressing Ctrl-H when the PDF
viewer has focus. Defaults can be set within Adobe app. Look under the menu
Edit>Preferences>Document>Remember Current state of Tools
Pane.

 Attachments linked to the document

• Attachments other than the XML and PDF invoices will appear when the accountant clicks this button.
• The button will always be enabled .
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• Files with supported file extensions will be opened inside viewer. File types not supported by the VDC
viewer can be opened locally (outside of the VDC client) as long as the appropriate app is installed

• Supported files can be zoomed in and out using the Ctrl + and Ctrl - keys.
• Upload attachments by dragging the file and dropping it onto the attachments pane.
• Attachments can also be removed.
• Note:  Documents with attachments cannot be merged.

 Summary of all files stored for that document.

• This view is a summary list of documents/attachments related to this invoice. It is provided as an audit
of received/attached documents.

Note:  A PDF viewer must be installed on the user’s local computer or terminal server. The
Adobe Reader DC reader is compatible with VDC. Use of other readers may exhibit slower
performance.

Supplier AutoInvoice activation service

Configure supplier notification routine frequency
The accountant can now configure how frequently the notification routine will run.

Supplier e-mail content is editable
The accountant is now able to edit the default e-mail content (subject and body) supplied by Visma
Document Center. The accountant can also reset the e-mail content to the default supplied by VDC.

The template can be found by selecting System Settings under the Tool menu. Click the E-mail tab and
then select Supplier Activation for Electronic Invoices in the e-mail type selector. The default text will
display which can be modified and saved. The template can revert to the default supplied text by clicking
the Reset button.

"Do not notify" setting for supplier activation notifications
A new option was added to the supplier activation grid. You can now set a supplier as "Do not notify"
to cease sending this supplier further e-mails. If set then the suppler will not receive any automatic
AutoInvoice activation notices.

Manually trigger the sending of AI supplier notifications

The accountant is now able to select one or more suppliers from the supplier activation grid and send the
notification e-mail via a "right-click" menu option.

There is a new setting at company level to turn off the automatic sending of supplier notification e-mails (E-
mail notifications can still be sent by manually triggering the e-mail)

Comments added to the supplier Visma AutoInvoice activation grid
The accountant can now enter comments for a supplier directly in the activation grid.

Common Visma Document Center

Only allow the Administrator role to delete documents in the Archive
To better secure archived documents the ability to delete archived documents are now restricted to users
with the role of administrator.

Any one of a group of approvers setting
You can now configure multiple approvers on a level where any one of them can approve to send the
document onward in its flow. When creating a template, each step will give you the option mark the level as
any one can approve by checking the new check-box.

Add company name to logging entries
When looking in the logs it has been difficult to see from which company the error or log entry is from.
Company number and name has been added to the log entries.

Send multiple documents on AutoFlow
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The accountant now has the ability to select multiple new documents and then send them all on flow by
selecting the Send document on Autoflow option.

Improvements 13.10.0

General

Incorrect message shown when a document that has the workflow disabled is sent on autoflow

When a document that has the workflow disabled is sent manually on autoflow, an already on flow warning
was displayed. This message has been changed to "Document <<Document Id>> cannot be sent on
autoflow. Workflow is disabled."

Incorrect language displayed
In some scenarios system created comments in the notes were in a language other than was set. This also
occurred in some pop-up messages. This has been corrected.

Issue with importing very large PDF documents
There was an issue where very large PDF documents would cause the import process to fail. This occurred
both through AutoInvoice and Autoimport methods of import. This has now been corrected.

Visma XML 6.0 System Defined Keywords
Additional keywords have been added to Visma XML 6.0. This will improve line interpretation results.

Pop-up window when activating flow appear outside screen
When activating a flow, the pop-up window (where you select approvers and press OK to send on flow)
appeared partly outside the screen if you worked on a laptop. This is now fixed.

Improve integration performance
A number of changes have been made that will improve the performance between Visma User Directory
and the other Visma Business product line components including Visma Document Center.

Performance improvements
Various improvements have been implemented for better performance of Visma Document Center. The
improvements are geared towards installations with a large number of companies.

Interpretation error
There was an issue where the CID was incorrectly interpreted. This is now fixed.

OCR improvements
The OCR component has been upgraded. This improves the interpretation and better handles the processing
of PDF documents.

Superiors are Always Added on Approval Amount For Line Approvers
When the setting Add recipient on approval amount is selected, if you have Line Approvers in the
workflow, their superiors will be added regardless of the amount on their line. This has now been fixed. The
superiors are added only if the Attestation Amount limit is set in the ERP and the actual amount on the line
is larger.

Page display issue
Invoices with 2 pages from Autoinvoice displayed the same (first) page for both pages in the document
viewer. This is now fixed to show the correct pages.

EHF/PEPPOL-bis bank account tags
Bank account number tags have been added for EHF/PeppolBIS 2.0 XML formats.

Clean-up of temporary files
There was an issue where temporary files were not deleted causing the temp folder to grow too large. This
has now been fixed.

Too many AutoInvoice activation reminders
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Some suppliers continued to receive activation reminders after they started sending electronic invoices
through Visma AutoInvoice. This is now fixed.

Timestamp issue
The timestamps for comments were showing UTC. This has now been corrected to display local time.

Document on flow per person report errors
The document on flow report would occasionally produce errors such as Object reference not set to an
instance of an object and Value cannot be null. This has been fixed.

AutoInvoice import error
Failure to import one Autoinvoice invoice caused an exception that stopped Autoinvoice import and set Last
fetch time to blank. This caused problems with a large amount of old Autoinvoice invoices to be imported.
This has been fixed.

Interpretation of invoice reference
An issue regarding the invoice reference not being interpreted has been fixed.

Do not retry sending workflows with invalid email addresses

When sending a document to Visma.net Approval, if the recipient has an invalid email address (incorrect or
empty), the document will not be transferred. Visma Document Center needs to receive an error code from
Visma.net Approval and the document shall be set to workflow state REJECTED and status code 21 and
visible in the flow initiator's list.

From this state the flow initiator can see the error we got from Visma.net Approval and can handle the
document.

Incorrect rounding line
There was a situation where if the line import is off and automatic interpretation was used then a rounding
line was created. This is now fixed.

Delete document prompt now defaults to No
When the user deletes an archived document the following prompt is displayed:

• These documents are archived. Deleting them is permanent. Continue?

The Yes button had focus by default. Some accountants, typing quickly, inadvertently deleted the document
by hitting the Enter key twice. To prevent these accidental deletions, the default focus has been changed to
the No button.

Visma Business

Credit note profile, balance information
When applying a credit note profile to a document with pre-registration turned on, the balance field in the
bottom right corner in the "New documents" tab was incorrect. This is now fixed.

Transferring documents when no voucher series defined in Visma Business
When a voucher transfer fails due to lack of a free number in the Visma Business voucher number series an
empty batch would be left in Visma Business. This has been corrected and no empty batches remain.

Able to delete pre-registration line after transferred to ERP
There was an issue where the accountant was able to delete a pre-registration line after it was transferred to
the ERP. This has now been corrected. Deletion is not allowed if the transfer to ERP has taken place.

Currency rate calculation issue
There was an issue where the currency rate was incorrectly changed in some scenarios. This has now been
fixed.

Visma Global

Transfer fails when valuation date is in prior year
There was a scenario where the transfer to ERP failed when valuation date was in a prior year. This
primarily occurred when the document did not have a distribution formula. This has been fixed.
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Slow sending on flow for new suppliers
The system could be very slow the first time a document was sent on flow for a new supplier. In some cases
the operation would time-out. This has now been corrected.

Visma Nova

Order form problem
There was an issue where the quantity received did not match with the Nova Purchase order. This occurred
only if a new row was inserted between existing rows but not if added at the end. This has now been
corrected.

Visma Contracting

Transferring voucher documents without a voucher date
In some circumstances it was possible to transfer a voucher document without a voucher date to the
accounting system. This is now fixed.

Pin/Unpin document viewer feature improved
The use of the pin/unpin button for the document viewer when started from within Visma Contracting has
been improved. It is easier to find the viewer window when hidden by other windows.

Known Issues, Limitations & Restrictions 13.10.0
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in the "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Restart of Visma Document Center server
It is not recommended to restart the Visma Document Center server. If you need to restart, it is
recommended to stop and then start it again.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.
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Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exists, then
it will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Visma User Directory

Upgrade when VUD active
Active companies will not be visible in Select ERP client form after upgrade, unless you manually add the
companies in VUD management console > Application instances > Registered companies.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents causes an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.6
The platform has been updated to use Microsoft .NET Framework 4.6. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.

Adobe PDF Reader

PDF invoice opens outside of Visma Document Center
If you encounter the PDF document opening outside of Visma Document Center when clicked on then this
may indicate that the Adobe reader pluggin for Internet Explorer has crashed. A solution is to restart the
computer. If this does not fix the issue then a re-installation of Adobe Reader should solve the issue.

PDF invoice opens download window
If clicking on a PDF document triggers the file download window then the Adobe reader may not be seen
as the default program for opening PDF files. If Adobe Reader was recently reinstalled the computer
should be restarted or the user can go to the Windows Control Panel and choose Programs>Default
Programs>Associate a file type or protocol with a program and scroll down
to .PDF. Select Adobe Reader as the default program
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In version 13.01.1 of Visma Document Center we have introduced a
number of new features, implemented a number of important bug fixes and
made some other improvements which are described in this section.
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Improvements 13.01.1

Visma Contracting

Failure in Contracting Caused by VDC Client
Fixed application crash upon opening VDC Document Viewer from Contracting.

Known Issues, Limitations & Restrictions 13.01.1
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in the "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Restart of Visma Document Center server
It is not recommended to restart the Visma Document Center server. If you need to restart, it is
recommended to stop and then start it again.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exists, then
it will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".
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Visma User Directory

Upgrade when VUD active
Active companies will not be visible in Select ERP client form after upgrade, unless you manually add the
companies in VUD management console > Application instances > Registered companies.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents causes an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.6
The platform has been updated to use Microsoft .NET Framework 4.6. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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In version 13.01.0 of Visma Document Center we have introduced a
number of new features, implemented a number of important bug fixes and
made some other improvements which are described in this section.
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New features 13.01.0

Common Visma Document Center

Stop converting documents received from Visma.net AutoInvoice to TIFF file format

Converting documents to the TIFF file format resulted in a black and white image of sometimes poor
quality. The conversion process also occasionally generated errors when received from AutoInvoice. With
this release Visma Document Center will no longer convert any documents or attachments received from
AutoInvoice to a TIFF formatted file. The original document and attachments will be made available to the
user through the viewer.

Note:  Eliminating the TIFF conversion through autoimport and manual import will be
addressed in a future release. You will still get TIFF images through these methods.

New image viewer

A new document viewer has been implemented to support the display and download of various file types.
The viewer supports the display of PDF, TIFF and XML invoices and attachments. Other file types can
be downloaded and viewed using your locally installed programs. The new viewer is also available from
Visma Business, Visma Contracting and Visma Global.

There are 5 new buttons located in the upper left corner of the viewer:

•

 XML view of the document

• The button is enabled if an XML document exists. Click the button to view the XML based
document.

•

 PDF View of the document

• The button is enabled if the document contains an PDF invoice. Click the button to view the invoice.
• The new viewer uses the PDF viewer installed on the client computer. It is embedded in Visma

Document Center client. We strongly recommend using Adobe Acrobat Reader or Foxit reader.
• How the PDF is displayed can be configured in the Adobe and Foxit viewer (thumbnails, reading

modes, navigation, etc...)
•

 TIFF View of the document

• This button will be enabled if the document contains TIFF (documents imported from autoimport,
manually imported or document imported before new functionality was turned on.)

•

 Attachments linked to the document

• Attachments other than the XML and PDF invoices will appear when the accountant clicks this
button.

• The button will be enabled only if attachments exist.
• Files with supported file extensions will be opened inside viewer. File types not supported by the

VDC viewer can be opened locally (outside of the VDC client) as long as the appropriate app is
installed

•

 Summary of all files stored for that document.

• This view is a summary list of documents/attachments related to this invoice. It is provided as an
audit of received/attached documents.

Note:  A PDF viewer must be installed on the user’s local computer or terminal server.
Adobe Acrobat Reader and Foxit readers are compatible with VDC.
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Visma Business product line

Improved performance when using Visma User Directory

Work has been completed across the Visma Business product line to improve performance for multi-
company implementations. Specifically, environments with many companies (100+) will see an
improvement. The Visma Document Center user will experience quicker response when launching Visma
Document Center either from the desktop shortcut or from within Visma Business. Changing companies
will also be faster.

Configure auto-import setting using the Visma Business product line installer
Autoimport setup is now possible via the Visma Business product line installer

Improvements 13.01.0

General

Error popup window has no scroll bar

If many documents appeared in the Errors when sending to ERP window the user was unable to scroll to
view the entire list. This has been fixed with the addition of a scroll bar to the window.

Excess memory consumption
Some customers have noticed an increase in memory consumption on the VDC Server when running for
extensive periods of time. We addressed these issues and made sure that server memory consumption no
longer exceeded normal limits.

Visma Business

The select client window displays too many companies

If the accountant checked the box to show all companies in the select ERP client window then all companies
are shown including those the accountant does not have access. This has now been corrected and all the
companies the accountant has been given access is shown.

Visma Contracting

Saving documents in Visma Contracting

There was an issue with saving PDF documents in Visma Contracting. The PDF document could not always
be viewed in VC or the image quality was poor. This issue has now been fixed.

Note:  This problem has been solved only for PDF's received through Visma.net
AutoInvoice. PDF's coming through autoimport and manual import will be addressed in a
future release.

Known Issues, Limitations & Restrictions 13.01.0
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in the "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
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There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Restart of Visma Document Center server
It is not recommended to restart the Visma Document Center server. If you need to restart, it is
recommended to stop and then start it again.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exists, then
it will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Visma User Directory

Upgrade when VUD active
Active companies will not be visible in Select ERP client form after upgrade, unless you manually add the
companies in VUD management console > Application instances > Registered companies.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents causes an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.6
The platform has been updated to use Microsoft .NET Framework 4.6. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.
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Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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In version 13.00.1 of Visma Document Center we have focused on small
background technical improvements.
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Improvements 13.00.1

General

Excess memory consumption
On some customers we noticed an increase in memory consumption on the VDC Server when running for
extensive periods of time. We addressed these issues and made sure that server memory consumption no
longer exceeded normal limits.

Known Issues, Limitations & Restrictions 13.00.1
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in the "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Restart of Visma Document Center server
It is not recommended to restart the Visma Document Center server. If you need to restart, it is
recommended to stop and then start it again.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exists, then
it will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
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or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Visma User Directory

Upgrade when VUD active
Active companies will not be visible in Select ERP client form after upgrade, unless you manually add the
companies in VUD management console > Application instances > Registered companies.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents causes an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.6
The platform has been updated to use Microsoft .NET Framework 4.6. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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In version 13.00.0 of Visma Document Center we have introduced a
number of new features, implemented a number of important bug fixes and
made some other improvements which are described in this section.
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New features 13.00.0

Common Visma Document Center

Copy account number into another row
Users can now copy the debit or credit account number and pasting it in a new row by selecting the desired
field, by pressing CTRL+C and moving on to a new field and pressing CTRL+V. If the account number is
valid, this process will add the account number without opening the look-up window. If the account number
is not valid, it will open a look-up window.

Select documents to manually download from Visma.net Approval

If you encounter the situation where a document has been approved but remain in an “In Approval” status
(110) then you now have the option to manually download the correct status from Approval. From the
document list, right-click on the document (or multiple documents) and choose the Select for download
from Approval option. The download process will start immediately.

If you there are many documents queued for download you may check the download status by selecting
View download queue from Approval option found on the Tools menu.

Improved OCR rules for reading KID/CID from Danish invoices
The interpretation of Danish KID/CID numbers have been improved. Updated search pattern to identify the
CID for the situation when the keyword is +71<(or variations like this) or when the keyword is some text
placed above the CID value on the invoice. 

Add the invoice number to each accounting line
Previously the invoice number was only set on the first accounting line. Now the invoice number will
appear on each accounting line.

Document viewer improvement
The Document Viewer, can be unpinned by using any of the two pin icons on the screen and can be recalled
either from the pin button on the document viewer or the one in the main VDC screen.

Maintain the selected zoom level when switching documents
The zoom value is retained and marked with the correct percentage (which fades away) and is remembered
between documents, even if the zoom is performed on an unpinned document.

Search add on companies in Autoimport configuration form
In the Autoimport settings form located in System/Autoimport you are now able to search on a
company in the same way as we can search on a company in the Select ERP client form.

New edit properties shortcut
Pressing the key combination CTRL + Z will open the Edit Properties window.

New Send on AutoFlow shortcut
Pressing the key combination CTRL + B will send the selected document on AutoFlow.

New Send on flow shortcut
Pressing the key combination CTRL + Enter will open the Send on Flow window.

On Flow report new tabs
The On Flow report has improved by presenting the data in flexible views. The report now consists of 3 tabs
formatted as follows:

• User tab: Shows active documents sorted and grouped by awaiting approver. A document may appear
multiple times if there are more than one active approver assigned to the document. This view will tell
you the approval queue for each approver.

• Document tab: Shows all active documents sorted by Document ID. A document will only appear once.
• All data tab: Shows all active documents with a line for each approver (both approved and awaiting

approval).

Finvoice 3.0
Support for Finvoice 3.0 has been added for the Finnish market.
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Always add superior for the first level of approvers
Currently a superior’s superior (to all levels) is added to the flow when the Always Add Superior
configuration is set. A new option has been provided to only add the first superior and not subsequent
superiors.

Visma Contracting

Order number on each accounting line
If the buyer’s order number is found in the XML header then it will be copied to each voucher line. If an
order number is not found then if the warehouse number exists it will instead be copied to each line.

Visma Global

Added VAT code 80
VAT code 80 is now available

GDPR Related Features

Delete archived documents
Accountants and administrators can now delete archived documents by selecting the desired documents and
pressing the DELETE key on the keyboard. This will prompt the message: "These documents are archived.
Deleting them is permanent. Continue?". Clicking on Yes will delete the documents permanently. 

This feature can be used to administer a company's data retention policy by deleting old records which are
no longer required.

For example these steps can be followed to delete documents based on dates:

1. Click the Archive button
2. Create a filter by clicking the filter icon
3. You can create a filter for a specific year (the following example will filter all documents created in

2010):

• Created >= 01-Jan-2010
• Created <= 31-Dec-2010

4. Click Activate (or Save Activate if you wish to reuse the filter)
5. The filter results are now displayed
6. Select the line you wish to delete (Ctrl-A) selects all lines
7. Press the Delete key.
8. You will be prompted:  "These documents are archived. Deleting them is permanent. Continue?"
9. Click Yes and the selected documents are deleted.

Note:  The deletions will be recorded in the event log.  Deleting large amounts of documents
may take awhile since each deletion is recorded in the event log.

Log changes to a user's role
Security logging has been enhanced within Visma Document Center. Whenever a role is changed for a user
the event is recorded in the event log. This only applies if VUD is not implemented, If VUD is installed
then role changes are made there. VUD already logs all role changes.

Log user changes to the bank account number
Security logging has been enhanced within Visma Document Center. Whenever the suppliers bank account
number or organization number is changed by a user then the event is recorded in the event log.

Improvements 13.00.0

General

On Flow filter returning incorrect results
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There was an issue where the "On Flow" filter was not returning correct results. Specifically those with a
status of 110 and 120 were not included in the results. This has been fixed.

Documents in status 110 not appearing on the document flow report
Documents with a status of 110 were not included in the document flow report when using the Visma.net
Approval integration. This has now been corrected.

Performance improvements
Users with an approver role were experiencing degraded performance compared with users with higher
access roles. This has been approved.

Large documents generating errors when sent to Visma.net Approval

Large attachments no longer generate errors and no longer cause blockages in the sending to Approval
process. All the large files as well as the ones imported and sent after them reach Approval with status 110
correctly.

Pop-up Regarding ODBridge Service Failing to Start
During the installation of the Document Center server a pop-up appears warning of the failure to start the
ODBridge Service.  After the installation is completed the service will appear to be running correctly.  The
erroneous pop-up has been fixed.

Domain needed for Windows logon
After upgrading to 12.01, the windows logon to Document Center would only work when the username had
a domain associated to it in the Visma Business user table and VWUser table (domain\username). This has
been corrected and the domain is not required.

Approved document status not updated
Deadlocks were preventing the status update of approved documents received from Visma.net Approval.
This has now been corrected. We use now a different approach to avoid the deadlock errors when accessing
the database for workflow task related operations.

Invoice numbers not interpreted correctly in the Danish dictionary
Invoice numbers containing letters like AWB123466 are now correctly interpreted.

Reduce the number of call's VDC is making toward VUD
Larger customers were experiencing performance issues when Visma User Directory (VUD) was enabled
with Visma Document Center. Several technical improvements were implemented in the integration with
VUD to speed the performance.

"Manage recipients on supplier" window
Improved loading time and of supplier list int he Manage recipient on supplier form to avoid Out of
Memory errors.

Supplier number not copied
The Copy row feature was not including the supplier ID in the copied line. This has now been corrected.

Sending documents on flow without a supplier is slow
There was a scenario where the flow window had a noticeable delay in appearing when sending a document
on flow which did not have a supplier identified. This has now been corrected.

Autoinvoice configuration issue
Searching in the Autoinvoice company, ERP client field, the user could be thrown out from the set-up. This
has now been corrected.

Autoinvoice follow up form does not show the correct status
There was an issue where the Autoinvoice follow up form did not show the correct status. This was
preventing the user from retrying the download from AutoInvoice. This has now been corrected.

Visma User Directory must be enabled in Visma Business before enabling it Document Center
Starting with VDC 13.00 you will be prevented from activating VUD in VDC as long as it is not activated
in Visma Business. You must first activate VUD for Visma Business. This will ensure the proper export of
users and roles.

Don’t convert zip folder messages in OD Bridge
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There was an issue with converting zip files as attachment for invoices going to Visma Approval. This has
now been corrected.

Visma Global

Incorrect currency value
In Global integration when the user inputs the currency number manually the correct exchange rate is now
shown.

Known Issues, Limitations & Restrictions 13.00.0
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in the "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Restart of Visma Document Center server
It is not recommended to restart the Visma Document Center server. If you need to restart, it is
recommended to stop and then start it again.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exists, then
it will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".
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Visma User Directory

Upgrade when VUD active
Active companies will not be visible in Select ERP client form after upgrade, unless you manually add the
companies in VUD management console > Application instances > Registered companies.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents causes an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.6
The platform has been updated to use Microsoft .NET Framework 4.6. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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In version 12.10.3 of Visma Document Center we have introduced a
number of new features, implemented a number of important bug fixes and
made some other improvements which are described in this section.
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Improvements 12.10.3

General

Always add superior for the first level of approvers
Currently a superior’s superior (to all levels) is added to the flow when the Always Add Superior
configuration is set. A new option has been provided to only add the first superior and not subsequent
superiors.

Don’t convert zip folder messages in OD Bridge
There was an issue with converting zip files as attachment for invoices going to Visma Approval. This has
now been corrected.

Autoinvoice configuration issue
Searching in the Autoinvoice company, ERP client field, the user could be thrown out from the set-up. This
has now been corrected.

Search add on companies in Autoimport configuration form
In the Autoimport settings form located in System/Autoimport you are now able to search on a
company in the same way as we can search on a company in the Select ERP client form.

Large documents generating errors when sent to Visma.net Approval

Large attachments no longer generate errors and no longer cause blockages in the sending to Approval
process. All the large files as well as the ones imported and sent after they reach Approval with status 110
correctly.

On Flow report new tabs
The On Flow report has improved by presenting the data in flexible views. The report now consists of 3 tabs
formatted as follows:

• User tab: Shows active documents sorted and grouped by awaiting approver. A document may appear
multiple times if there are more than one active approver assigned to the document. This view will tell
you the approval queue for each approver.

• Document tab: Shows all active documents sorted by Document ID. A document will only appear once.
• All data tab: Shows all active documents with a line for each approver (both approved and awaiting

approval).

When a completed document returns from Approval Due Date Changes to Last Update Date
There was an issue where the due date for each step was changed to the last update date. The due date
should not change according to the last update date as it should reflect the deadline set in the general
settings. This has now been corrected.

Call back is repeating for the same document
It was observed in the On Demand Bridge console that here were several call back messages logged for the
same OD Handle as there were several call back requests sent for the same OD handle, which should not
happen. This has now been corrected.

Avoid unknown document counts in the Select ERP client start-up window
In order to avoid having "unknown" in the document number columns in the Select ERP client start-up
window the document count from the last run will be stored and used.

The field Due Date was renamed to Deadline
The field Due Date was renamed to Deadline in the workflow task details screen. This better represents the
field value as it contains the deadline for the approver and not the invoice due date.

Visma Business

Supplier org. units on lines
There was as a scenario where organzation units associated with a suppler were not added to the voucher
line. This has been corrected.
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Visma Global

Added VAT code 80
VAT code 80 is now available

Incorrect currency value
In the Global integration when the user inputs the currency number manually the correct exchange rate is
now shown.

Known Issues, Limitations & Restrictions 12.10.3
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in the "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Restart of Visma Document Center server
It is not recommended to restart the Visma Document Center server. If you need to restart, it is
recommended to stop and then start it again.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exists, then
it will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".
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Visma User Directory

Upgrade when VUD active
Active companies will not be visible in Select ERP client form after upgrade, unless you manually add the
companies in VUD management console > Application instances > Registered companies.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents causes an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.6
The platform has been updated to use Microsoft .NET Framework 4.6. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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In version 12.10.2 of Visma Document Center we have introduced a
number of new features, implemented a number of important bug fixes and
made some other improvements which are described in this section.
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Improvements 12.10.2

General

Number of Calls from VDC towards VUD Needs Reducing
Larger customers were experiencing performance issues when Visma User Directory (VUD) was enabled
with Visma Document Center. Several technical improvements were implemented in the integration with
VUD to speed the performance.

Slowness Impacting the Flow Window
When sending a document on Flow, there is a check performed to verify if there is a supplier on the
document, not in the Supplier Template.

Workflow Status on Document not updated correctly
We now use a different approach to avoid the deadlock errors when accessing the database for Workflow
task related operations.

"Out of Memory" errors in "Manage recipients on supplier" form for large number of suppliers
Improved loading time and of the supplier list in the "Manage recipients on supplier" form to avoid "Out of
Memory" errors.

Autoinvoice follow up form does not show the correct status
There was an issue where the Autoinvoice follow up form did not show the correct status. This was
preventing the user from retrying the download from AutoInvoice. This has now been corrected.

Note:  The documents that have been imported before upgrading to 12.10.2 will still have
the wrong status. The fix will apply for documents imported after upgrade.

Known Issues, Limitations & Restrictions 12.10.2
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in the "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Restart of Visma Document Center server
It is not recommended to restart the Visma Document Center server. If you need to restart, it is
recommended to stop and then start it again.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
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using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exists, then
it will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Visma User Directory

Upgrade when VUD active
Active companies will not be visible in Select ERP client form after upgrade, unless you manually add the
companies in VUD management console > Application instances > Registered companies.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents causes an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.6
The platform has been updated to use Microsoft .NET Framework 4.6. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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In version 12.10.1 of Visma Document Center we have introduced a
number of new features, implemented a number of important bug fixes and
made some other improvements which are described in this section.
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Improvements 12.10.1

General

High load on Visma.net

Visma Document Center was creating a higher load than necessary when communicating with Visma.net.
This has been improved.

Visma Nova

Nova Server Isolation feature failed

Changes to the On Demand Platform integration rendered the Nova server isolation feature inoperable.
This affected both the site ID method and Instance Management Tool. This has now corrected and working
properly. Company registration and activation will no longer be performed during this process.

Known Issues, Limitations & Restrictions 12.10.1
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in the "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Restart of Visma Document Center server
It is not recommended to restart the Visma Document Center server. If you need to restart, it is
recommended to stop and then start it again.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exists, then
it will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.
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Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Visma User Directory

Upgrade when VUD active
Active companies will not be visible in Select ERP client form after upgrade, unless you manually add the
companies in VUD management console > Application instances > Registered companies.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents causes an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.6
The platform has been updated to use Microsoft .NET Framework 4.6. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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In version 12.10.0 of Visma Document Center we have introduced a
number of new features, implemented a number of important bug fixes and
made some other improvements which are described in this section.
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New features 12.10.0

Common Visma Document Center

Automatic supplier notification for electronic invoice activation
Receiving supplier invoices electronically through Visma Autoinvoice saves you time and ensures a high
level of accuracy when creating vouchers. Visma Autoinvoice has a large network with thousands of
registered suppliers. Many of your suppliers are also likely registered but some of these may still be sending
you their invoices manually. This results in missed opportunities for better automating your workload.

We recommend using the industry standard: EHF eInvoices (Peppol BIS) sent through the PEPPOL
network.

Visma Document Center will now automatically send an e-mail to your supplier requesting invoices be
sent to you electronically through Visma’s Autoinvoice network. You can monitor the status of e-mail
notifications from the Supplier Activation for Electronic Invoices window. This window is accessed from
the Reporting menu and contains the following information:

• Supplier ID and Name
• Company number
• E-mail address (you can update the e-mail address)
• Telephone number
• Manual Invoices (the number of manual invoices received from this supplier in the past 6 months)
• Status (Missing e-mail if an e-mail address was not found for this supplier. Sent once a notification has

been sent.)
• Notification count (the number of notifications sent to this supplier)
• Last Notification Time (you can right-click a line and choose to reset the notification count and time)

To use this feature you must first:

• Have the Visma Autoinvoice integration active
• Configure an e-mail server (from the menu Tools\System Settings\Configure E-mail

Server tab)
• Configure the notification settings (from the menu System\Auto Supplier Activation)

• Check the Enable automatic notifications box
• Enter the sender e-mail address (this is the e-mail address you wish the supplier to use when replying

to you)
• Enter the maximum notification count (this will limit the number of notifications a supplier will

receive. The default value is 2 notifications)
• Enter the number of days to wait between notifications (the default value is 14 days)

The notification settings are at the company level.

Note:

EHF: EHF stands for "electronic trading format", meaning that you can send and receive
invoices electronically and standardized. EHF is the Norwegian version of Peppol BIS. This
saves you a lot of time and paperwork, and the workflow goes easier. You want better control
of your invoices. The state requires all their suppliers of goods and services to send invoices
in this format. We can also see a clear trend that more private companies are beginning to
make use of this format.

Read more here: https://www.anskaffelser.no/leverandorer/slik-moter-du-det-offentliges-
krav-til-digitalisering/faktura-og-kreditnota

PEPPOL: PEPPOL offers a standardised messaging connection for e-ordering, e-invoicing,
electronic credit notes and other business documents . These technologies automate
information exchange across the supply chain, reducing the cost and potential risk of error
from manual intervention. For many public bodies, procurement remains a largely manual
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process and, where there is automation, it generally involves an inefficient ‘tangled web’ of
different systems and protocols.

Read more here: https://peppol.eu

ELMA: ELMA is the Norwegian service providing SMP services part of PEPPOL network
for Norwegian organizations.

Read more here:https://www.anskaffelser.no/verktoy/mottakere-i-elma

Determine supplier for factoring invoices
The logic used for identifying the supplier for an invoice has been improved to better handle factoring
invoices. The supplier will be determined during automatic interpretation as follows:

1. Select the supplier using both the company number and bank account. If an exact match is found then
that supplier will be used.

2. If an exact match was not found using the company number and bank account then the supplier will be
selected based on the company number and no bank account.

During automatic interpretation we will not match on the bank account only. If the user manually
reinterprets the invoice then first supplier from the list is picked and the rest is presented as available
options in the list.

Visma Business product line

Support VAT amount in currency

To support improved VAT reporting in Visma Business 2 new columns have been added to the accounting
grid: VAT Amount in Currency and Amount Exclusive VAT in Currency. The values in these fields will be
transferred to Visma Business.

Improvements 12.10.0

General

Line approvers which were entered in the accounting grid remain on workflow after a new OCR and
interpret is performed

There was an issue where a previously entered line approver will remain in the Workflow tab for the new
document even though a second OCR and Interpret is performed. Now when the accounting grid is reset
due to a new interpretation the workflow data is also reset.

Cost unit disappears from the account line after select/copy to new line

When using the select line (Ctrl-2) and copy to new line (Ctrl-3) feature the copied cost units appear on the
new line but were not saved. This has now been corrected.

Notification mail includes all statuses

There was a scenario where a new document e-mail notification would be sent for approved documents.
This has now been corrected.

Document per person on flow report decimal error

The Document per person on flow report was displaying the document amount with the decimal in the
wrong position. This has now been corrected.

Supplier activation for electronic invoices report

Some users have been experiencing an error condition when trying to run the Supplier activation for
electronic invoices report. This has been corrected.

Timeout when selecting Manage recipients on supplier

When selecting the Manage recipients on supplier option from Workflow settings tab would timeout if there
were many suppliers. This has now been corrected.
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OD Bridge does not process all VDC companies

This was an issue affecting large installations (more than 100 companies) using Visma Approval. The
bridge service was not able to process all companies within the default refresh rate time limit (5 minutes).
This has been corrected by ensuring the bridge completes the processing for all companies before starting a
new tick.

Visma Business product line

Identify employee primarily on user name

When looking up employees in Visma Business, the search will first use the user name to find a match. If no
match is found then the search will use the email address to find the employee.

Visma Global

Using Visma Document Center without VUD integration did not require entry of username and
password

When logging into Visma Document Center the entry of username credentials is required. Using VUD and
single sign-on is not affected.

Known Issues, Limitations & Restrictions 12.10.0
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in the "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Restart of Visma Document Center server
It is not recommended to restart the Visma Document Center server. If you need to restart, it is
recommended to stop and then start it again.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.
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For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exists, then
it will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Visma User Directory

Upgrade when VUD active
Active companies will not be visible in Select ERP client form after upgrade, unless you manually add the
companies in VUD management console > Application instances > Registered companies.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents causes an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.6
The platform has been updated to use Microsoft .NET Framework 4.6. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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In version 12.01.1 of Visma Document Center we have a number of
important bug fixes and made some other improvements which are
described in this section.
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Improvements 12.01.1

General

Amount not interpreted when importing XML invoices from AutoInvoice

XML invoices received through Visma Autoinvoice were showing 0,00 in the amount fields. Invoices
manually imported or through the Autoimport feature showed the correct amounts. This has now been fixed
and XML invoices from Visma Autoinvoice are shown correctly.

Supplier activation for electronic invoices report

Some users have been experiencing an error condition when trying to run the Supplier activation for
electronic invoices report. This has been corrected.

Downgrade of the NHibernate component

In some cases Autoimport and Workflow was not working properly. This was caused by a new version of a
component called NHibernate. This component has been downgraded to a stable version to eliminate these
issues.

Document per person on flow report decimal error

The Document per person on flow report was displaying the document amount with the decimal in the
wrong position. This has now been corrected.

Known Issues, Limitations & Restrictions 12.01.1
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in the "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Restart of Visma Document Center server
It is not recommended to restart the Visma Document Center server. If you need to restart, it is
recommended to stop and then start it again.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.
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Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exists, then
it will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Visma User Directory

Upgrade when VUD active
Active companies will not be visible in Select ERP client form after upgrade, unless you manually add the
companies in VUD management console > Application instances > Registered companies.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents causes an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.6
The platform has been updated to use Microsoft .NET Framework 4.6. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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In version 12.01.0 of Visma Document Center we have introduced a
number of new features, implemented a number of important bug fixes and
made some other improvements which are described in this section.
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New features 12.01.0

Common Visma Document Center

Template names can now be edited

In previous versions we restricted changing a template name. The only way to change a template name was
to delete it and create it again with different name. We have now made it possible to change the name of an
existing template. If there is already a template with the same name you will get a warning.

Supplier activation report

Receiving supplier invoices electronically through Visma Autoinvoice saves you time and ensures a high
level of accuracy when creating vouchers. Visma Autoinvoice has a large network with thousands of
registered suppliers. Many of your suppliers are also likely registered but some of these may still be sending
you their invoices manually. This results in missed opportunities for better automating your workload.

To help you identify those suppliers who are capable of sending you electronic invoices but are not we have
created a report. This report will list the supplier’s contact information and how many manual invoices you
have received within a specified time period. Using this report, you may contact your suppliers and request
invoice be sent to you electronically through Visma’s Autoinvoice network. The report is produced in the
form of a spreadsheet.

To run the report, select the Supplier Activation for Electronic Invoices option from the Reporting
menu. You will be asked how many months back you wish the report will cover. The report will contain the
following columns:

• Supplier name
• Organization number
• E-mail address
• Contact person name
• Telephone number
• Total number of invoices received from this supplier in the last X months

Suspending companies

The suspend companies feature has been implemented to improve performance for installations with many
companies configured. Some installations may have upwards of 1000 companies.

Many of these companies may no longer be in use except for researching past documents. These little used
companies are still consuming computer resources through active background processes. With this new
feature you can suspend a company thus stopping all running processes for that company. The result will be
improved performance for your active companies.

Features in suspended companies are limited to:

• Viewing documents
• Exporting to an external archive

To suspend a company:

1. Select the Companies Status option from the Tools menu.
2. From the displayed Companies window select a company and right-click with your mouse.
3. Click the Suspend option.
4. The status will initially show PendingSuspend.
5. Click the Save button.
6. The company status will now be Suspended and all background processing stopped.

To resume a suspended company:

1. Select the Companies Status option from the Tools menu.
2. From the displayed Companies window select a suspended company and right-click with your mouse.
3. Click the Resume option.
4. The status will initially show PendingResume.
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5. Click the Save button.
6. The company status will now be StandBy until the company is accessed. Then the status will move to

Active and background processes will resume.

Note:  The Company Status option is only available when logged into an active company. To
resume a suspended company, you must first be logged into an active company.

Interpret VAT amount instead of calculate
You may choose to interpret the VAT amount from the invoice instead of calculating the amount.

Improved error handling during Visma Autoinvoice document import

A number of new features have been developed to better handle issues that may arrise when new
documents are imported from Visma Autoinvoice.
The key improvements to this process includes:

• Process all documents imported from Autoinvoice
• Alert the accountant of documents missing XML or attachment images
• Retry import of missing XML or images

Process all documents imported from Visma Autoinvoice

Occasionally an invoice document may fail to be imported into Visma Document Center from Visma
Autoinvoice. This may be due to any number of reasons such as XML files with bad data, corrupt PDF files,
large images etc.

Previously a document entry would not be created in the document list and this would be only be discovered
by looking at the error logs. Now Visma Document Center will create a record in the document list with as
much information from the invoice as it can gather. The accountant will have the opportunity to retry the
download or manually supply the missing information. These entries in the document list will be marked as
in error (red indicator in the first column).

A new filter has been created for the document list to only show documents with missing XML and/or
missing images.

• Click the Filter selection field to open the drop-down list of pre-defined filters
• Click the Autoinvoice follow-up filter to apply the filter

Alert of documents with missing XML or image attachments
When the accountant selects an ERP client, a new window will display if any documents with missing XML
or image attachments are detected. For each document detected this window will display:

• Document ID
• Invoice number
• Date
• Due date
• Amount
• VAT amount
• XML status (OK or missing)
• Image status (OK or missing)

Clicking the Import button will retry the import for the selected documents. You can also retry the import
from the document list (see Retry import of invoice and images for details).

Note:  If the XML status is Missing then it is likely the invoice information is blank.

Retry import of invoice and images

You may retry importing documents from Visma Autoinvoice by using a new option in the document list.
To retry the import:

1. Select one or more documents from the document list.
2. Right-click and select theAutoinvoice follow-up option.
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3. A new window will appear showing the list of documents you selected and the state of invoice XML and
images.

• If the XML status is OK then the XML has successfully downloaded
• If the XML status is Missing then the XML has not successfully downloaded
• If the Image status is OK then image attachments have successfully downloaded
• If the Image status is Missing then no image attachments have successfully downloaded

4. Clicking the Import button will retry importing the missing XML and/or images.
5. If the issue persists it is suggested that you log into Visma Autoinvoice directly to access the document

and attachments.

Visma Global and Visma Business

Auto-create employee records in ERP
Large accounting offices often reassign accountants to different companies. This is easily done using Visma
User Directory. However the administrator is still required to create corresponding employee records in the
ERP. To eliminate this extra step a user record is now automatically created when the accountant logs into a
company the first time.

Note:  Approvers should be created as employees in the ERP manually to ensure the
approval limit and superiors are set.

Note:  This feature is enabled only if Visma User Directory is in use.

Note:  To turn this feature off you must edit the server configuration file. The key
FeatureToggle.AutoCreateEmployeeAtLogonWithVUDActive must be set to
value=false

Improvements 12.01.0

General

Autoimport error
If the Workflow not in use option was checked in the My settings menu, then all the documents imported
via Autoimport or Autoinvoice received the status 0 - not in flow instead of 100 - disable workflow. This is
now fixed.

Improved navigation in Workflow configuration forms
The navigation has been improved by the resequencing of the tab order in the following workflow related
forms:

• Workflow configuration
• Load template
• Approve/Reject
• Forward/Review
• Manage templates
• Manage recipients on supplier

PDF document hangs VDC Client and Autoimport
There was a scenario where certain PDF documents would cause the both the VDC client and the
Autoimport process to hang. This has been solved.

Issue with invoices in colour
A problem with processing certain invoices with colour printing appeared in version 11.11 of VDC.
Sometimes the result was blank invoice or blackened invoice. This has now been corrected with the upgrade
of a third party component.

Linking approvers based on suppliers
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When sending more than one document from the same supplier on flow, the suggested recipients related to
the supplier will be now added to the flow.

Select ERP client should show the number of documents for approval
A new column showing the number of documents that are awaiting approval in Visma.Net Approval has
been added to the select ERP client form.

Autoflow configurator scroll bar
The vertical scroll bar was missing from the Autoflow configurator form making it difficult to view a long
list. This has been corrected by the addition of a vertical scroll bar.

Omnipage component upgraded
The Omnipage component has been upgraded to the latest version (20.20). This solves several issues with
scanning and interpretation (described elsewhere in these release notes).

The text from the search box not deleted; templates displayed twice in the list
There was an issue with clearing the search box used for searching templates which was causing templates
to appear twice in the list. This has now been corrected.

Approval date for documents
In version 12.00 the date in the workflow tab is the deadline, not the date when the document was approved.

For example: if we send the document on flow to a recipient on 1st of March 2017 and we have the
document deadline in 2 days, the date from the workflow tab will be 03.03.2017. Even if the recipient
approves the document in the same day (1st of march), the date will not be change and will remain
03.03.2017.

The last update date of workflow task information has now been added to the workflow task details view

Translation improvements
A number of translations of field names were improved/corrected.

Document sent on flow without a profile
There was a situation where a credit note was imported and sent on autoflow even though the document had
no profile assigned. This has been fixed so the autoflow rule will not trigger if the document does not have a
profile.

Cannot import files on Windows Server 2012

This issue was caused by a set of missing dlls. This is fixed now. VDC 12.01 now contains the necessary
dlls and will assure that pdf and tiff files can be correctly imported manually or through Autoimport.

The VAT code is not updated when removing the account number
When removing an account with a VAT code he VAT code on the document is not updated. This is now
solved. Deleting or modifying the debit account will also update the VAT code.

Save recipients to supplier - save template to supplier

The interaction with workflow templates and templates linked to specific suppliers has been improved. The
latest improvements include:

• When sending a document on flow you have the option to Load a template. This opens a list of
templates with the option of previewing, deleting or updating a template. Any changes made to a
template and saved will be updated correctly. Select a template and click the Use Template button then
your template contents will be loaded to the document’s flow.

• Templates can be pre-loaded based on the supplier. In this case if you choose to load another template,
it will only replace the pre-loaded one for that document. It will not be added as a template for that
specific supplier. Only one template can be used at a time.

• If new approvers / steps are added and the Save template button is clicked you can name the new
template which will then be added to the list.

• Click the Save recipients to supplier template option to save the approval flow created for the current
document as a template for this supplier. When you click the Send on Flow button a new template is
also created. You can see the new template linked to the supplier by selecting the Manage recipients on
supplier option found by going to Tools\System settings\Workflow tab.
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Note:  The template will only be saved to the supplier if there was no template previously
set for that supplier.

• When using a pre-loaded template for a supplier, changes can be made by adding/removing approvers or
steps for that document’s approval flow. Then when you click the Send on Flow button you will also be
asked if you wish to update the supplier template with your changes.

Note:  Line Approvers are NOT saved to a template.

Report Documents on flow per person
There was an issue where workflow states where missing for documents pending Visma.net Approval on
the Documents on flow per person report. This issue has been solved. The report now shows documents in
status 20, 110 and 120.

Exception returned when using invalid credentials
The issue where upon entering invalid credentials of any kind (empty, wrong user or wrong password),
there occurred a pop-up mentioning an Unhandled Exception. This is now fixed and the pop-up no longer
occurs.

Increase XML-tree form size

This form shows the whole XMLtree and since the form was very small it made it difficult for the user to to
add keywords for a specific tag. The form size has now been iincreased for easier editing.

Keyword for factoring bank account
A keyword was added to interpret the factoring bank account number.

Visma Business

Order matching credit notes
Credit notes which could not match to an order were not editable and the OK button was disabled in the
interpretation form. These issues have been fixed and credit notes are now handled correctly through the
order match process.

Interpret VAT amount instead of calculating

You are now able to interpret instead of calculating the VAT Amount.

To enable interpretation, the XML dictionary must be configured by adding a keyword on the document
level for the VATAmount.

AmountExculVAT will be up updated after the VAT Amount is interpreted on the accounting header
(the first accounting line). If the dictionary is not configured to interpret the VATAmount, then is will be
calculated as before.

Visma Contracting

Warehouse number not being transferred to Visma Contracting

There was an issue with non-Autofakt invoices where the warehouse number was not being transferred to
Visma Contracting. This has now been fixed.

Visma Nova

Rejected invoice in Approval status

There was a scenario where if you rejected an invoice from Document Center before the workflow was
completed and the invoice was already transferred to Nova then Nova would receive an incorrect status.
This has been fixed.

Issue with tax rates of 100%
For Nova accounts set at 100% tax rates Document Center would apply a 50% rate. This has now been
fixed.
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Known Issues, Limitations & Restrictions 12.01.0
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in the "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Uninstall of Visma Document Center server fails
When performing an upgrade, both the client and the server are first uninstalled and then reinstalled.
Sometimes the uninstaller for the server fails when trying removing the shared folder that the client uses to
install. This is solved for version 9.00.0. Since it is the uninstall that fails this might happen on all versions
before version 9.00.0.

Restart of Visma Document Center server
It is not recommended to restart the Visma Document Center server. If you need to restart, it is
recommended to stop and then start it again.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

New company in Visma Business
The Visma Business Services has to be restarted when a new company is created in Visma Business so that
the logon in Visma Document Center to the new company is possible.

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exists, then
it will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".
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Visma User Directory

Upgrade when VUD active
Active companies will not be visible in Select ERP client form after upgrade, unless you manually add the
companies in VUD management console > Application instances > Registered companies.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents causes an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.6
The platform has been updated to use Microsoft .NET Framework 4.6. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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In version 12.00.0 of Visma Document Center we have introduced a
number of new features, implemented a number of important bug fixes and
made some other improvements which are described in this section.
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New features 12.00.0

Common Visma Document Center

Visma Document Center will run an automatic transfer to ERP
We have introduced a new setting in the Tools > System Setting form that will turn on/off the automatic
transfer of vouchers to the ERP.

When this setting is turned on, documents that are workflow completed will be automatically transferred to
ERP.

This automatic transfer will perform the same background validations as the manual transfer used to do.

When the transfer has succeeded the accounting status will change to 30 (transferred)

If the transfer fails a document note is added to the document which will contain the reason for the failure.

Automatic transfer to ERP and preregistration

When the preregistration feature is used, automatic transfer can be done for the final booking. The
automatic batch update must be turned on for preregistration.

Without automatic preregistration batch update, the final booking needs to be transferred manually as
before.

Show EHF, PEPPOL-BIS and BII XML documents in Norwegian, English and Swedish
For EHF, PEPPOL-BIS and BII XML commercial documents that are displayed in the VDC client using
default stylesheets

When the VDC client language is set to Danish, the above types of XML commercial documents will be
displayed in Norwegian.

When the VDC client language is set to Dutch, the above types of XML commercial documents will be
displayed in English.

When the VDC client language is set to English, the above types of XML commercial documents will be
displayed in English.

When the VDC client language is set to Finnish, the above types of XML commercial documents will be
displayed in English.

When the VDC client language is set to Norwegian, the above types of XML commercial documents will be
displayed in Norwegian.

When the VDC client language is set to Swedish, the above types of XML commercial documents will be
displayed in Swedish.

Visma Business product line

Automatic update batch to Visma Business
There is a new setting added in Tools > System settings: Automatic update batch to Visma Business. When
this is turned ON, the batches transferred to Visma Business are also updated in Visma Business.

As a result, the batches and vouchers transferred should be found in the updated Batches or vouchers in
Visma Business.

The setting is saved as a company setting and once it is turned on, it will apply to all documents transferred
manually or automatically to Visma Business.
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Improvements 12.00.0

General

OCR of two different fields, with same user defined word list, returns different results
The pattern that was used for invoice reference is changed for Danish OCR language and we added a
restrictive pattern that also searches for digits.

Check for duplicate invoices
We have improved the existent feature for detecting duplicate invoices.

Duplicate invoices are now detected right after import based on the following criteria:

• supplier
• accounting year
• invoice number

The warning about the duplicate is posted in the follwing places:

• Document list
• Edit document properties form
• Interpret result form.

VDC will simply warn the user about a duplicate and will also block autoflow for duplicated invoices. The
transfer to ERP is not blocked for duplicated invoices.

Number of invoices "For approval" is incorrectly shown as 0
In the select ERP client, the number of For Approval document was not correct. This is now fixed and the
For Approval column shows the same number as the For Approval tab in the VDC client.

Workflow

Empty workflow template list after upgrading
After upgrading, all the workflow groups, recipients on supplier and recipients from autoflow rules are
converted automatically into templates. The problem was that these templates were not visible in the
Manage templates form and manage recipients on supplier form until other operations were done. This is
now fixed and templates for recipient groups/ default recipients/autoflow rules are now created and assigned
to the proper entities the first time a form that uses them is opened.

Convert workflow groups into templates
All the workflow groups that were created before upgrade (even the ones that were not saved on a supplier)
are now converted into templates and are visible in the Manage templates form.

Since in the previous versions, the workflow groups contained only the recipients, without having a flow
type associated, after upgrade, all the recipients from a workflow group will be added on the same step
(parallel flow).

Empty workflow templates
In Visma Business you are allowed to set an employee as a user that doesn't exist in the users table. If a
recipient that didn't have a user attached was set as auth. responsible for a supplier in Visma Business, after
upgrade, an empty template was created on the supplier. When a document from this supplier was sent on
flow, a task was started without having any user attached, only an employee id. This is now fixed and when
a recipient doesn't have a user attached, it will not be added to the template.

Document due date is not calculated
When a document was sent on flow, the document deadline setting from system settings menu was not
considered and the deadline was always the current date. This is now fixed and the deadline is calculated
accordingly.

Date validation when sending on Autoflow
If on a document the due date and the invoice date were the same, the invoice was not sent on autoflow
because the validation failed. Now this is fixed and we support same due date as invoice date.



Visma Software International AS | Visma Document Center 12.00.0

© Visma Software International AS | 94

The recipient group names are preserved when converted to templates
When recipient groups were being converted to new workflow templates they were assigned a generic
sequential name (group 1, 2, etc...). This has been improved. A generic name is no longer assigned. The
name of the original recipient group is retained and used to name the template.

Visma Business

Lookup order for credit account
The lookup order for credit account field is now changed. this means that on a regular invoice it will first
look into suppliers, then GL accounts, customers and capital asset accounts.

Visma.net Approval

Comments on rejected documents
A comment added on a document when handling a reject was not sent to Visma.net Approval. This is now
fixed and the comment will be sent to Visma.net Approval when the document is resent on flow.

Known Issues, Limitations & Restrictions 12.00.0
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Uninstall of Visma Document Center server fails
When performing an upgrade, both the client and the server are first uninstalled and then reinstalled.
Sometimes the uninstaller for the server fails when trying removing the shared folder that the client uses to
install. This is solved for version 9.00.0. Since it is the uninstall that fails this might happen on all versions
before version 9.00.0.

Restart of Visma Document Center server
It is not recommended to restart the Visma Document Center server. If you need to restart, it is
recommended to stop and then start it again.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

New company in Visma Business
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The Visma Business Services has to be restarted when a new company is created in Visma Business so that
the logon in Visma Document Center to the new company is possible.

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exists, then
it will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Visma User Directory

Upgrade when VUD active
Active companies will not be visible in Select ERP client form after upgrade, unless you manually add the
companies in VUD management console > Application instances > Registered companies.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents causes an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.6
The platform has been updated to use Microsoft .NET Framework 4.6. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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In version 11.11.3 of Visma Document Center we have introduced a
number of new features, implemented a number of important bug fixes and
made some other improvements which are described in this section.
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Improvements 11.11.3

General

Workflow Status on Document not updated correctly

We now use a different approach to avoid the deadlock errors when accessing the database for Workflow
task related operations.

Timeout when selecting "Manage recipients on supplier"
When selecting the "Manage recipients on supplier" option from the Workflow Settings tab would timeout
if there were many suppliers. This has now been corrected. In cases where there is a large number of
suppliers, a waiting time should be expected in order to display the suppliers.

"Out of Memory" errors in "Manage recipients on supplier" form for large number of suppliers
Improved loading time and of the supplier list in the "Manage recipients on supplier" form to avoid "Out of
Memory" errors.

Known Issues, Limitations & Restrictions 11.11.3
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Uninstall of Visma Document Center server fails
When performing an upgrade, both the client and the server are first uninstalled and then reinstalled.
Sometimes the uninstaller for the server fails when trying removing the shared folder that the client uses to
install. This is solved for version 9.00.0. Since it is the uninstall that fails this might happen on all versions
before version 9.00.0.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.
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For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exist, then it
will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Visma User Directory

Upgrade when VUD active
Active companies will not be visible in Select ERP client form after upgrade, unless you manually add the
companies in VUD management console > Application instances > Registered companies.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents cause an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.6
The platform has been updated to use Microsoft .NET Framework 4.6. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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In version 11.11.2 of Visma Document Center we have introduced a
number of new features, implemented a number of important bug fixes and
made some other improvements which are described in this section.
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Improvements 11.11.2

General

Workflow issues

There was an issue with some documents where all the workflow tasks were completed but the status
remained at 20 (workflow is in progress). Occasionally the Document Center client crashed when sending a
document on flow. These issues have been fixed.

Known Issues, Limitations & Restrictions 11.11.2
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Uninstall of Visma Document Center server fails
When performing an upgrade, both the client and the server are first uninstalled and then reinstalled.
Sometimes the uninstaller for the server fails when trying removing the shared folder that the client uses to
install. This is solved for version 9.00.0. Since it is the uninstall that fails this might happen on all versions
before version 9.00.0.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exist, then it
will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues
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In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Visma User Directory

Upgrade when VUD active
Active companies will not be visible in Select ERP client form after upgrade, unless you manually add the
companies in VUD management console > Application instances > Registered companies.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents cause an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.6
The platform has been updated to use Microsoft .NET Framework 4.6. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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In version 11.11.1 of Visma Document Center we have introduced a
number of new features, implemented a number of important bug fixes and
made some other improvements which are described in this section.
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New features 11.11.1

Visma Contracting

Prevent edits to approved documents
Restrictions have been implemented regarding who and when a document can be edited. Restrictions have
been applied to the following roles as described:

All Approver roles

• An approver can not edit a document assigned to a different approver.
• Once a document has been approved it can not be edited by any approver

Document Administrators

• Can not edit approved documents

Document Controllers, Accountants, and Administrators

• Can edit accounting lines of approved documents.

Note:  This feature will not be available in V12.00 of Visma Document Center but will be
available in subsequent versions.

Allow processing of invoices with zero amount totals
Documents with an invoice total of 0 can now be transferred to the Contracting ERP system. This feature is
controlled by a new setting found on the General tab of System Settings under the Tools menu. This option
is available only for Visma Contracting installations.

Note:  This feature will not be available in V12.00 of Visma Document Center but will be
available in subsequent versions.

Improvements 11.11.1

Visma Global

Amount is missing when the document returns from Visma.net Approval
For supplier without currency in ERP system Visma Global, the accounting lines created in Visma.net
Approval did not get the Amount updated correctly at workflow completion.

This has been now corrected and when document is downloaded from Visma.net Approval, the amounts on
the accounting grid are updated correctly.

Visma Contracting

Suggested approvers when sending on flow
There was an issue where approvers were not being suggested when placing documents on flow. This has
now been corrected.

Known Issues, Limitations & Restrictions 11.11.1
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
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already registered for your customer you will get an error code in "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Uninstall of Visma Document Center server fails
When performing an upgrade, both the client and the server are first uninstalled and then reinstalled.
Sometimes the uninstaller for the server fails when trying removing the shared folder that the client uses to
install. This is solved for version 9.00.0. Since it is the uninstall that fails this might happen on all versions
before version 9.00.0.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exist, then it
will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Visma User Directory

Upgrade when VUD active
Active companies will not be visible in Select ERP client form after upgrade, unless you manually add the
companies in VUD management console > Application instances > Registered companies.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents cause an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.
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Technical Framework

Microsoft .NET Framework is upgraded to version 4.6
The platform has been updated to use Microsoft .NET Framework 4.6. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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In version 11.11.0 of Visma Document Center we have introduced a
number of new features, implemented a number of important bug fixes and
made some other improvements which are described in this section.
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New features 11.11.0

Visma Nova

Server isolation
As part of the ability to run Visma Document Center in a hosting environment, we are now supporting
multiple simultaneous and isolated servers instances on the same physical machine, while protecting each
instance from each other, by not allowing one instance to access data from other instances. To facilitate the
creation of multiple instances, a separate tool called  Instance Management Tool has been developed as
part of Visma Document Center.

With the use of Instance Management Tool the administrator is able to create new server instances of the
currently installed VDC installation based on an already existing instance. It will also list instances on
the local machine and provide basic information about each instance, together with other operations like
deleting, verifying and upgrading these instances.

Running the Instance Management Tool

The Instance Management Tool will be installed in the server instalation folder during the VDC server
instalation. The tool starts by running the Visma.Workflow.Nova.IMT.exe executable file or by selecting the
shortcut from the Windows start up menu on the installation server machine.

On the Start page you will find the Instance Root and a list of the existing instances available on the
machine.

The Instance Root is the path where all the instances files will be saved. This path can be changed using
the Change button.The list of instances can be used to view, verify, setup, upgrade, delete and create new
instances.

Selecting one of the existing instances, the IMT will display the input parameters that you have used at
instance creation in read only mode and information related to the Visma.net AutoInvoice and Visma.net
Approval integration.

Creating new instances

1. In the Start page click Create new instance button.
2. Provide an Instance name in the instance field.
3. Click on Create to create the new instance or Cancel to exit without creating the instance. The new

instance is opened in editing mode on a new page.
4. Follow the information displayed for each field and provide the necessary values. Some fields already

have default values that can be changed based on your specific needs.
5. Click the Save instance button after providing all necessary information to finalize the instance creation

on the server machine.
6. To install the VDC client on a client machine, go on the server installation machine\VDCSetup

shared folder and run the installer.The shortcut on the client desktop will have to include the following
parameters:/InstanceRoot:"\<Instance Root Folder>" /InstanceName:<Instance Name> (eg: /
InstanceRoot:"\\pc\Visma" /InstanceName:Two).

Note:  When making VDC instances for a client/server environment, it is recommended to
use a shared path as instance root.

Note:  After the new instance has been done, you will find the new configuration files
and logs under a folder structure with the following structure: ..\<Instance Root Folder>
\<Instance Name>\ , where the Instance Root Folder has been defined on the start page.

Upgrading an instance

After a new version on Visma Document Center has been installed you need to upgrade the existing
instances.

1. In the Start page select the instance you want to upgrade.
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2. Click the Upgrade button. After running the upgrade, the configuration files will be updated and the
services will be started.

Verifying an instance

1. In the Start page select the instance you want to verify.
2. Click the Check instance button. The current status (running/starting/stopped) of the selected instance

services will be displayed

Deleting an instance

1. In the Start page select the instance you want to delete.
2. Click the Delete button. When instance is deleted, the associated databases are not deleted.

Improvements 11.11.0

General

Line import and credit notes
VDC will now handle correctly line import for credit notes.

Automatic line import will fill the credit account field with the account set in the supplier cross account
field.

Credit note with preregistration
When VDC detects that the imported invoice is a credit note and preregistration is also in used, VDC sets
the preregistration account in credit.

Infinite loop when the superior user has the user as a stand in or as superior
In the previous version, when an infinite loop caused by superiors, stand in or stand in -superior cross was
met, the VDC client had a not responding state and after a while an error message was returned. This is now
fixed and when an infinite loop is detected, if the user that caused the infinite loop has already a task started
on the same line it will not be added anymore on the flow.

In server console there are information about the recipient that caused the infinite loop.

No warning is returned in the client.

Save recipient on supplier always active
If "Save recipient on supplier" was enabled on a previous version, after upgrading to the new workflow 2.0
there was no possibility to disable it, since this option is not available anymore as a general setting. This is
now fixed and after upgrading, this setting is disabled.

Manage recipient on supplier form
For a better user experience, Manage recipient on supplier form has been split in two different forms:

• Manage templates: in this form the following functionalities are available: create template, edit
template, delete template, preview template, search for a template

• Manage recipients on supplier: in this form the following functionalities are available: search of
suppliers, lookup of templates for each supplier, preview of selected templates and delete the link
between supplier and template.

Rename "Save recipients to supplier" form
For a better understanding, in the workflow configuration tab, Save recipient to supplier option has been
changed to Create a supplier specific template.

Update list of approvers
If the company was changed from VDC, the recipients list was not updated and the approvers from the
previous company were displayed. In order to get the updated list of recipients, you needed to log out
from Visma Document Center and login again. This is now fixed and the list of recipient will be updated
accordingly when changing the company.

Invoice number field support 25 characters
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Invoices with invoice numbers longer than 25 characters imported by auto import were causing errors in
saving documents and were stopping auto import. This is now corrected. Invoice numbers longer than 25
characters will be truncated to 25.

Automatic interpretation using templates
Empty templates, or templates with 0,0 coordinates were causing Automatic interpretation to crash and stop
importing files. This is now handled and if such a template is created, Autoimport will run as expected.

Improvements on Danish CID interpretation
We have extended the CID interpretation patterns to improve the Danish CID interpretation.

Update Omnipage component
We have updated the Omnipage component to the latest version (20.0.16372.1900).

Visma.net Approval

Update country code
In the activate Visma.net Approval Integration screen VDC will have the entire list of national country
codes instead of a hard coded short list. This way we will support using companies with country code like
Estonia for ex. .

Visma Global

Update accounting line in Visma.net Approval
When a new line was added in Visma.net Approval, containing a general ledger account with a VAT code,
the VAT amount was not added to the line when the document came back to Visma Document Center. This
is now fixed. When a document returns to VDC from Visma.net Approval, all the fields are filled in with
the correct value: VAT amount, Tax class, VAT code.

Visma Nova

Invoice transferred twice to the financial system
When the document transfer to Visma Nova encountered an error, VDC displays an error message and
does not update the accounting status but the voucher was created in Visma Nova. This is now fixed. The
accounting status is updated when the voucher is transferred.

Display cost units in autoflow
When the cost unit ID had a value of 0, this was displayed in the autoflow configuration rule creation
wizard screen. This has been fixed and now the cost unit name and its description are displayed.

Visma Contracting

Select line approvers
When pushing F12 in the line approver field the cursor would to jump to the Voucher date field, so the line
approvers selection was not possible. This is now fixed.

Transfer credit account content to Visma Contracting
When both Credit and Debit accounts were general ledger, the Credit account content was not transferred to
Visma Contracting. This is now fixed and all the values are now transferred.

Known Issues, Limitations & Restrictions 11.11.0
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"
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If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Uninstall of Visma Document Center server fails
When performing an upgrade, both the client and the server are first uninstalled and then reinstalled.
Sometimes the uninstaller for the server fails when trying removing the shared folder that the client uses to
install. This is solved for version 9.00.0. Since it is the uninstall that fails this might happen on all versions
before version 9.00.0.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exist, then it
will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Visma User Directory

Upgrade when VUD active
Active companies will not be visible in Select ERP client form after upgrade, unless you manually add the
companies in VUD management console > Application instances > Registered companies.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents cause an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.
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Technical Framework

Microsoft .NET Framework is upgraded to version 4.6
The platform has been updated to use Microsoft .NET Framework 4.6. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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& Restrictions 11.10.0

In version 11.10.0 of Visma Document Center we have introduced a
number of new features, implemented a number of important bug fixes and
made some other improvements which are described in this section.
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New features 11.10.0

Common Visma Document Center

Introducing new workflow
Managing workflow

Workflows are used for managing the approval process of the accounting vouchers.

When defining a workflow, it can have one or more levels called steps. All the recipients from a step will
get the document at the same time. The next step will be activated only when all the recipients from the
previous step will finish their tasks. If a recipient is selected on multiple steps, it will get the document only
once, on the higher step and all the other tasks will be cancelled as duplicates.

There are no limitations related to the steps that can be added or to the recipients that are on a step.

Once a flow is configured, there is the possibility to save it as a template and reuse it when needed.

The user has the possibility to update/modify a created template or to delete it. This option is available in
the System settings -> Manage recipient on supplier menu or directly in the Workflow Configuration form.

When a document is sent on flow, the user has the possibility to load an existing template or to create a new
flow. Once a document is sent on flow, the recipients will receive the document in their “For approval” list
in Document Center.

The recipients have the following options for deciding the further handling of the document:

• Approve the document. The document is passed to the next recipient.
• Reject the document. The document is returned to the person who initiated the workflow. The workflow

initiator must decide on an action for the document. The workflow will be restarted and the initial flow
will have the status Rejected. Workflow history will be saved and visible in the Workflow tab with a
new graphical representation.

• Forward the document to another person. This means handing over the document task to somebody else
that will be added on the same step.

• Start a review of the document. This means sending the document to another person and requesting that
person to review the document. The reviewer is added on the same step as the initial approver. When the
other person has reviewed the document, it is returned to the person who started the review.

When the last recipient has approved the document, the document is set to 'completed' status, which is
indicated in the document list by the number '30'.

After a workflow has been completed and the accounting information transferred to the ERP system, the
document is moved to Visma Document Center's archive.

Line approvers

You can assign specific accounting rows to specific approvers. These approvers are responsible for
approving their accounting line. The line approvers are initially added on the first step that will contain
only line approvers. This step is not configurable once the document is sent on flow. If the same recipient
is added on the flow as a line approver and also as a document approver, it will receive the document only
once as a document approver and his task as a line approver will be cancelled.

If a line that has been approved by a line approver is changed by another user, than the line will go back to
the line approver on the current active workflow step.

Note:  When saving a workflow that contains line approvers to a template, the line approvers
are not added to the template.

Save recipient to supplier functionality

If the user regularly receives invoices from a specific supplier, and the invoices should always be sent for
approval to a specific person or a group of persons, save recipient to supplier function can be used and
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the person/ group of persons will then automatically be suggested when a workflow will be started for a
document from this supplier.

When Save recipient to supplier is turned on, a new template will be created automatically, having the name
of the supplier.

Managing the recipients linked to a supplier is possible from the new option located in  Tools > System
settings , under the Workflow tab. A new window will open and here you can add an existing template,
create a new one or delete the template that already exists on a specific supplier.

The recipients on supplier will now be saved only in Visma Document Center and they cannot be defined
anymore in the ERP system by updating the supplier information.

Recipients suggested by a template can be modified before sending the document on flow.

Superiors

Superiors are added on Employee in the ERP system. In Visma Document Center there are two
functionalities related to superiors:

• Always add superior: in some companies, it is necessary to always have the superior added to the flow.
This means that whenever a recipient is added to the flow, the superior for this recipient is also added.
Before you can start using the Always add superior functionality you need to check Always add superior
functionality from Tools > System settings > Workflow tab

• Add recipient on approval amount: A recipient's superior can always be added to the flow if the total
amount exceeds the amount limitation set up to the recipient in the ERP. Before you can start using
the Add recipient on approval amount - functionality you need to check Add recipient on approval
amount from  Tools > System settings > Workflow tab.

When superiors are added to the flow, a new level (step) is created automatically and populated with
superiors of the selected recipients. If we have more than one recipient that has the same superior on the
flow, the superior will get the document only once and it will be added on the higher step. The suggested
superiors cannot be removed from the flow and are not visible in the workflow configuration form.

Stand-in

A stand-in can be used when a person is on holiday. All documents sent to the person on holiday will
be transferred to the stand-in instead. The stand-in will always be added on the same step as the original
recipient and in the workflow tab it will also be visible that the original recipient has been replaced with a
stand-in. The stand-in is set in the ERP system.

Cost unit responsible

Many companies use cost units like department and project. Each of these cost units may also have a
responsible set up in the ERP system. In Visma Document Center the responsible may be suggested in
the flow when a flow is activated. When the flow is activated, Visma Document Center will analyze the
cost units in the accounting lines and add the user listed as responsible to the flow for each cost unit. The
recipient based on cost unit functionality is set up in the system settings together with the priority that
controls in which order these recipients should be listed.

Workflow history

The Workflow history is stored on the document and it is visible on the workflow tab. You have the
possibility to select the view type. Bottom right there is a button where you can select advanced view or
standard view.

If the standard view is selected, then only the active tasks from the flow will be visible. If you want to see
everything that happened on the flow you should select the advanced view. In this view, you can also see all
tasks that were cancelled as duplicated.

When moving between documents, the standard view is selected by default.

Autoflow
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Autoflow is an automated workflow functionality. The workflow is created automatically based on user
configured rules. The rules used for creating the flow can be associated to Supplier, Cost Unit or Invoice
reference.

Autoflow rules can be managed from System -> Autoflow configurator menu.

The user needs to select the autoflow trigger and, similar with the normal workflow, it has the possibility to
use an existing template or to create a new one. In this version, the superiors that are set in the ERP system
are also added to the flow. The last approver notion is now obsolete since a template can now have as many
levels (steps) as necessary.

An autoflow rule contains the following details: Autoflow trigger value type, Autoflow trigger value,
template Id and template name. The user has also the possibility to preview the configured flow from an
existing rule, edit a rule or delete it.

Autoflow Configurator form also has the option to define a rule as Default rule. The Default rule will be
applied to each valid document that has no autoflow rule detected based on interpreted trigger values.

Validation of the invoice is done based on the following:

• Bank account is the same as in ERP
• Invoice number does not exist in ERP
• VAT amount not higher than Amount
• Due date not earlier than invoice date
• One supplier identified on bank account and company number

Invalid invoice will arrive in the "New documents" list and user can read on a note about which validation
rules failed. After making all the needed changes, the user can send the document on autoflow again via the
menu Processing > Send on Autoflow or via the right click menu Send document on Autoflow.

Note:  All the Autoflow rules that were created before upgrading to Workflow 2.0 will
be available. The workflow for each rule will be automatically converted into a template.
Parallel workflows will have approvers on a single level with the last approver on the next
one and sequential workflows will have each approver on his own level.

Note:  All the documents that were sent on flow before upgrading to Worflow2.0 will be
treated in the same way as they were on Workflow 1.0.

Known Issues:

The documents in the New Documents list that have line approvers set. In this case, after upgrading, the
document needs to be called back in order to behave correctly.

When approver A has approver B as superior and approver B has approver A as stand-in, an infinite loop is
created in the VDC workflow and we cannot handle this for the moment.

Visma Business product line

Automatic order match with Visma Business
Incoming XML invoices can be automatically matched with a purchase order in Visma Business. If a valid
order number is not identified in the ERP, then the invoice will be handled as a regular incoming invoice.

General Setup

To be able to use this functionality with Visma Business, you must enable Perform automatic order
matching for supported documents option from Tools > System Settings > Order match tab.

When upgrading to this version a new document profile called "automatic order match" will be created.
This document profile is be used as a prerequisite for the documents that can handle the automatic order
match. The automatic order match supports only XML’s in EHF 2.0/ PeppolBis 2.0 format.

Automatic ordermatch on manually imported documents

For manually imported documents that you want to use for automatic order match you need to apply
automatic order match document profile. After interpreting the document it needs to be transferred to the
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ERP system by selecting Send Order(s) to financial system from the right click menu on the document.
If the validation fails, the document will stay in New documents list and a error message box will be
displayed.

Further processing is done in Visma Business.

Automatically imported documents

For automatically imported document you need to setup the automatic order match document profile in
the autoimport / autoinvoice configuration forms for the selected company. The automatic order match
is available in the drop-down list in the Order document profile selection combo box. The automatic
interpretation function must be also enabled.

When the documents are automatically imported, interpretation, validation and transfer to Visma Business is
all done automatically in the background. If the validation fails, the document will stay in New documents
list and will have a note about the failure.

Further processing is done in Visma Business.

Validation of the invoice is done based on the following:

• the document format is EHF 2.0/ PeppolBis 2.0
• the order number is interpreted and must be found in Visma Business under the same supplier

If all the processing is successfuly done, the accounting staus of the document changes to transferred ('30').

Improvements 11.10.0

General

Split document with divider
When the option Split document with divider from Edit menu was used, the document was not split and "
Could not split document" message was returned. This is now fixed and this option can be used.

Scroll in document list
In Document list filter window, there was no possibility to scroll up and down. This is now fixed. A
scrollable panel was added to the document list filter control.

Improved PDF support
We have updated the Omnipage component to the latest version (19.20.16322.1100) which gives us a better
support for PDF file formats.

Visma Business

Exception rotate document
An exception used to occure in the document viewer when you tried to rotate the document. This issue is
now fixed.

Payment terms
If in Visma Business, for a selected supplier the Payment terms sup was set to 1 and the voucher date was
set in the Interpretation results form, the due date was not set correctly. This is now fixed and Visma
Business payment terms are now considered.

Amount removed during automatic interpretation
Some invoices have a reference in the order ID field, order that does not actually exist in Visma Business.
When running automatic interpretation on these invoices the total amount was removed from the invoice.
This is now fixed, and the amount is interpreted as expected.

Visma User Directory

Company access
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We had a security issue related to access companies in VDC that were part of a company group, but did
not have application type Visma Document Center set in VUD. This is now fixed, and companies without
Visma Document Center application type are no longer shown in Select ERP client window.

Visma Nova

Line import and more than 2 decimals
If the supplier delivers more than two decimals in XML, all decimals will be saved into database. If
decimals are typed manually, more than two were saved into database but amount was rounded into two
decimals. This is now fixed.

Callback document from Visma.net Approval
When a document was transferred to Visma Nova before being rejected in Visma.net Approval, the call
back functionality and disable workflow were not available. This issue is now fixed.

Known Issues, Limitations & Restrictions 11.10.0
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Uninstall of Visma Document Center server fails
When performing an upgrade, both the client and the server are first uninstalled and then reinstalled.
Sometimes the uninstaller for the server fails when trying removing the shared folder that the client uses to
install. This is solved for version 9.00.0. Since it is the uninstall that fails this might happen on all versions
before version 9.00.0.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exist, then it
will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.
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Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Visma User Directory

Upgrade when VUD active
Active companies will not be visible in Select ERP client form after upgrade, unless you manually add the
companies in VUD management console > Application instances > Registered companies.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents cause an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.6
The platform has been updated to use Microsoft .NET Framework 4.6. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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In version 11.01.3 of Visma Document Center we have introduced a
number of new features, implemented a number of important bug fixes and
made some other improvements which are described in this section.
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Improvements 11.01.3

Visma.net Approval

Missing VAT amount
When a new line was added to a voucher in Visma.net Approval, the VAT code and VAT amount were
missing on the accounting grid when the document came back from Visma.net Approval to VDC. This is
now fixed and the information is displayed correct on the accounting grid.

Visma Business

Amount removed during automatic interpretation
Some invoices have a reference in the order ID field, order that does not actually exist in Visma Business.
When running automatic interpretation on these invoices the total amount was removed from the invoice.
This is now fixed, and the amount is interpreted as expected.

Known Issues, Limitations & Restrictions 11.01.2
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Uninstall of Visma Document Center server fails
When performing an upgrade, both the client and the server are first uninstalled and then reinstalled.
Sometimes the uninstaller for the server fails when trying removing the shared folder that the client uses to
install. This is solved for version 9.00.0. Since it is the uninstall that fails this might happen on all versions
before version 9.00.0.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.
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For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exist, then it
will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents cause an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.6
The platform has been updated to use Microsoft .NET Framework 4.6. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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Topics:

• Improvements 11.01.2
• Known Issues, Limitations

& Restrictions 11.01.2

In version 11.01.2 of Visma Document Center we have introduced a
number of new features, implemented a number of important bug fixes and
made some other improvements which are described in this section.
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Improvements 11.01.2

General

Support for OIOUBL and EHF credit notes
OIOUBL and EHF XMLs are now identified as credit note during interpretation.

Visma Contracting

Supplier data removed when edit accounting grid
If the accounting grid was changed or updated after a document was interpreted, the supplier number and
name were removed from the document list. This is now fixed and the supplier number and name are no
longer removed.

Accounting grid column setup
An exception used to occur when changing the column setup in the accounting grid and the new setup was
not saved. This is issue now fixed and it is possible now to change the columns order.

Known Issues, Limitations & Restrictions 11.01.2
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Uninstall of Visma Document Center server fails
When performing an upgrade, both the client and the server are first uninstalled and then reinstalled.
Sometimes the uninstaller for the server fails when trying removing the shared folder that the client uses to
install. This is solved for version 9.00.0. Since it is the uninstall that fails this might happen on all versions
before version 9.00.0.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.
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For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exist, then it
will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents cause an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.6
The platform has been updated to use Microsoft .NET Framework 4.6. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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In version 11.01.1 of Visma Document Center we have introduced a
number of new features, implemented a number of important bug fixes and
made some other improvements which are described in this section.
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New features 11.01.1

Visma Contracting

Autofakt settings form
Autofakt settings can now be configured on each company by choosing System > Autofakt menu item.

In this new menu item, you will have the possibility to setup two Autofakt settings:

1. Turn on/off the automatic interpretation of invoices received via Autofakt. By turning this setting ON,
the invoices received from Autofakt will be automatically interpreted. The default value for this setting
is OFF.

2. Send automatically Autofakt documents on flow. This means, that if automatic interpretation has
been done and a case handler has been identified on a order or warehouse, then the invoice will be
automatically sent on flow to the identified case handler. The default value for this setting is OFF.

Improvements 11.01.1

Visma Global

New VAT codes
Due to the new tax regulation in Norway, new VAT codes have been implemented in addition to the old
ones in the Norwegian version.

Visma User Directory

Update license when VUD activated
If some customers upgrade their license with new users, there is no way to update the license through the
application, since that option is removed when VUD is active.

To fix this situation we have added the Update license button to the new license viewer by choosing Help >
License....

Known Issues, Limitations & Restrictions 11.01.1
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Uninstall of Visma Document Center server fails
When performing an upgrade, both the client and the server are first uninstalled and then reinstalled.
Sometimes the uninstaller for the server fails when trying removing the shared folder that the client uses to
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install. This is solved for version 9.00.0. Since it is the uninstall that fails this might happen on all versions
before version 9.00.0.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exist, then it
will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents cause an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.6
The platform has been updated to use Microsoft .NET Framework 4.6. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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In version 11.01.0 of Visma Document Center we have introduced a
number of new features, implemented a number of important bug fixes and
made some other improvements which are described in this section.
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New features 11.01.0

Visma.net Approval

Company organization numbers for Norway when sending to Visma On Demand
Starting version 11.01, VDC will trim the letters form the organization numbers sent to Visma.net for
Norwegian companies.

Eg.: NO123456MVA will be sent as 123456 to Visma.net.

This is due to alignment with VBPL with Visma.net integration.

The change will affect the companies that are active in the Visma.net Approval integration from older
versions and also for the companies that are going to activate the Visma.net Approval integration from now
on.

For the companies that already have active the Visma.net Approval it should be verified in Visma.net if the
company organization number has been updated. If not, it has to be updated manually and the ODBridge
manually restarted.

Show status for Visma.net Approval Integration
A new status icon has been added to the VDC status line that shows the Visma.net Approval integration /
ODBridge status.

When the Approval integration is up and running the Approval icon is colored in blue, when the interation
is down the icon is greyed out.

This icon shows the status that is also displayed in Visma.net Approval Integration Status screen,
accesible from Tools > System status > Visma.net Approval Integration Status.

Visma.net AutoInvoice

Send license ID to Visma.net AutoInvoice
Starting version 11.01, VDC will send the license ID to Visma.net AutoInvoice.

Request Visma XML 6 from Visma.net AutoInvoice
Starting this version, Visma Document Center can request from Visma AutoInvoice files in the Visma XML
6.0 format.

Visma XML 6.0 has been added to Visma Document Center formats in VDC.

To download invoices in Visma XML 6.0 format this format should be selected as XML format to be used
in the Autoinvoice configuration form.

Visma XML 6.0 stylesheet
We have added default Visma XML 6.0 stylesheets in Danish, Finnish, Norwegian and Swedish so that
starting this version, Visma XML 6.0 invoices will be displayed in the VDC client selected language.

Visma Global

Turn off MDM transfer in VDC
Starting with version 11.00, Visma Global will start transferring General Ledger and Cost units to MDM.
Therefore VDC will not transfer MDM data to MDM anymore; documents are going to be transferred to
Visma.net Approval as before.

Visma Contracting

Automatic interpretation of Autofakt invoices
Invoices received via Autofakt from Visma Contracting are now automatically interpreted. Invoices
automatically interpreted can now be sent on autoflow.

Send additional invoice details to Visma Contracting
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Starting this version, some additional information will be displayed in the accounting grid and transferred to
Visma Contracting. The product number, quantity, price (per item) and discount (%) will be displayed
in addition in the accounting grid. Product number and quantity will be also transferred to Visma
Contracting.

Interpret order number
The order number is now automatically interpreted on the received invoices.

Site type
A new setting called Site type has been added to Visma Contracting. If this setting is active, then the site
ID is required when transfering vouchers from VDC. If this setting is active and the site ID is not set on the
accounting line, then the voucher will not be transferred to Visma Contracting.

Improvements 11.01.0

General

Edit category property
From this version, all the roles can change the category except the Approval role who is denied editing
capabilities at the server level. The following are the roles that can change the Category:

-Approver, edit cost unit

-Approver, edit cost unit and accounts

-Approver, edit all accounting fields

-Document creator

-Document controller

-Accountant

-Administrator

Recognize Visma XML invoice without a stylesheet reference
Visma XML format is now recognized and the default stylesheet is applied when the invoice does not
contain stylesheet reference. Default stylesheets for Visma XML versions 3.0, 4.0, 5.0, 5.1, 5.2, 5.3 and 6.0
have been added.

Support for EHF credit notes
In the previous version, VDC displayed the EHF credit notes using UBL invoice stylesheet. This is now
fixed and the EHF credit notes are now displayed and interpreted correctly.

The link to the stylesheet is not used from VDC but works from Internet Explorer
Because the stylesheet was not found when ' character was used, some XML invoices were not correctly
displayed in VDC. This is now fixed, and the XML invoices are correct displayed.

Large event table
We had problems in some environments with large event tables, that is now fixed. We have added a button
that allows a administrator user to delete records in between date intervals.

PDF attachments not imported to VDC due to large image size
The pdf file from the attachment is now imported without returning any error message but gives
performance issues that we are not able to improve for now.

The loadable image size is controlled by two settings: Kernel.Img.Max.Pix.X and Kernel.Img.Max.Pix.Y
(defaults are both 8400 pixels). The option to alter these settings to bigger values (12600 pixels) when the
image size error occurs has been added. These settings can be set in the client/server configuration files
using the "KernelImgMaxPixX" and "KernelImgMaxPixY" keys in <appSettings>.

Note:  Increasing these would require more memory resources so it should be used only
when really needed.
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The values can be increased up to 32000 pixels in both directions (OmniPage limitation).

Autoimport large TIF file
Some large TIF files could not be imported to Visma Document Center, but they were deleted from the
autoimport folder. This has been fixed and the invoices are now imported. We have also added a warning
message when the image resolution is not supported by VDC.

Visma User Directory

Save import/export operation logs
If you run into an issue while running the import/export to VUD operation you might want to consult the
log files. Starting this version we automatically save on the disk the logs that are generated during the
export / import from VUD operations.

The logs are saved in the following location ..\AppData\Local\Visma\Visma Document Center
\VismaUserDirectory.

Visma Business

ERP Client selection window open instead of login in to same client as in Business
When using windows authentication and VDC was started from Visma Business, Select ERP form used to
be displayed. This is now fixed and the user is automatically logged on to the same company as in Visma
Business.

Support for Visma Business with /n
Visma Document Center did not work when starting Visma Business with /n parameter and registry key
different from CurrentVersion. This is now fixed.

Visma Global

Move documents when VDC is started from Visma Global
When Visma Document Center was started from Visma Global, the user could not move a document from a
company to another. This is now fixed. When the user tries to move the document to another company, only
for the first document it will be asked for his credentials, so that the move can occur. The next documents
will be moved without requiring the user name and password.

Voucher number series per year
When voucher number series per year was enabled in Visma Global and clicking on the Show ERP button,
you saw all the accounting lines for that voucher regardless of year. Now that is fixed. We use document ID
in filtering the lines.

AccountView

Filter purchase order list based on project code
When a Project code was entered and the list of Purchase order numbers was opened, all the purchase order
numbers were available. This is now fixed and only the purchase order numbers with the entered project
code will be displayed.

Dutch decimal mark
When the regional settings are set to Dutch, the "." (dot) decimal separator is converted to the "," (comma)
decimal separator. This conversion takes place both for "manual entry" and "automatic" entries.

Known Issues, Limitations & Restrictions 11.01.0
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
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already registered for your customer you will get an error code in "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service" must
be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Uninstall of Visma Document Center server fails
When performing an upgrade, both the client and the server are first uninstalled and then reinstalled.
Sometimes the uninstaller for the server fails when trying removing the shared folder that the client uses to
install. This is solved for version 9.00.0. Since it is the uninstall that fails this might happen on all versions
before version 9.00.0.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1001 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exist, then it
will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Visma Contracting

Warehouse responsible
For invoices with warehouse number imported from Autofakt, the warehouse responsible will not be
suggested in the Visma Document Center Workflow dialog. Workflow recipient has to be added manually.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

A missing booking period on the documents will cause an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.
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Technical Framework

Microsoft .NET Framework is upgraded to version 4.6
The platform has been updated to use Microsoft .NET Framework 4.6. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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Chapter

29
Visma Document Center 11.00.0

Topics:

• New features 11.00.0
• Improvements 11.00.0
• Known Issues, Limitations

& Restrictions 11.00.0

In version 11.00.0 of Visma Document Center we have introduced a
number of new features, implemented a number of important bug fixes and
made some other improvements which are described in this section.
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New features 11.00.0

Common Visma Document Center

Automatically assign document profile to credit notes and order match documents
In the process of automating the user activity, we have introduced a new feature that allows to automatically
apply separate document profile for credit notes and order match documents.

To use this functionality, you need to set up the document profile for the incoming credit notes and order
match documents that are automatically imported via Autoimport or Autoinvoice in System > Autoinvoice
configuration or System > Autoimport configuration menu item.

Note:  When integrated with Visma Business or Visma Global the credit note and order
match document profiles are filtered by document type, so an empty list is displayed if no
such document profile exists.

After the documents have been imported, VDC will detect the invoice as credit note or as an order and will
apply the document profile accordingly.

Enable VAT handling on line import for EHF invoices
Line import functionality now supports VAT handling for XML formats which have the NET Amount on
the lines. VDC will interpret the line level NET Amount and VAT Amount. The line level TotalAmount will
be calculated using the interpreted values.

The XML dictionary will contain system defined keywords to interpret NETAmount and VATAmount for
the most common XML formats (VismaXML, EHF, Swefakt, Finvoice). For custom XML formats, you
must configure the XML dictionary to interpret the NETAmount and VATAmount.

VDC will also support preregistration and line import.

In the case of preregistration, the Total VAT amount is posted on the preregistration line. The accounting
lines created with line import will not have a VAT Amount.

Note:  If the VAT Amount has been interpreted and the interpreted value is different than the
calculated value based on the VAT code, then this will overwrite the calculated value.

If there is no VAT Amount on the accounting line, then the Total Amount will be the same as NETAmount.

Show license information
We have added a new menu item where you can view the Visma Document Center license information.

This information can be found by choosing Help > License... menu item.

Disable workflow active
Sending an invoice to the ERP before the workflow is finished used to deactivate the Disable workflow
option. Now this has been changed. If the workflow is not completed it is transferred to the ERP, the
Disable workflow option remains active. So when the flow is canceled, the document is transferred to the
archive.

Templates for automatic interpretation
The automatic interpretation has been improved. Templates can now be used when PDF files, which came
through Autoimport, are automatically interpreted.

Visma.net Approval

Send invoice number to Visma.net Approval
In the previous versions the users were not able to search for an invoice in Approval using the invoice
number because this field was not sent by Visma Document Center to Approval. This is now changed and
the invoice number is sent to Approval in the description field. This field will contain only the invoice
number, so the supplier name and amount/currency amount were removed from it.
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Visma Business product line

Turn off MDM transfer in VDC for Visma Business integration
Starting with version 11.00 Visma Businesswill start transferring General Ledger and Cost units to MDM.
Therefore, documents are going to be transferred to Approval as before, but Visma Document Center will
not transfer MDM data to MDM anymore.

Line import with pre-registration document profile
When using pre-registration together with line import the final booking voucher type was not set on the
imported lines even if there was a pre-registration accounting rule created. This is now fixed and the final
booking voucher type will be set on the imported lines. Also VAT amount will be set to decimal zero on all
the imported lines if there is a pre-registration accounting rule.

Visma Nova

Goods receive date on order match form
We have added the possibility to see the goods receive date and also, to change invoice date in Visma Nova
order match form.

New check box on order match form
We have added a Select all lines check box in the order match form for Visma Nova integration. Now it is
possible to select all available order lines.

Improvements 11.00.0

Technical

Technical Framework
The platform has been updated to use Microsoft .NET Framework 4.6. Visma Document Center can run on
any Microsoft Windows operating system that supports .NET Framework 4.6. Further details can be found
on Visma application compatibility page.

Update SyncEngine to version 2.11.1
The SyncEngine asset, used in Document Center has been updated from version 2.10 to version 2.11.1

New default value of MSI property ODBridge_AcknowledgeUnknownWorkflowHandles

The value of the ODBridge_AcknowledgeUnknownWorkflowHandles MSI property is by default set to
"true".

ODBridge shall not be removed in maintenance
When entering the maintenance mode, ODBridge was removed and not reinstalled even if the server setup
was rerun. This is now fixed and ODBridge is not removed anymore.

Improved performance selecting suppliers
Some users were experiencing some performance issues when they were trying to get the supplier list to
configure suppliers with line import disabled.

This is now fixed and the performance and usability of this functionality have been improved. A combo
box that allows to search for a supplier has been added to the bottom of the window. When the name/id is
written in the combo box, partial matches will be displayed. These matches can be selected either by mouse
or keyboard, and pressing “Enter” will add them to the list. A supplier can be removed from the list by
selecting it and pressing “Delete”.

General

Document note icon
The document note icon is visible again in the document list for documents that have manual added notes.
For the automatically added notes (such as notes marking documents imported by Autoinvoice or when
marking failed Autoflow validations) the note icon is not displayed.

Improved autoflow rules
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In the previous version, when an autoflow approver was replaced with itself, the approver was deleted from
the rule. This is now fixed and the approver is not deleted anymore.

Update VAT code and VAT amount
If an account with VAT code was selected and after this changed to another account with no VAT code,
neither VAT amount or VAT code were removed from the accounting grid. This is now fixed and VAT code
and VAT amount are removed when changing the GL account to one where VAT code is 0.

Automatic bank account and organization number interpretation improvement
When the organization number or the bank account were not interpreted, the values were fetched from ERP
and put in the interpreted value field. This happened only when automatic interpretation was used. This is
now fixed and the interpreted value fields contain values only if these are actually interpreted.

Invoice reference longer than 50 chracters
An exception used to occur when documents imported via Visma AutoInvoice have the invoice reference
field longer than 50 characters. This is now fixed and the invoice reference is truncated when longer than 50
characters.

Removed keyword from XML dictionary
In order to improve the Bankgiro interpretation we haved removed the system defined target value Invoice
\cac:PaymentMeans\cac:PayeeFinancialAccount\cbc:ID for Bank account keyword from the XML
dictionary. In case this value is needed for some invoices you will have to update manually the user defined
dictionary.

Visma Business

Support equal sign as character of the database user
Equal sign (' =') was not supported by Visma Document Center as character in the database user password.
This is now fixed and the passwords containing the equal sign can be used.

VDC client crash
When having VUDauthenticationVDC client used to crash at logon if one or more companies were missing
the VudStaticId in Visma Business. This issue has been fixed, but these companies are no longer showed
in the Select ERP client window when starting Visma Document Center. This information is logged in the
Visma.Workflow.Client.Windows log files.

Consider "0" prefix when interpreting bank accounts
On previous version “0” prefixes for bank account were ignored. This is now fixed and if bank account
string will be composed entirely of zeros, it’s content will be returned.

Pre- registration suggested account
When using pre-registration, the account on the supplier that was set in the GL account supplier field was
suggested on the final booking in VDC line instead of Cross-account supplier. This is now fixed and the
account from Cross-account supplier is suggested on the final booking line.

Line import with pre-registration document profile
When using pre-registration together with line import the final booking voucher type was not set on the
imported lines, even if there was a pre-registration accounting rule created.

This is now fixed and the final booking voucher type will be set on the imported lines. Also VAT amount
will be set to decimal zero on all the imported lines if there is a pre-registration accounting rule.

Visma Global

Bank account update
When running Visma Document Center against Visma Global, the bank account on the accounting grid
remained empty when a supplier was set on the document. This is now fixed and the bank account in
accounting header is the same as the one from the supplier.

If the supplier is updated, then the bank account field will be updated accordingly. When the supplier is
deleted from either document edit form or accounting grid, the bank account will not be deleted from
accounting header.

Improved error message
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When documents were transferred from VDC to Visma Global and the cost units were required but not set
on a document, a generic error message was displayed without containing the invalid document’s id. This is
now fixed and the invalid document’s id is also displayed in the error message for a better identification.

Improved VAT code description translation
When using Document Center against Visma Global, if the Norwegian language was selected and then
changed to English, Vat code description was not translated until the server was restarted. This is now fixed.

Known Issues, Limitations & Restrictions 11.00.0
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Uninstall of Visma Document Center server fails
When performing an upgrade, both the client and the server are first uninstalled and then reinstalled.
Sometimes the uninstaller for the server fails when trying removing the shared folder that the client uses to
install. This is solved for version 9.00.0. Since it is the uninstall that fails this might happen on all versions
before version 9.00.0.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exist, then it
will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".
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Visma Contracting

Warehouse responsible
For invoices with warehouse number imported from Autofakt, the warehouse responsible will not be
suggested in the Visma Document Center Workflow dialog. Workflow recipient has to be added manually.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents cause an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.6
The platform has been updated to use Microsoft .NET Framework 4.6. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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Chapter

30
Visma Document Center 10.11.3

Topics:

• New features 10.11.3
• Improvements 10.11.3
• Known Issues, Limitations

& Restrictions 10.11.3

In version 10.11.3 of Visma Document Center we have introduced a
number of new features, implemented a number of important bug fixes and
made some other improvements which are described in this section.
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New features 10.11.3

Common Visma Document Center

Show additional invoice status quantities in opening window
To improve accounting offices user experience, a new column that shows the number of documents ready
for transfer has been added to the Select ERP client form. That means, that the column "Completed" shows
documents that have workflow status "completed" and accounting status different than "transferred".

Sort the Show ERP client form
To give a better support for the accounting offices users,in Select ERP Client form, the company list
information is now sortable on each column.

Improvements 10.11.3

General

VDC client freeze
Some users were experiencing performance issues caused by internal changing the log level for some
important information messages. This caused "Info" messages from other threads to get recorded even
though the log level was set to "Warning". This is now fixed. In the current behavior, when log level is set
to warning then, in the log file will appear warnings and important info. Important info is marked with "off"
instead "info", to avoid confusion.

Improved performance when running Excel report in VDC
Some users were experiencing performance issues when running the Excel report in Visma Document
Center and client went into a not responding state. Now this has been fixed, and the performance when
running the Excel report in Visma Document Center has significantly been improved.

Autoimport improvements
If documents were added in the autoimport folder in the same time when the autoimport task was running,
the new documents were deleted by the task. We have fixed this issue and any additional files added during
the task run will be kept in the folder to be picked up by the next run.

Known Issues, Limitations & Restrictions 10.11.3
This list covers some of the known problems with this version, which will be resolved in future releases.

General

'=' not supported in database user password
Currently, Visma Document Center does not support the equal sign ('=') as character in the database user
password.

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".
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Uninstall of Visma Document Center server fails
When performing an upgrade, both the client and the server are first uninstalled and then reinstalled.
Sometimes the uninstaller for the server fails when trying removing the shared folder that the client uses to
install. This is solved for version 9.00.0. Since it is the uninstall that fails this might happen on all versions
before version 9.00.0.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exist, then it
will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Visma Contracting

Warehouse responsible
For invoices with warehouse number imported from Autofakt, the warehouse responsible will not be
suggested in the Visma Document Center Workflow dialog. Workflow recipient has to be added manually.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents cause an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.5
The platform has been updated to use Microsoft .NET Framework 4.5.2. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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In version 10.11.2 of Visma Document Center we have introduced a
number of new features, implemented a number of important bug fixes and
made some other improvements which are described in this section.
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Improvements 10.11.2

General

Send cost units start / end date to MDM
Starting with version 10.11.2, VDC will send to MDM the start and stop date of cost units. This will help
customers to have the correct MDM data available in their applications. For example, in Visma.net Expense,
the Cost units are filtered based on end date.

Known Issues, Limitations & Restrictions 10.11.2
This list covers some of the known problems with this version, which will be resolved in future releases.

General

'=' not supported in database user password
Currently, Visma Document Center does not support the equal sign ('=') as character in the database user
password.

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Uninstall of Visma Document Center server fails
When performing an upgrade, both the client and the server are first uninstalled and then reinstalled.
Sometimes the uninstaller for the server fails when trying removing the shared folder that the client uses to
install. This is solved for version 9.00.0. Since it is the uninstall that fails this might happen on all versions
before version 9.00.0.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exist, then it
will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.
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Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Visma Contracting

Warehouse responsible
For invoices with warehouse number imported from Autofakt, the warehouse responsible will not be
suggested in the Visma Document Center Workflow dialog. Workflow recipient has to be added manually.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents cause an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.5
The platform has been updated to use Microsoft .NET Framework 4.5.2. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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Topics:

• Improvements 10.11.1
• Known Issues, Limitations

& Restrictions 10.11.1

In version 10.11.1 of Visma Document Center we have introduced a
number of new features, implemented a number of important bug fixes and
made some other improvements which are described in this section.
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Improvements 10.11.1

Visma Contracting

Exception when running automatic interpretation
When running against Visma Contracting, an exception occured at automatic interpretation because
the rounding amount is not calculated in this case. Running autoimport and autoinvoice with automatic
interpretation no longer triggers an exception.

Improved autofakt credit note interpretation
When a autofakt credit note document was interpreted, the voucher type changed and the general ledger
account was updated in both debit account and credit account. This is now fixed., so when interpreting
Autofakt invoices the voucher type will be set correct and the account from the voucher type will be set on
debit/credit according to the voucher type.

Credit note from Autoinvoice and Autoimport handling
When credit invoices were received from autoinvoice and autoimport in Visma Document Center, the
voucher type and the credit and debit accounts were not set correctly. This is now fixed and the credit notes
are handled properly.

Known Issues, Limitations & Restrictions 10.11.1
This list covers some of the known problems with this version, which will be resolved in future releases.

General

'=' not supported in database user password
Currently, Visma Document Center does not support the equal sign ('=') as character in the database user
password.

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Uninstall of Visma Document Center server fails
When performing an upgrade, both the client and the server are first uninstalled and then reinstalled.
Sometimes the uninstaller for the server fails when trying removing the shared folder that the client uses to
install. This is solved for version 9.00.0. Since it is the uninstall that fails this might happen on all versions
before version 9.00.0.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.
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Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exist, then it
will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Visma Contracting

Warehouse responsible
For invoices with warehouse number imported from Autofakt, the warehouse responsible will not be
suggested in the Visma Document Center Workflow dialog. Workflow recipient has to be added manually.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents cause an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.5
The platform has been updated to use Microsoft .NET Framework 4.5.2. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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In version 10.11.0 of Visma Document Center we have introduced a
number of new features, implemented a number of important bug fixes and
made some other improvements which are described in this section.
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New features 10.11.0

Common Visma Document Center

Visma Document Center handles rounding difference between invoice lines and invoice total
When Visma Document Center is integrated with Visma Business product line, Visma Global or Visma
Nova it is now possible to setup the XML dictionary to interpret the rounding amount if any, and
automatically create rounding line based on rounding account from integrated ERP. Please refer to User
guide for limitations and details.

Supplier specific XML dictionary
In order to improve the interpretation quality of the XML documents, Visma Document Center XML
dictionary has been extended, and now supports supplier specific keywords, in addition to the system
specific and user defined keywords.

In order to add a supplier specific keyword the supplier's organization number needs to be set.

When a document from a supplier with specific keywords is interpreted, the supplier must be first
identified. When the supplier is found, the system will check for supplier specific keywords, and, if found,
these will be used instead of the user defined or system specific keywords.

The extension of XML dictionary also improve the Autoflow functionality. For more details on how to
define supplier specific keywords, please reffer to Visma Document Center user guide.

Supplier specific line import
To improve performance, and increase flexibility it is now possible to disable line import for a specific
supplier. This feature applies for both manual and automatic interpretation.

Improved Autoflow rule management
In this release we have continued to develop and improve the Autoflow rule management. New features,
like mass update changes, adding a new empty row in the grid when adding a new rule, duplicate a rule and
the possibility to delete more than one rule at a time have been added to the Autoflow Configurator screen.

Autoflow and invoice refference
Visma Document Center now supports interpretation of an invoice reference for both XML and paper
invoices. To interpret the invoice refference you hav eto setup the dictionary with the right keywords.

The Autoflow functionality has been extended and now it is possible to automatically send an invoice on
flow based on the interpreted invoice reference.

Duplicate a document in new documents list
The user is now able to copy existing documents by using the "Duplicate document" option found in the
right click menu.

To duplicate a document the user needs to be a Document Creator or an Accountant.

The duplicate will have the same property values as the original with the following exceptions:

• New Id is provided;
• Created and LastUpdate are set to today's date;
• CreatedBy and LastUpdatedBy are set to empty strings;
• Accounting Status is set to Not Transferred;
• Workflow Status is set to None;
• VoucherNo and BatchNo are set to 0;
• Pre-registration accounting lines, if any, are not copied to the duplicate document;
• Document Notes are not copied;
• The duplicate document will have a default note added, saying that is a duplicate document.

Although different document ID-s are created for the duplicate document, they will point to the same file on
disk, so be aware of deleting documents. If the original document is on flow, the duplicate document will
not inherit that.
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Improvements 10.11.0

General

Workflow improvements
When a document was sent on flow to a user that had a superior or sent sequentially to two users, if the first
user rejected the document, the second user or the superior was not able to approve the document anymore.
This is now fixed and the approving is possible in all the required situation.

F6 Shortcut fix
F6 key allows you to navigate between the four different lists, document list, picture viewer, comments and
accounting line, but jumping to comments area was not working. This is now solved.

Improved supplier identification
When the interpreted organization number matches with the organization number of several supliers in the
ERP, but with different bank accounts, only one supplier was identified and listed in IRF. This is now fixed
and all the identified suppliers matched on the organization number are listed in the IRF.

Identify supplier based on organization number
When running interpretation, if the identified bank account is different than the one from the ERP, but the
Organisation No is the same, the supplier is not identified. This is now solved and the supplier is identified
based on the organization number.

Restricted access for accountant users
Menu items Visma AutoInvoice and AutoImport are now disabled for users with Accountant role.

Transfer cost center selection to Visma Document Center
Cost units with ID 9 are now transferred correctly to Visma Document Center from Visma Approval.

Visma Global

Fixed RCC Lib issues
Interop.RCCLib.dll library is now properly located and resolved from the Document Center install folder.

Visma Nova

Fetch Cost center from Supplier
Cost centers assigned to a supplier in Visma Nova are now set on the accounting line during interpretation.

AccountView

Update project code description
When working in a project organization, there is a default entry on order line number. Previous, when
project code was filled in by default, then the project code description did not appear, which made a
manual handling still necessary. This is now fixed and project code and project code description are fetched
automatically.

Default order entry
In the previous version, if in Document Center was used a purchase order that had an amount that uses a
decimal mark, the amount field in Document Center was filled in with a different value than the amount
from Account View because ‘.’ was not used as decimal mark. Now this is fixed and the amount parsing for
purchase order is culture independent, so the amount from Document Center is the same as it is in Account
View.

Interpret and save VAT amount into OCR template
For Account View integration we have the possibility to interpret/recognize the VAT Amount and create
template for VAT Amount, but the recognition of the VAT amount was not saved in the template. This is
now solved.
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Known Issues, Limitations & Restrictions 10.11.0
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Uninstall of Visma Document Center server fails
When performing an upgrade, both the client and the server are first uninstalled and then reinstalled.
Sometimes the uninstaller for the server fails when trying removing the shared folder that the client uses to
install. This is solved for version 9.00.0. Since it is the uninstall that fails this might happen on all versions
before version 9.00.0.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exist, then it
will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Visma Contracting

Warehouse responsible
For invoices with warehouse number imported from Autofakt, the warehouse responsible will not be
suggested in the Visma Document Center Workflow dialog. Workflow recipient has to be added manually.
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AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents cause an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.5
The platform has been updated to use Microsoft .NET Framework 4.5.2. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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In this version of Visma Document Center we have introduced a new
feature which is described in this section.
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New features 10.10.0

Common Visma Document Center

Integration with Visma User Directory
Integration with Visma User Directory is now supported when running Visma Document Center with Visma
Business and Visma Global

Visma User Directory provides user authentication and authorization services for Visma applications. Visma
User Directory provides Single Sign-On to users, which enables a user to be authenticated once and gain
access to multiple applications.

Visma User Directory also provides central administration of users and roles across Visma applications

For more detailed information related to VUD configuration and settings, please consult the VUD help
menu.

When you upgrade or install Visma Document Center for the first time, using the standalone installer, you
can choose to activate the integration with Visma User Directory.

Before activating VUD in Visma Document Center you must make sure that the integration between Visma
Business or Visma Global and VUD is active.

The other Visma Document Center integrations do not support integration with VUD.

For the moment, you can activate the integration with VUD from dedicated page of the installer by clicking
Enable Visma User Directory.

To complete the integration with Visma User Directory a data export has to be done. This has to be executed
at the first start up of Visma Document Center by the VudAdmin user.

Known Issues, Limitations & Restrictions 10.10.0
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Uninstall of Visma Document Center server fails
When performing an upgrade, both the client and the server are first uninstalled and then reinstalled.
Sometimes the uninstaller for the server fails when trying removing the shared folder that the client uses to
install. This is solved for version 9.00.0. Since it is the uninstall that fails this might happen on all versions
before version 9.00.0.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
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Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exist, then it
will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Visma Contracting

Warehouse responsible
For invoices with warehouse number imported from Autofakt, the warehouse responsible will not be
suggested in the Visma Document Center Workflow dialog. Workflow recipient has to be added manually.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents cause an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.5
The platform has been updated to use Microsoft .NET Framework 4.5.2. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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In version 10.01.1 of Visma Document Center we have introduced a new
feature which is described in this section.
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Improvements 10.01.1

General

Documents not imported by autoimport
VDC Autoimport functionality did not support empty company names. Empty company names caused
deletion of documents from Autoimport. We have fixed this issue now. Companies that does not have name
in the ERP will be skipped by the Autoimport task.

Known Issues, Limitations & Restrictions 10.01.1
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Uninstall of Visma Document Center server fails
When performing an upgrade, both the client and the server are first uninstalled and then reinstalled.
Sometimes the uninstaller for the server fails when trying removing the shared folder that the client uses to
install. This is solved for version 9.00.0. Since it is the uninstall that fails this might happen on all versions
before version 9.00.0.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exist, then it
will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues
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In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Visma Contracting

Warehouse responsible
For invoices with warehouse number imported from Autofakt, the warehouse responsible will not be
suggested in the Visma Document Center Workflow dialog. Workflow recipient has to be added manually.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents cause an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.5
The platform has been updated to use Microsoft .NET Framework 4.5.2. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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In version 10.01.0 of Visma Document Center we have introduced a
number of new features, implemented a number of important bug fixes and
made some other improvements which are described in this section.
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New features 10.01.0

Common Visma Document Center

Default style-sheet support for OIO UBL credit note and EHF invoices
Visma Document Center now contains default style-sheet support for OIO UBL credit notes and EHF
invoices. Further details related to default style-sheet handling can be found in our documentation: Links to
other documentation chapter, Previous Release notes document, Page 54.

Line numbers in VDC
Having documents with many accounting lines may be sometimes difficult to handle. Therefore, to have a
better overview on the accounting grid we are now displaying the document lines in the accounting grid.

Update VismaLicensing with Visma.net AutoInvoice information
Improvements have been made with the interactions between Visma Document Center, Visma.net
AutoInvoice and Visma's Licensing System to provide more accurate usage statistics.

Display cost units and cost units value in External Archive
When the transactions were extracted via external archive, cost units and cost units values were not shown.
This is now fixed and cost units and cost unit values are displayed in the html and excel file.

Visma Business product line

Update integration user credentials
Visma Workflow Server Manager is a new tool developed to help the administrator to change the
integration user password when this has been changed in Visma Business. You can find Visma Workflow
Server Manager in the Visma Document Center server installation folder. After the integration user
password has been changed, run the Visma Workflow Server Manager, update the password, apply the
changes and then just restart the VDC server.

Improved preregistration functionality: Suggest cost unit on final booking line
We have introduced an improvement on the existing Preregistration functionality with Visma Business:
automatic suggestion of the cost units on final booking line.

The new functionality have the following behavior:

1. If the supplier set on the document have linked cost units, then those cost units are fetched on the final
booking line. In Visma Business, the preregistration account must be blocked for cost units if you do not
wish to have the cost units on the preregistration row.

2. If both the Supplier and final booking account have cost units linked, then the cost units linked to
supplier will have higher priority.

3. If the supplier does not have linked cost units then the cost units linked to the final booking account will
be fetched on the final booking line.

4. If the general ledger account used on final booking line does not allow cost units, then the cost units are
left blank.

Visma Contracting

Save recipient to supplier functionality for Visma Contracting
Save recipient to supplier functionality is now supported in the Visma Contracting integration.

When the user sends a document on flow, they now have the ability to link the recipient to the supplier on
the document.

Subsequently, on the next document for that same supplier, the system will suggest the recipient previously
linked in the Recipient Selection form.

Improved Contracting style-sheet installed with VDC

The E2B style-sheet used in the Autofakt import has been improved.  The warehouse number and order
number is now shown if supplied with the invoice.
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Visma Nova

Finvoice XML
Visma Document Center version 10.01 will support Finvoice 3.0 XML version.

Improvements 10.01.0

General

Identify supplier on XML invoice with more than one bank account
Previously, for the invoices that had more than one bank account, even if all the bank accounts were
interpreted, the suppliers were identified only on the company number or the first bank account.

Now this is improved and all the suppliers are identified based on all interpreted bank accounts. However, if
there is an exact match on both company number and bank account, that supplier is saved on the document.

Autoflow validation improvement
In order to avoid useless document notes, autoflow validation is done only for the invoices which for we
detect an autoflow rule.

Improvements when importing unsupported document types
Previously, when an unsupported file was imported or it was appended to a document, an exception was
received. This is now fixed and when an unsupported file is imported or appended to a document, a warning
message will be displayed and the user will be notified about unsupported file types.

E2B default style-sheet fixed
The internal default style-sheet was missing the tag for <ref>. This is now corrected and <ref> tag is now
shown in the internal style-sheet.

XML line import improvements
Previously, the XML files that contained different nodes with the same name and different sub codes were
not supported by Visma Document Center because the tags we got in VDC were not unique. This is now
fixed and the invoices are displayed correctly.

Visma Document Center support importing large PDF files
We have improved the document import function and large pdf files are imported without any errors.

Autoinvoice import improvement
The import of large documents from Visma.net AutoInvoice failed and generated an error. This is now
solved.

Improvements using Template
Using the Save and OCR in IRF was closing the form. This is now fixed and the interpretation result form
will remain opened.

Visma Business

Improved order match functionality
In the existent order match functionality against Visma Business, the order number is interpreted and saved
on the document, and then the document is automatically transferred to the ERP. This feature generated a lot
of support if the order number was incorrectly interpreted.  Changing it was not possible due to accounting
status set to transferred.

Order match functionality is now improved to solve the described issue.  Documents will no longer get
the accounting status transferred automatically.  When the user wishes to transfer the document for
order match they must manually select the new option:  Send order(s) to financial system located in the
Processing menu.

Send order(s) to financial system in right click menu
Send Order(s) to financial system option is also present in the right click menu as well for the Visma
Business integration.
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Update of orders status in Visma Business on Send order(s) to financial system
Since there is a new way of transferring the order match documents to Visma Business, the updates on the
order status in Visma Business is done when the Send order(s) to financial system is done based on the
workflow status:

1. Invoice received can be done (is NOT excluded) in Visma Business when invoice is already transferred
and the workflow is completed or disabled .

2. Invoice received cannot be done (IS excluded) in Visma Business invoice is transferred but the
workflow is not yet completed or is not disabled.

Notification about blocked orders
We have improved the transfer of documents for order match so that when the order is in edit mode in
Visma Business, VDC will not allow transfer of the document, since the order is blocked for update. In this
case the user is prompted with the message:

The order is not available due to unsaved changes

Update order line with Document ID on partial order matching
When partial order matching is done, VisaID ID field should contain the Document ID of the last document
matched to the order. In previous versions VismaID Id field was not correctly updated in Order line table.
VismaID ID field will be updated on each order line where finished quantity is different than invoiced
quantity on order line.

New default filter to handle invoices with purchase order number
We have created a new default filter to see in a fast manner the documents meant for order match.

Fetch GL account from voucher type
Previously, if the GL account supplier was not set in Visma Business but we had a debit account set on
voucher type, this debit account was not suggested on the final booking line. If the voucher type was
introduced manually, the debit account was filled in. This is now fixed. If no GL account supplier is set
in Visma Business , then if we have debit account set on voucher type, debit account is filled in with this
value. If we have GL account supplier set in Visma Business, even if we have debit account on voucher type
in Visma Business, on the final booking line debit account will contain the GL account supplier value.

Visma Global

Improvements when updating VAT code and Tax class in Visma.net Approval
Previously, when a GL account had the Tax class and VAT code set in Global, if the invoice was sent on
flow to Visma.net Approval without having the GL account set and this GL account was set in Visma.net
Approval, when the document was sent back to Visma Document Center, VAT code and Tax class were not
updated in Visma Document Center.

This is now fixed. When the document is sent back to VDC from Visma.net Approval, the VAT code and
Tax class will be set in Visma Document Center.

Exception handled when update voucher date or validation date
Previously, when manually changing the period after the voucher date was changed the system returned
an exception.  This has been fixed allowing the user to manually change the period.  It will not change
automatically when the voucher date is changed.

Improved CID interpretation
CID with more than 7 digits were not interpreted by VDC. Previously, there was a check to ignore all CID
candidates with less than 7 digits. Now this was fixed and the value is interpreted.

Visma Contracting

Correct voucher type for incoming invoices
When Visma Document Center running with Visma Contracting the voucher type on the accounting grid
was set as incoming credit note, instead of incoming invoice. This is now fixed: for incoming invoice the
voucher type is set to incoming invoice as well.

Switch accounts for Autofakt credit notes
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When interpretation detects the imported invoice as credit note, the credit and debit accounts should be
switched and voucher type and document type changed to credit note. This was not working correctly for
Autofakt invoices. Now we have corrected it and we have the correct behavior for autofakt import as well.

Improved lookup search for supplier
Look up on supplier field have been improved so that when the user search for a string of characters those
will be searched in the whole supplier name instead of searching only the suppliers that start with that
string.

Duplicate invoice number warning
The duplicate invoice number warning in the Interpret Result Form was missing from previous versions of
Document Center. This is now fixed and the user will get a red exclamation mark as warning in the Interpret
Result Form if the interpreted invoice number already exists in Visma Contracting.

Visma Nova

Unique supplier identification
When the bank account and the company number are identified and an exact match is identified in the
supplier list, then this supplier is now saved on the interpreted document.

When there is no exact match, and only one value has been identified, then the first identified supplier is
saved on the document.

Known Issues, Limitations & Restrictions 10.01.0
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

If you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Uninstall of Visma Document Center server fails
When performing an upgrade, both the client and the server are first uninstalled and then reinstalled.
Sometimes the uninstaller for the server fails when trying removing the shared folder that the client uses to
install. This is solved for version 9.00.0. Since it is the uninstall that fails this might happen on all versions
before version 9.00.0.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

Voucher type and organizational number search
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When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exist, then it
will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Visma Contracting

Warehouse responsible
For invoices with warehouse number imported from Autofakt, the warehouse responsible will not be
suggested in the Visma Document Center Workflow dialog. Workflow recipient has to be added manually.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents cause an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.5
The platform has been updated to use Microsoft .NET Framework 4.5.2. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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37
Visma Document Center 10.00.0

Topics:

• New features 10.00.0
• Improvements 10.00.0
• Known Issues, Limitations

& Restrictions 10.00.0

In version 10.00.0 of Visma Document Center we have implemented some
new features that are designed to reduce the time to process incoming
documents. This version will be part of the Visma Business product line
installer.
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New features 10.00.0
This version includes some new features to reduce the time spent by users on some repetitive steps like
placing the invoice supplier, setting the approval hierachy, sending the invoice on flow. Now, the invoice
will be placed automatically on the flow when the approver can be identified and this will increase the
accountant's efficiency and make Visma Document Center a more attractive product.

Common Visma Document Center

Autoflow -the new automated workflow
Autoflow in two words is a new and automated workflow functionality introduced in Visma Document
Center 10.00.

This new functionality have better approach of approval hierarchy and will support simple and multiple
level organizations as well, having one, unique superior added to the flow. The workflow is created
automatically based on user configured rules. The rules used for creating the flow could be associated
to Supplier or Cost Unit. When interpretation find the supplier or cost unit will automatically apply the
autoflow rule. The rule associated to a supplier has the highest priority. If there are no rules associated to the
supplier found on the document, autoflow will check if there is any autoflow rule associated to the Cost unit
found on the first accounting line.

Autoflow will not use the superiors and approval limits defined in the ERP system. Instead of superiors will
add only one superior set on autoflow. The superior set on the autoflow rule is named Last Approver. Last
Approver is the last person added to the flow and his approval task is activated when all the other approvers
already approved the document.

Autoflow rules can be added from the System > Autoflow configurator menu.

In the System > Autoflow configurator, the Adminsitrator or Accountant user can enable the Autoflow
functionality. Enabling Autoflow is only possible when the Responsible User is added. The Responsible
User name will also be displayed as a sender of the documentation. This that will also receive the document
after reject.

The autoflow rule contain the following details:

• Autoflow trigger value type
• Autoflow trigger value
• Recipients and recipients order
• Approval limit
• Last approver

When Automatic interpretation finds a trigger value on the document will apply an autoflow rule and will
send the document automatically on flow.

Autoflow Configurator form also have the option to define a rule as Default rule. The Default rule will be
applied to each valid document that have no autoflow rule detected based on interpreted trigger values.

In order to have the correct data on the document before sending on flow, invoices are validated before
sending them on flow based on a set of predefined validation rules. This can not be changed by the
user.Validation of the invoice is done based on the following:

• Bank account is the same as in ERP
• Invoice no does not exist in ERP
• VAT amount not higher than Amount
• Due date is not earlier than invoice date
• One supplier identified on bank account and company no

Invalid invoice will arrive in the "New documents" list and user can read on a note about what validation
rules failed. The user can see what correction need to do and after that the invoice can be replaced on flow .
The document can be sent on autoflow again by the menu point Processing>Send on Autoflow or by right
click menu Send document on Autoflow.
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Workflow tasks Review/Forward/ Stand-in should work the same way as before. If there is one autoflow
recipient who want to send the document to Review/Forward that is still possible when the document is in
the For Approval list.

When a document is Rejected  that document will arrive in the For Approval list of the Responsible
User. The responsible User must call back a rejected document, make the corrections and than send it on
Autoflow again by using the menu point Processing>Send on Autoflow or by right click menu Send
document on Autoflow.

Stand in users have to be defined in the ERP system as before and autoflow will take that in account.

Improvements 10.00.0

General

OPG and OD Bridge can now be installed on different machines

Whe have improved the way the ODBridge is reading the OnPremissesGateway address and now the two
applications can run on different machines.

Display of VismaXML with external stylesheet

Visma XML invoices were not displayed correctly in Approval Center and after extracted with External
Archive. This is now fixed and the Visma XML invoices are displayed correct in all situations.

OCR interpretation on cost units

When a tiff file was imported using Autoimport, cost unit on the first line was not interpreted by OCR
Interpretation. Now this is fixed and the cost unit is interpreted when using Autoimport.

Note:  It is important that Interpretation for Autoimport is enabled and the correct language
is selected.

Improved supplier identification

When running interpretation and having suppliers with identical bank account but different organization
number, when there is an exact match on bank accoutn and organization number we save that supplier on
the document. If there is no exact match found for both, bank account and organization number, than the
list of partial mathces is displayed in Interpret Result Form and the first supplier in the list is saved on the
document.

Improved bank accounts interpretation

When running interpretation on XML invoices containing multiple bank accounts, only the first bank
account found was considered. This is now improved and all the bank accounts available on the invoice are
taken into consideration. If any of the available bank accounts matches the value recorded in the ERP for
supplier bank account, then it will be saved on the document.

Fixed F6 and Shift-F6 functionality

When the document viewer is unpined, by pressing the F6 key the focus did not change from the document
viewer. This is now fixed and F6 and SHIFT-F6 keys work correct.

Note:  Using F6 key the navigation switches focus in the following order: the four different
lists, the document list, the picture viewer, comments and the accounting line. SHIFT + F6
navigate in the opposite direction.

Improved hand written text after import

The scan contrast has been incereased and now the notes written by hand on an invoice before scanning are
now more readable.

Visma Global

Voucher number
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When having a voucher with two accounting lines registered on different dates, after transferring to Visma
Global, each line had a different voucher number. This is now fixed and the two accounting lines have now
the same voucher number after transfer.

Star and distribution formula

Visma Global support Entry rules in distribution formulas. This rules can consist in special characters like *
(asterix/star) or + (plus). When * is used in the distribution formula in Globlal by this indicates that the user
can enter a value manually in that field. The automatic entrystop on the line where it finds a star and value
must be entered manually. Visma Docuemtn Center had an issue regarding * in distrubution formula from
Global, this is now solved and the functionality works in Document Center in the same way as in Global.
teh automatic entry stop, the focus is set to the accounting grid cell where the user have to manually enter
the value.

Visma Nova

Site ID and autoinvoice settings in ASP environment

In an ASP environment using AutoInvoice, a user was able to see all companies from all sites while he was
configuring the AutoInvoice company mappings.

This situation is now fixed. The user configuring the AutoInvoice mappings is able to see only the
companies from the site that he has access to.

Known Issues, Limitations & Restrictions 10.00.0
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

In case you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Uninstall of Visma Document Center server fails
When performing an upgrade, both the client and the server are first uninstalled and then reinstalled.
Sometimes the uninstaller for the server fails when trying removing the shared folder that the client uses to
install. This is solved for version 9.00.0. Since it is the uninstall that fails this might happen on all versions
before version 9.00.0.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

Update system user password
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When Visma Business integration with Visma User Directory is active, you might have to change the system
user password. As a result, your access to Visma Document Center might be blocked and you will need
to change the system user password in Visma Document Center too. Because in this situation you cannot
access the System settings > Sytem configuration menu item this change will have to be done by the
system administrator in the server console using the following syntax:

updatesystempassword <oldpassword> <newpassword>

Note:  No new password validation is done in this case. If accidentally you have entered a
wrong password, then you will have to run this command again and use the latest password
set as <oldpassword>

Note:  To preserve the changes, a server restart is necessary.

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exist, then it
will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Visma Contracting

Credit note issues on invoices imported from Autofakt
Accounts are not correctly suggested on accounting line when importing Credit Notes from Autofakt.

Warehouse responsible
For invoices with warehouse number imported from Autofakt, the warehouse responsible will not be
suggested in the Visma Document Center Workflow dialog. Workflow recipient has to be added manually.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0 or newer.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents cause an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.5
The platform has been updated to use Microsoft .NET Framework 4.5.2. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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Topics:

• New features 9.02.0
• Improvements 9.02.0
• Known Issues, Limitations

& Restrictions 9.02.0

In version 9.02.0 of Visma Document Center we have implemented some
new features to improve time when switching between documents and to
reduce time for transferring master data to Visma.net Approval. In this
version we have also implemented a number of important bug fixes.
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New features 9.02.0
This version includes some new features to improve time when switching between documents and to reduce
time for transferring master data to Visma.net Approval. In this version we have also implemented a number
of important bug fixes.

Common Visma Document Center

Enable / disable thumbnails in Document Viewer
Some users were experiencing performance delays switching between documents in the document list. This
occurred when the system rendered a large number of thumbnails containing document images. To alleviate
this problem a button has been added to toggle between thumbnails which display images of the document
pages and thumbnails showing the page number of the document. Selecting the option to display only the
page number on the thumbnail will greatly reduce the time taken to switch between documents. The default
view will display the page number.

Transfer only changed master data to MDM

In this version of Visma Document Center we only transfer changed and new master data entities to Visma
Approval. This will reduce the data load on the On Demand components.

Synchronzation of MDM data is configurable, but by default the following settings apply: (An enabled
MDM Sync will only send changes)

• Visma Business - MDM Sync enabled.
• Visma Global - MDM Sync enabled.
• Visma Nova - MDM Sync enabled.
• Visma AccountView - MDM Sync disabled. Visma Document Center does not send master data to

Visma Account View.
• Visma Contracting - MDM Sync disabled. Visma Document Center does not send master data to Visma

Contracting.

All logs from MDM Sync are saved together with the OD-Bridge log files in the following location C:
\ProgramData\Visma\Visma.Workflow.ODBridge.

Improvements 9.02.0

General

Supplier specific keywords for Autointerpretation

Autointerpretation is now running the supplier specific keywords in the same way as manual interpretation.

For detecting the supplier the keywords are used with the following priority:

1. User defined keywords
2. System defined keywords.

When the supplier is found for than the priority of the keywords for interpreting all the other target values is
the following:

1. Supplier specific keywords.
2. User defined keywords
3. System defined keywords.

Update supplier for more than one document

In older versions of Visma Document Center it was not possible to perform update supplier on more than
one document. We have fixed this issue and now multiple documents can be selected in the Interpret Result
Form. This form allows to do update of supplier for each document when switching between the documents
without closing the Interpret Result Form.
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Filtering for documents without no cost units has now better support.

Example:

1. Create a filter Project=0
2. Apply filter

Result: Documents without project will be found.

This improvemnt is meant to support the case when the customer want to retrieve all documents which have
not fille din cost units.

Number of decimals not interpreted correctly

The regional setting "Number of digits after decimal" was not taken into account when interpreting numbers
without decimals. This is now corrected and when we interpret a number without decimals we are adding 0
as decimal instead truncating the number.

Rotate document in Document Viewer

In some cases the action "Rotate document" was giving an error message not understandable for the user.
This is now fixed and Rotate document works properly.

Adding superior when forward document

When forwarding a document to a user with superior superior was not added to the flow. This is now fixed
and superiors are added to the flow after forward.

External Archive and number of digits for Supplier/Customer and General Ledger

The External Archive will support Supplier, Customer and General Ledger values without restrictions to the
number of digits.

Visma Business product line

Improved displayed information in the lookup form

When searching some information, the name of the field searched was not displayed on the lookup form
(e.g.. when searching for 'Debit account type' only the ID was displayed in the lookup form). Now this has
been fixed and the ID and searched field name is displayed.

Improved translation in the capital asset proc look up

The lookup elements of capital asset proc were missing the translation. This is now fixed and the searched
information is translated to the Visma Document Center client language.

Please note that because the information is cached, changing the Document Center client language and
pressing F12 within the next 30 seconds, the information might not be updated yet.

Fixed adding superiors

Previously, if Auth. responsible and Attestation amount limit were set to Visma Business and Add
Superior on Amount Limit was not turned on in Visma Document Center, then the superior was always
added when forwarding a document. Now this issue is solved. The superior is added only when Add
superior is turned on Visma Document Center.

Support for negative amounts in Free1 to Free4

In Visma Document Centernegative amounts were not supported in the accounting grid fields Free1 to
Free4. Since this behavior is supported byVisma Business, we have aligned the behavior and now is
possible to input negative amounts in these fields.

Set voucher date in the accounting grid

Setting a voucher date in the Edit Document Properties or in the Interpretation result form, that exceeds
the value set in Visma Business in the No. of days +/- warning/rejection  field, was set as voucher date in
the accounting grid . This behavior was not consistent when setting the voucher date in the accounting grid.
This is now fixed and now it is same behavior when trying to set the voucher date in the Edit Document
Properties or in the Interpretation result form.
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Fields on purchase orders are not updated if multiple invoices are connected to one purchase order

The problem occurs when two or more invoices has a reference to one purchase order in Visma Business.
This resulting in the last invoice received not updating all fields on the purchase order, and VismaID history
not been saved correctly. This is now solved.

Visma Global

Look up on Vat Chain Number

The look up for Vat Chain Number shows incorrect columns in Document Center Accounting grid. An
error message occur when the user selected one of the look up form entries. This is now fixed the Vat Chain
number is selectable and the look up for VatChainNumber shows the correct columns:

• Voucher Number
• Voucher Date
• GLAccount
• Amount
• VATcode

VAT code reset

The VAT code set on a general ledger account used to be reset when a general ledger account with VAT
code 0 was used in the credit account field. This is now fixed and the VAT code is no longer reset when a
general ledger account is used in the credit account field.

AccountView

Interpretation of international bank account

Bank account that starts with 2 letter country code is now recognized for the dutch and for international
OCR.

Missing warning when supplier on document and supplier on order do not match

When a purchase order line was entered in an accounting line via ‘Purchase orderno’, and the supplier in the
invoice header was changed afterwards, the document could be transferred, but an incorrect booking was
created in the ERP and the warning message did not appear anymore. This is now fixed. A warning message
will appear when the supplier on the document and the supplier on the order do not match.

Visma Nova

Document Viewer not working in Nova integration multitenant environment "ASP"
Viewing documents transfered from Visma Document Center to Visma Nova was not possible in a
multitenant environment "ASP". This is now fixed and the users can view documents using the document
viewer.

Known Issues, Limitations & Restrictions 9.02.0
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Some chapters in the user documentation are not translated into local language

The newly updated or added chapters in the user documentation has not been translated at the time of
release. Please check the online server, since that documentation is being updated independently of the
release.

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"
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In case you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Uninstall of Visma Document Center server fails
When performing an upgrade, both the client and the server are first uninstalled and then reinstalled.
Sometimes the uninstaller for the server fails when trying removing the shared folder that the client uses to
install. This is solved for version 9.00.0. Since it is the uninstall that fails this might happen on all versions
before version 9.00.0.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exist, then it
will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Visma Global Distribution keys does not support * (Asterisk)

At the moment it is not possible for VDC to follow the behavior in Visma Global when it comes to having
* in a distribution formulas. In Visma Global the creation of the lines stop when finding a *, but at the
moment this feature does not work in Visma Document Center. The workaround is to either not use *, but
a dummy account that can be changed to a commonly used account, or to have two sets of the distribution
formulas; one for Visma Global, and one for Visma Document Center. There is unfortunately not possible to
get a better error message for this issue.

Visma Contracting

Credit note issues on invoices imported from Autofakt invoices
Accounts are not correctly suggested on accounting line when importing Credit Notes from Autofakt.
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Warehouse responsible
For invoices with warehouse number imported from Autofakt, the warehouse responsible will not be
suggested in the Visma Document Center Workflow dialog. Workflow recipient has to be added manually.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents cause an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.5
The platform has been updated to use Microsoft .NET Framework 4.5.2. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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In version 9.01.0 of Visma Document Center we have implemented some
new features that is designed to reduce the time to process incoming
documents. This version will be part of the Visma Business product line
installer and will also provide the possibility to select a demo license for
the users. In Visma Nova we now provide support for project-phase.
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New features 9.01.0
This version includes some new features that is designed to reduce the time to process incoming documents.
For all integrations we now allow for extracting data to an external media. This version will be part of the
Visma Business product line installer, but also release as a stand-alone installer for other integrations. In
Visma Nova we now provide support for "Construction site".

Common Visma Document Center

Export and view data from utilizing the "External Archive" function

The need from the marked for a function for facilitating external auditing, and archiving of accounting data
has increased. The External archive spreadsheet supplied with Visma Document Center was not able to
handle the load, and amount of accounting data from larger installation.

To be able to content external auditing, and archiving of accounting data for larger installation, the function
"External Archive" was created within the Visma Document Center application. The new "External
Archive" function exports all accounting data, and documents given a set of parameters, and saves them to
a HTML file on a given file path.

For the following parameters there is a From and To value that can be set to influence the content of the
archive created:

• Year
• Period
• General Ledger
• Supplier
• Customer

The "External Archive" function can be found under the menu item Tools and  within the Visma
Document Center client.

Note:  The function "External Archive" only works when Visma Document Center is
integrated with Visma Global and Visma Business.

_____________________________________________________________________________________________

The number of invoices in the New Documents list is now shown in the Select ERP window when
login on

In larger installations and accounting offices one person often has the responsibility for many companies.
If the accountant has a way of knowing what companies has documents that needs to be handled would
increase the efficiency of the person.

To facilitate this it is now possible to see how many documents are in the "New documents" list in the
"Select ERP client" window under the column "New documents". The user can also opt to only see the
companies that has documents in the "New documents" list by checking the "Show companies with new
documents" option.

The column "New documents", and the option "Show companies with new documents" are available
when logging on, and when selecting File and "Select ERP client" from the menu in the Visma Document
Center client.

_____________________________________________________________________________________________

Ability to transfer documents to ERP while still on flow is configurable

Large organisations, and countries outside the Nordics can be required to follow more strict rules when it
comes to audit trail on invoice approval. Due to this there is a need to place restrictions on when a document
and accounting data can be sent to the ERP system.

With the option turned on a user will not be able to be transfer accounting data to the ERP system without it
being approved first. This feature is configurable, and by default disabled.
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The option is available when selecting "Tools", "System settings" and selecting the "Workflow" tab in
the Visma Document Center client.

_____________________________________________________________________________________________

Performance monitoring in the client

In support situations, and during setup of installation there is often a need to measure performance directly
in the customer environment.

The "Performance Monitor" is a function in the Visma Document Center client that always measure the
performance of the system, and saved the result to memory. The following areas are measured:

• Select Document
• Interpret document
• Search
• Set value on accounting row
• Search on Accounting Row
• Transfer batch of document

It is also possible to save the recorded response times to a comma separated CSV file.

The "Performance Monitor" window is available in the Visma Document Center client when selecting
"Tools" and "Performance Monitor".

Visma Nova

Support "Construction site" from electronic invoices for Finnish market

New Finnish regulations require that buyers, and contractors must report invoiced Euros per construction
site.

Visma Document Center now supports the capture, and transfer to Visma Nova of these new "Construction
site" from the invoice. To facilitate this new feature a new field in the "Accounting" section, and
dictionary keyword has been added.

There are four places on the invoice where the "Construction site" can be found:

• Order head
• Order lines
• Buyers reference
• Delivery code

Improvements 9.01.0

General

Autoinvoice user and password validation
When a user types in a user name and a password in the Autoinvoice setting form it is validated. In case
of incorrect credentials, a message is returned to the user.

Error in client when drag'n drop from Gmail
Document Center now shows error message informing the user that dragging a document from Internet
explorer is not supported and the document needs to be downloaded before imported.

Automatic interpretation and bank account number
Invoices imported from Visma AutoInvoice with automatic interpretation would sometimes result in the
Bank account number in the interpreted result being copied from the ERP system instead of been fetched
from XML. This has been corrected.

Automatic interpretation and dates
Invoices imported from Visma AutoInvoice with automatic interpretation would sometimes result in the
invoice date and due date shown in the incorrect regional format. This has been corrected.
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Credit account not copied
The issue where the credit account would not get copied when copying rows has been corrected.

Duedate +30 days
When interpreting an invoice with a due date equal to the interpreted invoice date, the value is ignored and
the default due date is set. Now this has been fixed and the interpreted due date is set.

Lineimport does not fetch department
When keywords for interpreting the cost units on the invoice lines are configure the cost units are now
fetched on the created accounting lines.

Update amount when interpreting currency and currency amount
When performing interpretation on an e-invoice with lines, all the lines in the xml invoice are added to the
accounting grid, and the amount is be calculated based on Line currency no and Line currency amount.

Support for Visma XML credit notes
Visma XML Credit notes are now set as "Type" credit note during interpretation.

Client side line interpretation does not create lines with currency amount
When performing interpretation on an e-invoice, for every line in the XML invoice, a line shall be created in
the accounting grid.

Visma XML invoice not displayed correctly in the ERP viewer
Visma XML is not displayed correctly in the document viewer in Visma Global and Visma Business. This
has now been corrected.

Bridge configuration file shall not be reset on upgrade
The OD Bridge configuration file is no longer overwritten when upgrading the OD bridge. This resolves the
issue where configuration values were reset upon upgrade.

Move documents confirmation dialog need to show number of documents
The Move document confirmation dialog now shows the number of document moved.

Line interpretation not active for automatic interpretation
There was an issue where not all lines from an XML invoice coming through the Autoimport folder were
interpreted. This has now been corrected.

Missing target value for LineVouchertype
There is a a new target value for the lineimport functionlity that interprets the voucher type on accounting
lines. The new target value is named: LineVoucherType.

Include XML stylesheets in Document Center API response
When downloading files for a document through the Document Center API, XML stylesheets (default or
custom) are also included along with the images and XML files.

Add scanned pages
There was an issue when trying to add more than one scanned pages in the ERP. This is now fixed and you
may add to the document as many pages are necessary.

Performance improvements in version 9.01
Performance for large installations is one of the main areas of improvements for this release. Improved
areas include:

• Move between documents in the Visma Document Center client
• Transfer document to ERP system
• Send document on flow
• Typing a Debit account in the Accounting grid
• Typing a Credit account in the Accounting grid

Automatic interpretation and order number
On automatic interpretation we were missing the validation of the order no with the orders existing int he
ERP.  We have aligned this with the manual interpretation and now interpreted order number is validated
based on existing order numbers.

Nova order match and order in currency
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In case of foreign currency invoices and suppliers amounts in the Visma Document Center Order Match
form was incorrect.  We have corrected this now and amounts are transferred correctly in foreign currency.

Negative Amount XML credit invoices not recognized
Negative amount xml invoices are now recognized as credit notes.  When interpretation detect the invoice
as credit note the accounts will be switched and document type will change to credit note. 

Note:  This not apply for negative amount tiff/pdf invoices, those will be handled based on
interpreting the credit word.

OIOUBL credit note not recognized
We have added support for OIOUBL credit notes. OIOUBL credit notes are now recognized by
interpretation based on Invoice Type Code keyword. This keyword is also added as system defined
keyword. The value that defines the credit note is: PCM.

Visma Business product line

Cost account is not fetched from Business in lineimport
There was an issue where only the first line received the cost account when fetched from the supplier
information. This occured when line import was used. Now all lines will receive the cost account.

VAT amount not deleted
There was an issue where deleting an invoice amount would also delete the amount excluding VAT but not
the VAT amount. This has now been corrected. Now the VAT amount is also deleted.

Amount excl.Vat cannot be deleted
When entering a value in the Amount excl.Vat field in the accounting header the VAT Amount and the
Amount are updated. When deleting the VAT amount the Amount excl.Vat is updated. However if the
Amount excl.Vat is deleted then the Amount excl.Vat and VAT amount are restored. This has now been
fixed.

Credit month due date calculation
The handling of the payment terms during interpretation has been updated, so the due date of the invoice
will be calculated considering also the number of free payment months until the due date. This means that
one free payment month is calculated as credit for the invoice month. One free payment month and 14 days
means credit until the 15th day of the month after the one the invoice was issued.

Wrong cost unit selected based on supplier
When two suppliers, having the same bank account, were identified during the interpretation, the cost unit
from the first selected supplier was set on the accounting row. Now this is fixed and the cost unit is set from
the supplier selected in the Interpretation results screen.

Changing exchange rate when using preregistration integration VB
In general currency exchange rate is fetched based on valuation date on the reverse line of preregistration. 
When on the reverse line the exchange rate is different than on the preregistration line we will use the same
rate as on the preregistration line.

AccountView

Net amount lines and header
The user will receive a warning when the net amount from the accounting lines and on the header are not
equal. Also the net amount on the accounting line is only updated if the total amount or vat amount is
changed in the header.

Default entry order-line number
When the user enters the order line number before the description, Net amount and Project code fields are
automatically defaulted.

AV: Net Amount update when VAT Amount or Amount change
Net Amount in the accounting grid is calculated as difference between Total Amount and VAT Amount
in the Document list.  When there i s only one accounting line in the accounting grid VDC will always
update the Net Amount. When the accounting is split on multiple accounting lines NET Amount will not be
updated.
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Visma Nova

Automatic interpretation and lineimport in Nova integration
Invoices imported from Visma.net AutoInvoice with automatic interpretation would sometimes result in
extra lines being created, and missing cost accounts. This has been corrected.

Automatic interpretation of XML credit invoice in Nova integration
When the total amount is negative in an XML invoice the invoice is considered to be a credit invoice.
Automatic interpretation did not handle the XML credit invoice in Nova integration correctly. This has now
been fixed.

Use only keyboard in Nova Order Match is not consistant
The moving from field to field using keyboard TAB-key in order match form has been improved.

Accounting row read only fields in Nova integration

When running against Visma Nova, you could edit the fields VAT Amount, Amount excl.VAT, and
Amount incl.VAT. Because these fields are not updated in the Visma Nova, we have made them read only.

Visma Global

Missing Swedish field for bankgiro in Global
Update bank giro field fixed with Swedish Visma Global. When updating the Swedish field Bankgiro in the
"Interpretation Results" window, the bank account field used to be updated in the Swedish Visma Global
instead of the bankgiro. We have now fixed this inconvenience and we have added a new field to the to the
"Update value into" field drop down list in the Interpret Result Form.

Free month delivery due date calculation
The handling of the payment terms during interpretation has been updated, so the due date of the invoice
will be calculated considering also the free month delivery option. This means that free month delivery
payment is calculated as credit for the invoice month.

Reject with preregistration and Swedish Global
Call back was not working properly on documents using preregistration on the Swedish Global integration. 
This issue is fixed now and call back possible for preregistration documents.

Cost account form the supplier not fetched for preregistration
When using preregistration in the Visma Global integration cost account set on supplier was not fetched
for final registration lines.  This is now fixed and when preregistration lines are expanded cost account is
fetched on the first final booking line from the supplier settings.

Visma.net Approval

Approval comments does not show the correct time
Workflow comments arriving from Visma.net Approval now show the correct time in Visma Document
Center.

Approval workflow data shown multiple times in the Document comments in VDC
Document comments on workflows sent to Visma Approval are not shown multiple times.

Phase column wrong place in Approval
The phase column has been moved to the right of the project column. This is the logical placement since the
project is selected prior to the phase.

OD bridge should not be blocked by large documents
There was an issue where documents would get blocked going to Visma Approval. This would occur when
sending large documents. This has been corrected.

Only first page of tiff document from VA are sent to VDC
When using the upload client in Visma Approval, sending a tiff to VDC only sends the first page of the tiff.
This has now been fixed.

Visma.net AutoInvoice documents with format Visma XML does not save xls in document folder.
The issue with the Visma XML files that where not displayed correctly when transferred to Approval has
been corrected.
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Known Issues, Limitations & Restrictions 9.01.0
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Some chapters in the user documentation are not translated into local language

The newly updated or added chapters in the user documentation has not been translated at the time of
release. Please check the online server, since that documentation is being updated independently of the
release.

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in "Visma.net Approval Integration
Status" window saying: "Company_NOT_Found_Below_Customer"

In case you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Uninstall of Visma Document Center server fails
When performing an upgrade, both the client and the server are first uninstalled and then reinstalled.
Sometimes the uninstaller for the server fails when trying removing the shared folder that the client uses to
install. This is solved for version 9.00.0. Since it is the uninstall that fails this might happen on all versions
before version 9.00.0.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Business product line

Voucher type and organizational number search

When a lookup for a voucher type or an organizational unit is done using a numerical value, only the exact
match will be suggested as a result.

For example, if you type 42 in the voucher type cell in the accounting line and voucher type 42 exist, then it
will be set. If voucher type 42 does not exist, and voucher type 420 is available, then this value will not be
set.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Visma Global 64bit version compatibility issues
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In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Visma Global Distribution keys does not support * (Asterisk)

At the moment it is not possible for VDC to follow the behavior in Visma Global when it comes to having
* in a distribution formulas. In Visma Global the creation of the lines stop when finding a *, but at the
moment this feature does not work in Visma Document Center. The workaround is to either not use *, but
a dummy account that can be changed to a commonly used account, or to have two sets of the distribution
formulas; one for Visma Global, and one for Visma Document Center. There is unfortunately not possible to
get a better error message for this issue.

Visma Contracting

Credit note issues on invoices imported from Autofakt invoices
Accounts are not correctly suggested on accounting line when importing Credit Notes from Autofakt.

Warehouse responsible
For invoices with warehouse number imported from Autofakt, the warehouse responsible will not be
suggested in the Visma Document Center Workflow dialog. Workflow recipient has to be added manually.

AccountView

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents cause an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.5
The platform has been updated to use Microsoft .NET Framework 4.5.2. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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In version 9.00.0 of Visma Document Center we have implemented some
new features that is designed to reduce the time to process incoming
documents. This version will be part of the Visma Business product line
installer and will also provide the possibility to select a demo license for
the users. In Visma Nova we now provide support for project-phase.
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New features 9.00.0

Common

Move documents from one client to another

The user will be able to move one or several documents from one company to another. This will apply to
documents in graphic formats and electronic file formats. The documents will be moved if you are granted
access to the destination company.

Automatic OCR and interpretation on the server side
New documents from Visma AutoInvoice and "Autoimport" will now be interpreted on server and be
ready for processing in Visma Document Center clients automatically.

Support for invoices uploaded to Visma.net Approval
Visma Document Center now supports importing new documents from Visma.net Approval.

Demo license
When using the Visma Business product line installer or the Visma Document Center installer, it is now
possible to select a demo license. The demo license is valid for 30 days.

Visma Business product line

Visma Document Center are part of the Visma Business product line installer
Visma Document Center can now be installed using the Visma Business product line installer. When
integrating with other ERPs than Visma Business, the Visma Document Center installer must be used.

Password encryption
Visma Business no longer allows the use of a blank password for the System user and this mandatory
password is now encrypted. Changes made to the system user password in Visma Document Center through
"Tools" - "System settings"- "System" tab, support this encryption.

Visma Nova

Added support for Nova project-phase
A new accounting dimension for "Project Phase" is available for Visma Nova users, in addition to the cost
center and project dimensions. The "Project Phase" will be available in the accounting grid and the order
match form. The "Project Phase" is a more detailed dimension for project dimension.

Visma.net Approval

Added support for download of pdf documents from Visma.net Approval
Visma.net Approval users can now upload PDF attachments, in addition to PNG attachments, to workflows
that are then downloaded to VDC.

ISO currency code sent to Visma.net Approval
All workflows that are sent to Visma.net Approval now include the ISO currency code on the amount.

Foreign currency value is sent to Approval
All workflows that are sent to Visma.net Approval now send both local currency and foreign currency so
Visma.net Approval can display the value wanted.

Improvements 9.00.0

General

Visma Document Center installer does no longer support older versions of Visma Business.
When installing Visma Document Center with stand-alone installer, the option to select Visma Business will
only be compatible with Visma Business 9.00.0.
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Select number of pages when scanning

You may now set the number of pages to be saved per document when scanning series.

Setting of voucher date when scanning

If voucher date option is selected, and a document profile is set, the selected date is now saved for the
scanned document.

Supplier not being updated

Supplier will now be updated when a new document is created.

Update of supplier information when interpreting

Updating some of the alternatives from the "Update value into" list in the "Interpretation results"
window was not working. This has been fixed.

Dependencies in Setup Guide

The application compatibility chapter in the Setup Guide has been updated.

Supplier information not remembered when using template option

In the interpretation results dialog, the filled in supplier field value would be reset to a blank value after
using the template option. This has now been fixed.

Finvoice stylesheet and future versions

Version 9.00.0 supports Finvoce XML version 3.0.

AccountView

Due date calculation order
The handling of the payment terms during interpretation when running against AccountView has been
updated, so the due date of the invoice will be calculated based on these priorities:

1. If the supplier has a payment term in AccountView, then the due date will be filled in based on the
suppliers payment term.

2. If a due date is available on the invoice, then the interpreted due date will be used.
3. A 30 days standard payment term will be used.

Rename of supplier columns in Doc List
When integrated against AccountView the document list we will use the following column names in English
and Dutch: SupplierID=CrediteurID, Supplier=Crediteur, SupplierName=Bedrijfsnaam

Supplier number and name displayed in document list

The supplier number and supplier name are now listed in the Document list. The Id generated by
AccountView for Visma Document Center is now available in the field "Supplier Id". The Id of the
supplier from AccountView is now available in the field "Supplier Id". The Name of the supplier from
AccountView is now available in the field "Supplier name".

Improved supplier and currency search

The "Supplier Id" and "Currency" search in the "Interpretation Results" window has been improved.
You can now search by the "ID" and "Name"field when doing lookup on suppliers and currency.

Rename of search fields in Currency Code look up form
In all look up forms the name of search fields has changed. ID is now Name, and Name is now Description.

Visma Nova

Transfer to ERP Button

When performing Order Match the "Transfer to ERP" button would be disabled after the transfer had been
done. The button will now always be available.

Account field will not disappear when document profile changes
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Fixed an error on accounting line when document profile was changed. It will now remove the account
number when the document profile is changed.

Order number will be shown when invoices are XML-files

Fixed an error on interpretation of XML-files that would result in the message "Document is not an order”.

Line import for account field

Accounting lines created by line import had incorrect account set, because account suggested by Nova was
overwriting the account finded by line import.

This is now improved and account field is set based on the following priority:

1. Line import: If line interpretation find account on invoice line this will be suggested in the "Account"
field.

2. Supplier: If supplier has an account linked in Visma Nova this will be suggested.
3. Accounting rule: Search on the accounting rule for an account.

Unnecessary dash after project number when creating voucher from Order Match

Fixed an issue when only project is entered without a phase number. Removed a dash behind the project
number before transferring to Visma Nova Accounts Payable.

Order matching support for credit notes

Order match with Visma Nova will now work with credit notes and invoices with negative amounts on
rows.

Visma Global

Apportionment on more than one accounting period gives wrong accounting in Visma Global

We had an issue related to apportionment and distribution formulas: splitting the accounting on different
accounting periods was not working correctly. This has been fixed.

Copying of accounting lines

There was an issue with the Account name not being copied when you used the "Copy row(s)" button on a
line in the accounting grid. This has now been fixed.

Update bank giro field fixed with Swedish Visma Global

When updating the Swedish field "Bank Giro" in the "Interpretation Results" window, the "Bank
account" field used to be updated in the Swedish Visma Global instead of the "Bank Giro".

Edit\Update accounting lines on vouchers already transferred to Global
When Visma Document Center checks the accounting lines on a voucher that has already been transferred to
Visma Global, it displays all the lines (including the deleted ones). This issue is fixed in the following way:
When the "Show the accounting in the ERP system" option is active, only the updated accounting lines
are displayed in Visma Document Center.

Visma.net Approval

Supplier Name is no longer shown in Creditor column of Accounting Grid

Supplier name is now shown after the supplier number on the Visma.net Approval accounting line.

Foreign and local currency is now sent to Visma.net Approval

To improve the Visma.net Approval task list and flow history, Visma Document Center now sends both the
local currency and the foreign currency on workflows.

OD Bridge should not be blocked by large documents

Large documents sent to Visma.net Approval sometimes fails to be transferred, and block all documents
sent on flow to Visma.net Approval. This is now solved.
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Visma AutoInvoice

Visma AutoInvoice and user and password validation

When user types in a "User name" and "Password" in Visma AutoInvoice setting window this is now
validated. In case of incorrect credentials a message is returned to the user.

Known Issues, Limitations & Restrictions 9.00.0
This list covers some of the known problems with this version, which will be resolved in future releases.

General

Some chapters in user documentation are not translated into local language

The newly updated or added chapters in the user documentation has not been translated at the time of
release. Please check the online server, as that documentation is being updated independently of the release.

Automatic creation of Visma.net Approval company from Visma Document Center
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in "Approval Integration Status" window
saying: "Company_NOT_Found_Below_Customer"

In case you encounter this error please contact your Visma partner.

Activation of a new Approval Company in Visma On Demand
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".

Uninstall of Visma Document Center server fails
When performing an upgrade, both the client and the server are first uninstalled and then reinstalled.
Sometimes the uninstaller for the server fails when trying removing the shared folder that the client uses to
install. This is solved for version 9.00.0. Since it is the uninstall that fails this might happen on all versions
before version 9.00.0.

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Visma Contracting

Credit note issues on invoices imported from Autofakt invoices
Accounts are not correctly suggested on accounting line when importing Credit Notes from Autofakt.

Warehouse responsible
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For invoices with warehouse number imported from Autofakt, the warehouse responsible will not be
suggested in the Visma Document Center Workflow dialog. Workflow recipient has to be added manually.

Booking periods on documents after upgrade of server with AccountView integration

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status "New document for approving" or
"Complete" after an upgrade of Visma Document Center to version 8.00.0.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents cause an error when trying to send document to the ERP.

The workaround for this is to open the "Edit document properties" window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.5
The platform has been updated to use Microsoft .NET Framework 4.5.2. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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In version 8.01.4 of Visma Document Center we have implemented a
important bug fix.
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Improvements 8.01.4

Visma Business

Look up on Cost Units field is done faster, and does not create time out messages.
Lookup on cost units with more than 500 items often ended up with timeout messages. Performance is now
improved, and time out does not occur.

Known Issues, Limitations & Restrictions 8.01.4
This list covers some of the known problems with this version, which will be resolved in future releases. No
changes since 8.01.2.

General

VDC 8.00.2 Logs are created in old catalog

In some install scenarios no 8.00.2 catalog are created. Workflow server logs are created in the 8.00 catalog.
The same error exists on version 8.00.1

Some chapters in user documentation not translated into local language

The newly updated or added chapters in the user documentation has not been translated at the time of
release. Please check the online server, as that documentation is being updated independently of the release.

Automatic creation of Approval Company from VDC
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in ODIntegrationStatus window saying:
"Company_NOT_Found_Below_Customer"

In case you encounter this error make sure you do not try to create a duplicate company.

Activation of a new Approval Company
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".In current version this error code stands for: "Terms of service not agreed" .

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Order match and received goods in Visma Document Center
Not possible to match the correct order numbers when "Receive goods on order match" is activated in
Document
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Visma Contracting

Credit note issues on invoices imported from Autofakt invoices
Accounts are not correctly suggested on accounting line when importing Credit Notes from Autofakt.

Warehouse responsible
For invoices imported from Autofakt with warehouse number on will not have the warehouse responsible
suggested in the Document Center Workflow dialog. Workflow recipient has to be added manually.

Booking periods on documents after upgrade of server with AccountView integration

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status Approving or Complete after an
upgrade of Visma Document Center to version 8.00.0.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents cause an error when trying to send document to the ERP.

The workaround for this is to open the Edit document properties window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.5
The platform has been updated to use Microsoft .NET Framework 4.5.2. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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In version 8.01.3 of Visma Document Center we have implemented a
number of important bug fixes.
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Improvements 8.01.3

Visma Business

Performance improvements
Visma Document Center server should process only the companies where a user was logged in at least once.

Due to an error the server was processing also companies which were not used in Document Center and this
had some impact on performance.

This is now corrected and Document Center Server processing only the companies which are used in
Document Center.

Known Issues, Limitations & Restrictions 8.01.3
This list covers some of the known problems with this version, which will be resolved in future releases. No
changes since 8.01.2.

General

VDC 8.00.2 Logs are created in old catalog

In some install scenarios no 8.00.2 catalog are created. Workflow server logs are created in the 8.00 catalog.
The same error exists on version 8.00.1

Some chapters in user documentation not translated into local language

The newly updated or added chapters in the user documentation has not been translated at the time of
release. Please check the online server, as that documentation is being updated independently of the release.

Automatic creation of Approval Company from VDC
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in ODIntegrationStatus window saying:
"Company_NOT_Found_Below_Customer"

In case you encounter this error make sure you do not try to create a duplicate company.

Activation of a new Approval Company
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".In current version this error code stands for: "Terms of service not agreed" .

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
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or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Order match and received goods in Visma Document Center
Not possible to match the correct order numbers when "Receive goods on order match" is activated in
Document

Visma Contracting

Credit note issues on invoices imported from Autofakt invoices
Accounts are not correctly suggested on accounting line when importing Credit Notes from Autofakt.

Warehouse responsible
For invoices imported from Autofakt with warehouse number on will not have the warehouse responsible
suggested in the Document Center Workflow dialog. Workflow recipient has to be added manually.

Booking periods on documents after upgrade of server with AccountView integration

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status Approving or Complete after an
upgrade of Visma Document Center to version 8.00.0.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents cause an error when trying to send document to the ERP.

The workaround for this is to open the Edit document properties window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.5
The platform has been updated to use Microsoft .NET Framework 4.5.2. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.



Chapter

43
Visma Document Center 8.01.2

Topics:

• Improvements 8.01.2
• Known Issues, Limitations

& Restrictions 8.01.2

In version 8.01.2 of Visma Document Center we have implemented a
number of important bug fixes.
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Improvements 8.01.2

Visma Global

Excess logging
When Visma Document Center was used in connection with Visma Global and RAC, the message "Could
not retrive CompanyName from RAC" was logged too many times causing the log files to get too big and
then affecting the performance. This message is no longer being used in this context.

Known Issues, Limitations & Restrictions 8.01.2
This list covers some of the known problems with this version, which will be resolved in future releases. No
changes since 8.01.1.

General

VDC 8.00.2 Logs are created in old catalog

In some install scenarios no 8.00.2 catalog are created. Workflow server logs are created in the 8.00 catalog.
The same error exists on version 8.00.1

Some chapters in user documentation not translated into local language

The newly updated or added chapters in the user documentation has not been translated at the time of
release. Please check the online server, as that documentation is being updated independently of the release.

Automatic creation of Approval Company from VDC
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in ODIntegrationStatus window saying:
"Company_NOT_Found_Below_Customer"

In case you encounter this error make sure you do not try to create a duplicate company.

Activation of a new Approval Company
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".In current version this error code stands for: "Terms of service not agreed" .

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Order match and received goods in Visma Document Center



Visma Software International AS | Visma Document Center 8.01.2

© Visma Software International AS | 199

Not possible to match the correct order numbers when "Receive goods on order match" is activated in
Document

Visma Contracting

Credit note issues on invoices imported from Autofakt invoices
Accounts are not correctly suggested on accounting line when importing Credit Notes from Autofakt.

Warehouse responsible
For invoices imported from Autofakt with warehouse number on will not have the warehouse responsible
suggested in the Document Center Workflow dialog. Workflow recipient has to be added manually.

Booking periods on documents after upgrade of server with AccountView integration

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status Approving or Complete after an
upgrade of Visma Document Center to version 8.00.0.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents cause an error when trying to send document to the ERP.

The workaround for this is to open the Edit document properties window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.5
The platform has been updated to use Microsoft .NET Framework 4.5.2. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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In version 8.01.1 of Visma Document Center we have implemented a
number of important bug fixes.
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Improvements 8.01.1

Visma Global

VAT calculations and date format
When using Norwegian regional settings and date format DD-MM-YYYY Visma Document Center TAX
rates were incorrectly applied and VAT Amounts incorrectly calculated in accounting grid and also in the
Order Form.

This is now solved so that VAT amount are correctly calculated no matter of the date format.

Known Issues, Limitations & Restrictions 8.01.1
This list covers some of the known problems with this version, which will be resolved in future releases.

General

VDC 8.00.2 Logs are created in old catalog

In some install scenarios no 8.00.2 catalog are created. Workflow server logs are created in the 8.00 catalog.
The same error exists on version 8.00.1

Some chapters in user documentation not translated into local language

The newly updated or added chapters in the user documentation has not been translated at the time of
release. Please check the online server, as that documentation is being updated independently of the release.

Automatic creation of Approval Company from VDC
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in ODIntegrationStatus window saying:
"Company_NOT_Found_Below_Customer"

In case you encounter this error make sure you do not try to create a duplicate company.

Activation of a new Approval Company
There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".In current version this error code stands for: "Terms of service not agreed" .

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Order match and received goods in Visma Document Center
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Not possible to match the correct order numbers when "Receive goods on order match" is activated in
Document

Visma Contracting

Credit note issues on invoices imported from Autofakt invoices
Accounts are not correctly suggested on accounting line when importing Credit Notes from Autofakt.

Warehouse responsible
For invoices imported from Autofakt with warehouse number on will not have the warehouse responsible
suggested in the Document Center Workflow dialog. Workflow recipient has to be added manually.

Booking periods on documents after upgrade of server with AccountView integration

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status Approving or Complete after an
upgrade of Visma Document Center to version 8.00.0.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents cause an error when trying to send document to the ERP.

The workaround for this is to open the Edit document properties window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.5
The platform has been updated to use Microsoft .NET Framework 4.5.2. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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In version 8.01.0 of Visma Document Center we have implemented a
number of important bug fixes.
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New features 8.01.0
This version provides Resource Access Control(RAC) Integration and a selection of new features for the
Visma Contracting integration.

Common Visma Document Center

Visma Nova

Default approver
"Save recipient to supplier" functionality is now available for the Nova integration.

This option can be activated from the Recipient Selection Dialog , by checking the "Save recipient to
supplier" check box.

When this is activated the selected recipient or recipient group will be linked to the supplier that is set on
the document. Next time when the same supplier is used on a document the linked recipient will be the
suggested recipient in Recipient Selection Dialog.

Is not possible to link more than one recipient or recipient group to one supplier. Requires Visma Nova 8.4.

Visma Global

Resource Access Control (RAC) Integration
RAC integration is now supported when using Visma Global.

Visma Contracting

Support for additional voucher types from Visma Contracting
When changing the voucher type on the accounting grid, the GL account is only updated it the new voucher
type has a GL account set.

Support for Autofakt xml invoices from Visma Contracting
Starting with version 8.01 Visma Document Center will support receiving Autofakt invoices from Visma
Contracting.

Autofakt is an electronic invoice from the wholesaler, this means that all items you order with the
wholesaler will be automatically transferred in the Visma Contracting accounting system.

In order to receive the Autofakt invoice in VDC there are some settings needed to be done in Contracting.
To send an Autofakt invoice to VDC the user will have to perform some steps in Contracting:

1. Select Ordre/ Autofakt
2. From the "Grossist" drop-down select the wholesaler you received invoices from
3. Then the invoices of the selected wholesaler will be visible
4. Select the invoice you want to send for approval in VDC and press the "Dann XML" button. This will

create the XML invoice that will be sent to VDC After performing this steps the "Autofakt" invoice
should be visible in Visma Document Center New Documents list.

In Visma Document Center Autofakt invoices are treated slightly different from regular incoming invoices
in Visma Document Center as follows:

1. The Autofakt invoices are automatically received in Visma Document Center, there is no need to import
them via Autoimport or manually. The Autofakt invoices are sent by Contracting to VDC and then
displayed in VDC in e2b XML format.

2. Once that Autofakt invoice is displayed in VDC that will automatically have a default accounting rule
and default document type: "Ingaende faktura" and "Invoice". This default values can be changed if
needed by “Apply Document Profile".

3. There are several fields in VDC first accounting line that are automatically fetched in when the invoice
is received. This fields are: order, warehouse, project, department and Cost Units.
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Excepting the above mentioned "special treatment" the Autofakt invoices are treated as regular invoices in
VDC.

Warehouse is a new column that has been added to the VDC accounting grid in order to give a better
support for Autofakt invoices. Warehouse field is editable on the accounting line and look up can be
performed on it. For Autofakt invoices the accounting line should contain either Warehouse either Order,
but cannot have both.

All fields related to Order or Warehouse like department, project, and cost units should be updated when
warehouse or order field is filled in.

Closed orders can be reopened
There are certain use cases when a closed order needs to be reopened in Contracting so that late arrived
invoices can be registered on that order.

Reopening of the closed order is possible now to do automatically from Document Center. Whenever in
Document Center on the accounting line a closed order is used the user is notified and asked if wants to
reopen the order. Based on the user answer order status will be changed or not in Contracting.

Accrual accounting and Apportionment
When Visma Document Center is integrated with Visma Contracting both Accrual accounting and
Apportionment can now be defined in Visma Document Center.

Approval hierarchy for Contracting users
This functionality addresses the following case: if an approver is only allowed to approve invoices below a
certain amount and he receives an invoice that has an amount higher than his maximum approval amount,
then his superior will automatically be added in the workflow.

Visma Document Center version 8.01 support this functionality when it is integrated with Visma
Contracting

Setting up the functionality needs several steps to be performed inVisma Contracting and then in Visma
Document Center.

Setting up Approval hierarchy in Contracting:

1. Select System/Vedlikehold/Brukere.
2. Select the user you want to have approval limit on amount.
3. In the field "Belopsgrense attestering" enter the amount limit that this approver is allowed to approve.
4. In the filed "Overordnet i dok.senter" enter the user number of the persont hat you want to have as

superior.
5. Save. Using the approval hierarchy functionality in Visma Document Center

By default this functionality is turned off. To turn it on you have to check the “Add recipient on approval
amount” setting in Tools / SystemSettings/Workflow
When we send for approval an invoice with amount exceeding the amount limitation of the original
recipient than his superiors are automatically added to the flow.
If you want to alter the recipient list after the flow has been activated, and you remove the original recipient,
the superiors will not be removed.

The work flow is finished only when all the superiors have performed their approval tasks.

Always superior functionality with Contracting

In some companies the approver's superior should also approve the document regardless of the total amount
of the invoice.
By checking the "Always add superior" setting in Visma Document Center in the Tools / SystemSettings/
Workflow tab, the recipient's superior is always added when sending
a document on flow.
The superior is set up in Contracting as we have described in the Setting up Approval hierarchy in
Contracting section, excepting the approval limit step.
When using "Always add superior" there is no need to set up approval amount limit, whenever a document
is sent on flow and the recipient is listed with a superior in Contracting
this person will also be added to the flow.
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Remove currency fields from Document properties and Accounting
The fields Currency amount and Currency no are now removed from the Edit document, Accounting
grid and Interpretation result windows.

The look up form for the Order No field have displayed many empty columns instead of relevant
information.

For this release we have fixed this and the following information is shown in the order form:

1. ID
2. Workplace
3. Phase
4. KB1 KB2
5. Department
6. Employee in charge
7. Responsible
8. Status

Changed features 8.01.0

Visma Contracting

ERP specific User details updated in VDC
Users in Contracting have 3 identifiers: BrukerNr, BrukerID and Name.

Bruker ID is the username that is used to log in to Visma Document Center and Contracting. Contracting
allows changing of BrukerID and Name. Changes performed in Contracting on BrukerID and Name are
now automatically updated in VDC database.

Note:  Deleting a user in Contracting does not update VDC User tables.

title

text

Common Visma Document Center

Improvements to navigation, search and lookup for Select Processing Profile Dialog.
For the Select Processing Profile we have added the blue search line functionality. The columns ID,
AccountingRuleID and Name can now be searched.

Reduce default fetch-count for all integrations to 500
When performing look-ups in the Accounting Grid the number of rows in the result window is
now reduced from 5000 to 500. The number of rows that is fetched is also configurable in the client
configuration file by adding the key <add key="FetchCount" value="500"/> inside the <appSettings> tag.

Improvements to navigation, search and lookup for the Set Default Import Settings Form.
For the Set Default Import Settings Form we have added search functionality for the input fields and
enabled F12 search too.

You can turn on the setting under Settings, My settings, and check-mark the box next to Set Default
Import Settings Form. The Set Default Import Settings Form can now be navigated by using TAB key
or Shift-TAB key (reverse).

Cancel worklfow on preregistered documents
Call back on documents using preregistration with workflow status completed was not possible before.
This is now fixed call back preregistration documents from flow or with workflow status completed is now
possible and will also trigger creating a reverse line in the ERP in order to cancel the preregistration.

Change company name
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When filtering the companies for show them up in Company list now the identification is done based on the
Company ID, instead of Company Name and ID. This change was needed to avoid missing companies in
case of changed company name.

67550900--> Documents with the "Document" Document profile can not be send on flow
It was not possible in 8.001 and 8.002 to send a document with the "document" document profile on flow
as this would trigger the following error:"Pre-registration. Already Transferred: Doc.id xxxx" This has now
been resolved.

Common Visma AutoInvoice

Improvements to Visma AutoInvoice. Showing the Autoinvoice mappings is slow
We have made some significant improvements on configuring and managing the Visma AutoInvoice
integration. You will no longer find the Visma AutoInvoice menu item under Tools - System settings -
Autoinvoice. Instead, the new dialog is now located under System - Autoinvoice.

The new AutoInvoice configuration dialog gives a better overview of your Autoinvoice accounts and it's
associated Autoinvoice Companies. The amount of time it takes to add a company to your account is no
longer dependant on the number of companies you have. Furthermore, the Visma AutoInvoice account
settings are now stored directly in the database, rather then in a local XML file.

Improvements to Visma AutoInvoice. Migrating Visma AutoInvoice configuration.
For existing Visma AutoInvoice users upgrading to 8.01, a migration of any pre-existing Visma
AutoInvoice details will take place when the VDC server is started. This is a one-time process. Users
are able to connect to the Document Center Server while the migration is running. Please note that the
migration will only be done for Enabled Autoinvoice accounts and Active/Standby companies. This process
could take a while depending on the number of companies that are present.

Common Visma.net Approval

Missing Images in Visma.net Approval
A document which has a missing image can no longer be transferred to Visma.net Approval. When trying to
send it on flow, it will now be transferred to the user's Document inbox instead with the comment: "Upload
to Approval failed with message: Document file not found:"Doc.id.xxx"

Move ODBridge related timestamps from registry to database
The time stamps used by ODBridge in order to keep track of the events processed were previously stored in
Registry. This caused problems mainly when the installation was migrated from one environment to another.
sometimes the (admin-) user forgot to do a back-up and migrated also the related registry info. We now have
moved this info in the VWClient table in VDC system db.

Improvements 8.01.0

General

User Guide updates

For the 8.01 release, we have worked on improving our user documentation.

In the Setup Guide, we have focused on correcting or removing outdated information for most of the
chapters (the Advanced Configuration chapters are an exception).

In the User Guide, we have updated or added on the following chapters:

• Introduction
• Email functionality
• Document interpretation
• Pre-registration
• Nova Order Match
• Visma.net Approval integration status
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Note:  The improvement activity is continuing into the next release

Autoimport for XML files with TIF
We had an issue when importing XML files with reference to tiff: autoimport functionality was importing
both the XML and tiff and was creating 2 separate documents in the VDC document list while should
have been creating only one. We have fixed this issue for version 8.01 and autoimport functionality is now
working correctly for XML with tiff files.

Stylesheet - Added support for Finvoice 2.1 stylesheet
Finvoice 2.1 stylesheet is now supported.

Reporting Documents on Flow and Credit Notes
The Excel report for Documents on Flow per person, was not listing the Credit Notes correctly. Now, Credit
Notes in the report are listed in a red font and are negative

Line and column focus - in connection with pre-registration
When pre-registration is used and the document is in the For Approval tab, the focus is now set on the first
editable accounting line and first editable column.

Interpretation - Update supplier's company number (ERP Org. no.)
The Update supplier's company number functionality is no longer returning an error meesgae when the
supplier already have a company number (ERP Org. no.) in the ERP.

Preregistration - Change of Accounting rule
When changing Accounting rule from preregistration to Normal voucher. The automatically created
accounting line will no longer be marked as a preregistration line.

The Exel report "Report documents on flow per person", now lists Credit Notes correctly, in red and
amounts are listed negative.

Approver can not change order of pages in Document Viewer
An exception used to occur when a user having the approver role inVisma Document Center tried to change
the page order of a document. Now this is fixed and a user having role approver can change the page order
of a document.

Shortcuts using numeric keypad
It was possible to use the only the alphanumeric keyboard for the shortcut keys Ctrl+1, Ctrl+2, Ctrl+3. This
has been improved and also the numeric keypad can be used for applying the shortcut.

Incorrect default size when starting for the first time
The main application form now fits on 1024x768 resolution after install and all window components are
correctly sized.

Field text in settings for preregistration improved
Preregistration tab in system settings has a better field text. It will now display text for Visma Business in
relevant language.

Line copy function will update balance
Copy function for preregistration lines will now update the balance values.

Preregistration will now keep cost lines
The cost lines will be preserved during call back function.

No warning when mismatch in ERP bank Account or Org. Number in Interpretation results
In certain scenarios, the red exclamation mark or warning symbol did not appear when there was a
mismatch between the interpreted data in the invoice for ERP Bank/Post account or ERP Organisation
number/Vat number and the supplier. The data validation only occurred when selecting the Update value
into option. This has now been fixed.

Sending Reminder/Email does not work for XML documents
When trying to send an email or a reminder for an XML document this resulted in an error message: There
was a problem saving the file. Check FILE PERMISSIONS. Exception: VRI:Merging multiple images into
a multipage document failed. This has now been fixed. When sending a reminder, the reminder is generated
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in an email message with doc id. When sending an XML document by email, an email is generated with
document attached.

Default maximum message size quota has been increased
In order to avoid exception that occurred in case of long messages the maximum message size quota for
incoming messages has been increased to 40000000.

Update supplier functionality fixed
The update supplier functionality should update the supplier information interpreted in to the ERP. Supplier
information that is possible to update is selectable in the Interpret Result Form "UpdateValueInto" field drop
down list. Updating some of the options from this drop-down was not working in version 8. We have fixed
this inconvenience and now all the values selectable in the drop-down list are correctly updated in the ERP.

XML with stylesheet and special characters

Ensured the XML files are processed with the correct encoding; Special characters are now correctly
displayed on the XML invoices.

OCR and Interpretation

Danish KID interpretation improved
In version 8.01 we have improved the Danish interpretation by adding country specific validation rules for
KID.

This way when the proper keywords or templates are used Danish KID is correctly interpreted inmost of the
situations.

Interpretation - IBAN in Swedish invoices
IBAN is now supported in interpretation of Swedish invoices.

Interpretation of invoices with QR code
Interpretation of invoices with QR-code, sometimes appeared to "hang". We have added a time-limit on the
search for candidates.

Visma.net Approval

Comment from Visma.net Approval not sent to Visma Document Center.
Comments written in Visma.net Approval before sending document on Request Review are now visible in
Visma Document Center.

Attachments added in Visma.net Approval is added in correct place
Attachments added in Visma.net Approval was added as second page in Visma Document Center instead of
as the last page of the document. This has been corrected.

Error message when sending document to Visma.net Approval with workflow comment larger than
500 characters
Workflow comments larger than 500 characters are now truncated when sent to Visma.net Approval.

Move ODBridge related timestamps from registry to database
OD Bridge time-stamp error caused support cases mainly when was needed to migrate the customer data
from one server to other.

To avoid this situations OD Bridge related timestamps are now safely stored in the System Database, Client
table.

Mising documents in Visma.net Approval
A document where it's image is missing can no longer be transferred to Visma.net Approval. When trying
to send it on flow it will now be transferred to the user's Documents inbox with the comment "Upload to
approval failed with message: Document file not found: "Doc-id.xxx"

Visma Business

Scan and Import File function in Visma Business
When using the Scan function in Visma Business and appending a page to a document by selecting Import
File, the appended document is now in focus.
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Order Match lock in Visma Business is not release when workflow is set to disabled
When performing Order Match with Visma Business the PO in Visma Business is now released when
workflow is disabled. If Document profile in Document Center is set to "Send to Archive" the PO in
Business is also released.

Update Scan status field fixed
Scan status field was not updated correctly in OpenSupplierEntry table in Visma Business. This is now
corrected and Scanstatus is updated in OpenSupplierEntry table based on workflow status of the document.
Scan status will have value 2 for the workflow status: approving (20); in approval center(110), Scanstatus
will have value 4 for the workflow status completed. Please note that scanstatus will never will be updated
in the updated vouchers tables when the batch is already updated. The fix have been added for both VB
versions VB 5.2X and VB 5.3X.

AccountView

Document header fields
Voucher no and Batch no fields in Document header are no longer visible when running against
AccountView.

Error when performing ocr&interpretation
No error occurs anymore when interpreting an invoice having Totaal set as alias for total amount.

Visma Nova

Revoke transfer to batch
Nova does not support Revoke transfer to batchfunctionality. To avoid confusing situations for the users,
the functionality is now deactivated by greying-out the Revoke transfer to batch command for Visma
Nova

Copy line function will work for preregistration
Copy function for preregistration lines now works.

Order match form columns changed
VAT amount and VAT rate are hidden by default setting. The amount column have changed location.

Account number is now validated before transfer to Nova
The user will not be able to register an account which is not valid. Only valid account number will be
transferred to Nova.

Difference Cost center/Project should not show last used values
This change will remove values from Difference cost center and Difference project after an order match
is done. On every new order match, there will be a blank entry in Difference cost center and Difference
project.

Transfer to ERP button after OM

Fixed instance after order match for Nova, where update button was no available (grey). Transfer to ERP
from Documents tab works as it should.

Visma Global

Error message when clearing line approvers
When selecting Clear approvers on a line in Visma Document Center the error message "Both accounts
cannot be zero" does not appear any more.

Add prescanned document to existing vouchers
Add pre-scanned document to existing voucher Add pre-scanned document functionality was disabled by
an error. This is now fixed: Add pre-scanned document functionality is now available again to be used from
Visma Global.

Switching companies with Visma Global Integration
When a Visma Global user started Visma Document Center from within Visma Global, there was a chance
that switching companies in Visma Document Center caused an error with the text: "Unable to change the
company for an ERP session. Current ERP session is {sessionId}". This has now been re-mediated.
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Line approvers not allowed in preregistration line
User will not be allowed to set line approver on the first preregistration line. The line is not for approval.

FreeText field updated in the accounting grid
Text field is now updated when supplier is set in the credit account field in the accounting line.

VAT code reset
The VAT code set on a general ledger account used to be reset when a supplier was set in the same
accounting row. Now this is fixed and the VAT code is not reset when a general ledger account is available
on the accounting row.

Cross reference on credit notes
By setting either the supplier or customer it is now possible to filter the lookup on sales ledger or debtors'
ledgers. To be able to search on all transactions or type in a sales ledger or debtors' ledger an General
Ledger account is needed.

Switch company with Visma Global
When a Global user started from within Visma Global, there was a chance that switching companies in
caused an error with the text: Unable to change the company for an ERP session. Current ERP session is
{sessionId}". This has now been improved..

Preregistration with one line distribution formula
When working with preregistration and distribution formulas there was a use case that was not correctly
supported by : distribution formula with only one line. In such a case was not capable to find the balance
account to fill in on the hidden reverse line and because of this the document was never balanced. This is
now fixed so that now check to see if there is any pre-reg lines beside the accounting header line. If true we
use this lines to determine the waiting account on the reverse line.

Visma Contracting

Lookup on order field show correct list
When the user do a look up on the Order field in the Accounting grid the correct list is shown.

Recharge does not work

Recharge and Recharge Percentage  value is used to calculate the CustomerPrice in Contracting. There
was an error  when transferring this  value to Contracting so CustomerPrice could not be calculated by
Contracting. We have fixed this issue now, and recharge fields are now correctly transferred to Contracting.

Known Issues, Limitations & Restrictions 8.01.0
This list covers some of the known problems with this version, which will be resolved in future releases.

General

VDC 8.00.2 Logs are created in old catalog

In some install scenarios no 8.00.2 catalog are created. Workflow server logs are created in the 8.00 catalog.
The same error exists on version 8.00.1

Some chapters in user documentation not translated into local language

The newly updated or added chapters in the user documentation has not been translated at the time of
release. Please check the online server, as that documentation is being updated independently of the release.

Automatic creation of Approval Company from VDC
When creating a new company you need to make sure that the company name that you try to register
does not already exist in Visma.net under the corresponding Visma.net customer. If the company has been
already registered for your customer you will get an error code in ODIntegrationStatus window saying:
"Company_NOT_Found_Below_Customer"

In case you encounter this error make sure you do not try to create a duplicate company.

Activation of a new Approval Company
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There is a new constraint for Visma.net Approval company creation and activation: "Terms of Service"
needs to be agreed before the new company can be used in Visma.net Approval.

If the Terms of Service is not approved you will get an error code in the logs stating: "unmatching ODP
value".In current version this error code stands for: "Terms of service not agreed" .

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Visma Global

Visma Global 64bit version compatibility issues

In the 64bit edition of Visma Global, Visma Document Center can not be started from within Visma Global.
Opening vouchers directly from within Visma Global does not work. Trying to open the document viewer,
or appending pages to existing vouchers will result in an error message: "No contact with the Visma
Document Center Server".

Order match and received goods in Visma Document Center
Not possible to match the correct order numbers when "Receive goods on order match" is activated in
Document

Visma Contracting

Credit note issues on invoices imported from Autofakt invoices
Accounts are not correctly suggested on accounting line when importing Credit Notes from Autofakt.

Warehouse responsible
For invoices imported from Autofakt with warehouse number on will not have the warehouse responsible
suggested in the Document Center Workflow dialog. Workflow recipient has to be added manually.

Booking periods on documents after upgrade of server with AccountView integration

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status Approving or Complete after an
upgrade of Visma Document Center to version 8.00.0.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents cause an error when trying to send document to the ERP.

The workaround for this is to open the Edit document properties window and set the booking period on
the document.

Technical Framework

Microsoft .NET Framework is upgraded to version 4.5
The platform has been updated to use Microsoft .NET Framework 4.5.2. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.
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Topics:

• New features 8.00.2
• Improvements 8.00.2
• Known Issues, Limitations

& Restrictions 8.00.2

In version 8.00.2 of Visma Document Center we have implemented a
number of important bug fixes.
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New features 8.00.2

Visma AutoInvoice

Support for attachments from Visma AutoInvoice

When there is a need to attach separate files to the invoice (timesheets, product descriptions, other
supporting documentation etc) these attachments can be sent to Visma AutoInvoice. Visma Document
Center is now able to download these attachments together with the invoice. When these attachments are
downloaded in Visma Document Center they will be added as a page to the invoice. Visma Document
Center will download PDF, TIF and JPG file attachment types.

Improvements 8.00.2

Visma AutoInvoice

Visma AutoInvoice Last Fetch Time is updated when an invoice download fails

When Visma Document Center is downloading invoices from Visma.net AutoInvoice and a time out
occurs,Visma Document Center will not update the last fetch time and try to download all new documents
from Visma.net AutoInvoice one more time.

Visma AutoInvoice communication stabilization

Instead of aborting a Visma AutoInvoice importing task when Communication fails, the task will remain
active and attempt to download the next invoice.

Finvoice-VDC-tiff XML format now redirects to Finvoice-VDC.

This XML format has been causing some issues in certain scenarios, and invoices offered in this format will
now in effect be redirected to use Finvoice-VDC instead.

Visma Nova

Decimal problem

We have removed the 6 digit formatting for matched sum and unmatched sum text-boxes.

Order Match form additional lines cost center and project

In the order form there is two more additional dimensions for specifying the accounting to additional cost.
In addition to the Difference account, you are now able to specify Difference cost center and Difference
projects. This will make it possible to account freight, customs or other invoice costs to the invoice on cost
center and project. This is cost which is not specified on the order, but the additional costs will be invoiced
from the supplier. You can in both fields register the value directly or you can look it up with F3 and choose
the value from the list.

Visma Business

Added support for Visma Document Center modules from other ERP license files

There is a possibility that Visma Business have a license activated which contains modules for Visma
Document Center also. This case was not supported by Visma Document Center until now and Visma
Document Center needed a separate license file. This is now fixed and Visma Document Center works
correctly when a Visma Business license file with Visma Document Center modules is used.

Order Match Business does not release Vbus lock when not sent on flow

When performing Order Match with Visma Business the PO in Visma Business is now released when
workflow is disabled inVisma Document Center. If Document profile in Visma Document Center is set to
"Send to Archive" the PO in Visma Business is also released.
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Note:  The PO in Visma Business is only locked and released when Visma Document Center
is integrated with Visma Business version 5.30 or higher.

Known Issues, Limitations & Restrictions 8.00.2

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Booking periods on documents after upgrade of server with AccountView integration

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status Approving or Complete after an
upgrade of Visma Document Center to version 8.00.0.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents cause an error when trying to send document to the ERP.

The workaround for this is to open the Edit document properties window and set the booking period on
the document.

Cross reference with Visma Global

Cross Reference in Visma Global
With the changes for supporting lookup on invoice number without Debit or Credit account set the
functionality for Cross reference is changed.

To be able to register a cross reference in Visma Document Center 8.00.0 one of the following  methods
must be used:

Set a GL account in the Debit field. Credit field must be empty. Type an invoice no. for an existing
customer transaction in the Cross reference field. It is also possible to perform a lookup F12 on the Cross
reference field to get all customer transaction for all customers.

Set a GL account in the Credit field. Debit field must be empty. Type an invoice no. for an existing supplier
transaction in the Cross reference field. It is also possible to perform a lookup F12 on the Cross reference
field to get all supplier transaction for all suppliers.

The original cross reference functionality with regards to filtering of the Cross reference field based on
ledger will be fixed in a future version.
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Visma Document Center 8.00.1

Topics:

• Improvements 8.00.1
• Known Issues, Limitations

& Restrictions 8.00.1

In version 8.00.1 of Visma Document Center we have implemented a
number of important bug fixes. This version are in addition to earlier
supported versions, also supporting backward compatibility with some
older versions of Visma Global and Visma Business
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Improvements 8.00.1

General

Use of +button for preregistration with multiple line

In the Accounting grid the + button on the keyboard now calculates and inserts the difference net amount
for pre-registered invoices with multiple lines.

Translations and Icon
Translation of various texts have been fixed and update of an Icon.

Improved interpretation quality when left aligned OCR output
For invoices with vertical text on the left side, the interpretation quality has been improved.

Callback of documents when using Visma.net Approval
Documents called back from Visma.net Approval should now be more robustly handled when connection
issues with Visma Business.

Visma Global

Performance improvement on look up for general ledger accounts.
Look up on general ledger accounts with tax classes has been improved.

Visma Business and Visma Global

Support for earlier ERP versions
In addition to supporting Visma Business 8.00.0 and Visma Global 7.80 , this release supports integration
with Visma Business 5.21.x, 5.31.x and 5.32.x, as well asVisma Global 7.70

Known Issues, Limitations & Restrictions 8.00.1

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Booking periods on documents after upgrade of server with AccountView integration

Transfer of document with missing booking period fails when integrated with AccountView
Default booking period will not be set for documents with flow status Approving or Complete after an
upgrade of Visma Document Center to version 8.00.0.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents cause an error when trying to send document to the ERP.

The workaround for this is to open the Edit document properties window and set the booking period on
the document.

Cross reference with Visma Global

Cross Reference in Visma Global Visma Global
With the changes for supporting lookup on invoice number without Debit or Credit account set the
functionality for Cross reference is changed.
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To be able to registrar a cross reference in Visma Document Center 8.00.0 one of the following  methods
must be used:

Set a GL account in the Debit field. Credit field must be empty. Type an invoice no. for an existing
customer transaction in theCross reference field. It is also possible to perform a lookup F12 on the Cross
reference field to get all customer transaction for all customers.

Set a GL account in the Credit field. Debit field must be empty. Type an invoice no. for an existing supplier
transaction in the Cross reference field. It is also possible to perform a lookup F12 on the Cross reference
field to get all supplier transaction for all suppliers.

The original cross reference functionality with regards to filtering of the Cross reference field based on
ledger will be fixed in a future version.

Links to other documentation page

Links to other documentation is not working in the Visma Help Viewer.
The links to other documentation page is not working in the Visma Help Viewer when Offline mode is
selected. Please use Online mode. The Offline mode will be fixed in a future version.
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Visma Document Center 8.00.0

Topics:

• New features 8.00.0
• Changed features 8.00.0
• Improvements 8.00.0
• Known Issues, Limitations

& Restrictions 8.00.0

In version 8.00.0 of Visma Document Center we have introduced a number
of new features, implemented a number of important bug fixes and made
some other improvements which are described in this section.
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New features 8.00.0

Branding

New Branding
Providing a branded graphical design with consistent appearance throughout the Visma Business product
line. New icons, banners login and splash screen.

Technical

Technical Framework
The platform has been updated to use Microsoft .NET Framework 4.5.2. This has been done to harmonize
the common dependencies and reduce the total footprint of technical dependencies in the Visma Business
product line.

Note:  Windows XP is no longer supported with the introduction of Microsoft .NET
Framework 4.5.2.

Visma help viewer

Use the Visma Help Viewer
Visma Document Center has a new help viewer. Pressing F1 will continue to open the user guide but will
use the new Visma Help Viewer. The News and Improvements will also be displayed using the help viewer.

The user documentation is now read from our Visma server, with a fall back to a locally installed
documentation if the server is not available. Having the user documentation on an on-line server allows us
to modify and improve documentation independent of releases and customer installations.

The PDF files for both the most recent and earlier version of the News and Improvements documents are
accessible through the help viewer in the chapter Links to other documentation, as well as in the Visma
Document Center program installation folder.

Shortcuts

New shortcut keys
The new shortcuts available are:

• Ctrl+1 - Shortcut key for move focus to the current document in the document list.
• Ctrl+2 - Shortcut key for selecting a row in Accounting tab.
• Ctrl+3 - Shortcut key for copying a row in Accounting tab.
• Ctrl+Alt+PageUp - Move to the top of the current page of the document in the Image viewer.
• Ctrl+Alt+PageDown - Move to the bottom of the current page of the document in the Image viewer.

System status and log file handling

System status related to Configuration GUI
We have created a new view, accessible to a user with Administrator role, where information about the
system state is displayed. This information can be useful before changing the system configuration. This
window also allow quick download or sending of the active log files.

On the System status menu, click Tools to access the System status window.

System Configuration Interface

System configuration related to Configuration GUI

The new System configuration window allows for the Administrator to change the settings through a
configuration GUI instead of editing configuration/XML files or making changes in the database.

The System configuration can be accessed in the System settings window as a new tab called System
configuration window. The menu is available for users with Administrator rights.
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System configuration window allows changing the following settings:

• System database configuration

• SQL Server name
• SQL Server Authentication mode
• System database name

• Autoimport configuration: the Administrator has the possibility to change the auto import directory.
• Visma Business configuration : the Administrator has the possibility to change the System account user

name field and System account password  field
• Setting of Log severity level

• VDC Server Log severity level
• VDC Client Log severity level

Broader support for PDF files

Improved support for PDF file formats
We have updated the Omnipage component to the latest version which gives us a better support for
additional PDF file formats.

The Auto-Import interface now supports import of PDF files.

Import of PDF attachments from Visma AutoInvoice
Visma Document Center now support attached PDF files from Visma AutoInvoice.

UBL

Extended UBL support
Support for OIO-UBL and Dutch UBL 2.0 has been added.

Pre-registration Visma Business and Visma Global

Pre-registration Visma Business and Visma Global

We have extended the pre-registration functionality in Visma Document Center with:

• The entry line for pre-registration are marked with orange color to visibly state it is a pre-registration
post.

• Hidden posting of the corresponding interim accounting line
• Hidden lines are supported in Visma Approval Center

Visma.net Approval

Approval Integration Status

We have created a separate view accessible to the Administrator user where the Visma.net Approval
integration status is displayed in an easy structured form.

• Easy to check if the On Demand Bridge has notified it's state as running and time of last notification.
• Easy to check if the connection with the OnDemand platform is alive.
• A brief summary of the most recent errors that occurred.

To access the Approval Integration Status dialog, on the Tools menu click System status, and then
Approval Integration Status.

Automatic company registration in Visma On Demand and activation of Visma.net Approval
To simplify the process of creating a new company in Visma On Demand and activating Visma.net
Approval for that company, this is now done automatically when activating Visma.net Approval in Visma
Document Center

Lookup on cost centres - Visma Global and Visma Business

Look up on cost centres in the Document list filters
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Document list filters now support lookup on project accounts (cost units) from the ERP.

AccountView

Automation of data entry in Accounting tab
Entering of accounting data has been automated by updating accounting fields with default entries based on
supplier (creditor).  The field values will be sent from AccountView.

Booking period - new editable field
In AccountView the users can decide in which period the costs should be booked. In order to make the
booking process more efficient, the Booking period field has been made available and editable in the
document header in Visma Document Center.

Nova

Visma Nova - order match
Visma Nova users can match supplier invoices in Visma Document Center with Visma Nova purchase
orders for better purchase management and control.

Visma Nova Multi environment Support
Visma Document Center now have support for multiple Visma Nova clients connecting to the same VDC
server.

Visma Nova Document Path
Visma Document Center version 8.00.0 and Visma Nova version 8.5 now have support for setting a
company specific document path. The document path is set in the Visma Nova user interface on the
following location: Settings\Company data\Additional Information\Visma Document
Center On this location the Visma Document Center documents are stored.

Changed features 8.00.0

Visma Business order match

Match an incoming invoice to a purchase order in Visma Business.

When matching an incoming invoice to a purchase order in Visma Document Center, the purchase order
is locked in Visma Business. When the purchase order is locked, it is not possible to perform Received
invoice in Visma Business. The lock in Visma Business is released when the invoice is approved either in
Visma Document Center or Visma.net Approval.

Cross Reference - Visma Global and Visma Business

Accounting office improvements - cross reference.

To increase efficiency of the invoice handling for accounting offices, the cross reference integration with
Visma Business and Visma Global has been improved. It is now only necessary to set an invoice number
in Visma Document Center to perform cross reference. Visma Document Center now also supports invoice
numbers that starts with the number zero.

Improvements 8.00.0

General

Navigation in Document Viewer - Flip/Rotate
Users with user role Approver will now be able to use the Flip vertical, Rotate clockwise,Rotate counter-
clockwise and Invert options in the Document Viewer.

Calculation of document deadline
Document deadline was incorrectly calculated. This is now fixed and a deadline warning will appear when
deadline equals today's date.
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Length of organizational unit name
Organizational unit names up to 100 characters are now supported. This length is consistent with the
supported length in Visma Business.

Calculation of VAT amount
Debit turn class was incorrectly considered when calculating VAT amount. This is now fixed and VAT
amount is correctly calculated.

Document header vs accounting header - synchronization
Synchronization between Accounting tab and Edit document window was not working correctly. When
Accounting tab was updated the changes related to Bank account field were not propagated to the Edit
document window. This is now fixed. When supplier account is entered in Credit account field on the
Accounting tab (first accounting line) the Bank account field in the Document list will be also updated.

Option Set current page as first page
The function Set current page as first page is now fixed and works as expected.

Storage of merged documents in target folder only
Merged documents are now moved into the folder where the target document is stored.

Ctrl-E should be disabled when document is already sent on flow to Visma.net Approval
The option Add recipients to a document through the shortcut Ctrl+E has now been disabled when a
document is already sent on flow to Visma.net Approval. The Add Recipients button is also disabled.

Shortcuts fixes
Both Ctrl+I and Ctrl+K are now working as designed.

Setting of customer in Debit account or Credit account updates the Customer No
Entering a customer in the Debit account or Credit account fields now updates the Customer No field.

Cash amount field - editing
The Cash amount field can now be edited and the value will be saved.

Edit Document window - Alphanumeric values accepted
When an alphanumeric value is entered in the Edit Document window, the Select order window is opened.

Report - Documents on flow
In the report showing documents on flow, a document is now listed only once in the All documents on flow
section.

Account lookup on Credit invoices
When imported document is identified as a Credit invoice the Debit account lookup will show Suppliers
accounts and the Credit account will show GL accounts from the ERP.

Both VAT code ID and name will be displayed
AccountView use VAT code names but those were previously not visible in the Visma Document Center
VAT code field. This is now fixed, and in the new version both VAT code ID and name will be diplayed.
VAT code name will appear between brackets in the same field as VAT code ID.

Change of language - Document remains selected
After changing the language the currently selected document now remains selected.

Error when inverting a document
An error message no longer occurs when inverting a document.

Corrected typo in Order match window with Norwegian language.
The field Valuta faturapris in the order match screen is now spelled correctly.

Selection of processing profile with enter
Solved issue where the wrong processing profile is selected when using the enter button.

OrderMatch - update of inventory
When updating an order in the Order form, the inventory is also updated.

Selection and filter on Voucher lines
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The vouchers are now selected based on the VismaId field which should contain the Visma Document
Center document id. If the document has a voucher number, this is also used to filter the displayed Voucher
lines.

Append page and voucher number
The Voucher No field now remains at the correct value after a page is appended.

Accounting field - limitation of text length
The Text accounting field is now limited to 255 characters by truncation. Previously an exception was
displayed if the field had too many characters.

XML interpretation – e2B – Interpretation of cost units
XML interpretation (e2b) will validate cost units by matching them with existing cost units in the ERP and
set them on the Accounting tab.

XML interpretation and date-format
XML date validation for unknown invoice types are changed to use exact date-formats.

XML Import - Delete PDF
When the Add document form file (move) option is used for importing XML files and the XML file was
linked to a PDF, the PDF file was not deleted. This is now fixed.

Add and append page - user rights issues (Visma Global and Visma Business)
You are now able to Add a page or Append page to the document. This previously failed with the error
message No rights to perform this operation.

New Accounting tab field
New field in the Accounting tab called Invoice details for Visma Nova. The value written on the first
Accounting tab in this field will be sent to the Note field in Visma Nova.

Accounting line - deletion of line
When deleting an Accounting tab, the wrong line was deleted. This is fixed and the correct Accounting tab
is now deleted.

Line approve list - display of recipients
Line approver list will now display the same recipients as Recipient selection form.

Invoice number field - warning if more than 25 characters
Invoice number field does not allow more than 25 characters. If more characters are entered, a warning
message will appear when the user try to save the value in Edit Properties  window.

Setting of supplier - VAT code is reset
When entering a supplier in the Credit account field the VAT code is set to 0.

Distribution keys with Swedish Visma Global
For existing documents, the distribution lines have to be re-generated by deleting the existing ones and the
accounting header.

Setting of cross GL accounts
The cross GL account is now correctly set in the Credit account field when a supplier is entered in the
Debit account field.

Voucher type updated - no change to Due date
When the Voucher type field is changed, the Due date is not updated.

Document viewer - Displaying selected documents
When selecting documents with shift+arrow-down, then select shift+up/down, the correct document are
now displayed in the Document viewer.

Cost accounts in Accounting tab
Cost accounts are now fetched on all lines in the Accounting tab in case that supplier is manually entered.

Invoice number field cut when transferring to Visma Nova
In Visma Nova the Invoice number field is 20 characters while in Visma Document Center it is 25
character long, this mismatch lead to an error when trying to transfer documents to Visma Nova. This is
now solved so that when the entered invoice number is longer than 20 characters inVisma Document Center
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it is trimmed to 20 characters. The user is notified about this by a message saying: "Invoice number too
long. Value truncated at 25". Transfer to Visma Nova is now possible this way.

VAT method handling
VAT-method handling works differently when transferring invoice to Visma Nova. VAT-method setting is
fetched from number series and net/gross is selected based on the VAT-method setting. VAT method setting
can have the following values: 1 -> net method 2 -> gross method empty -> based on setting in account.
There was an issue related to the last setting "empty" and this is now fixed in version 8.00. In case that this
setting is "empty", VAT method is based on setting in account.

ERP button handling
When more documents with the same voucher numbers but with different accounting year existed in the
ERP, the show ERP button has shown all data on the first document and empty lines for the other ones. This
is has been fixed and now the correct ERP data for each voucher is shown.

Scandoc status
After a document has been approved in Visma Document Center and transferred to Visma Business the
Scandoc status is set to 4 - Document finished. This is the final status for a document. However the status
is changed to 1 when the Add file button is used. This has been fixed.

Voucher transfer failure
When the Voucher no. control option is active in Visma Business and if the selected batch of documents
does not fit into the voucher number range, the transfer of a new voucher generates an error message and
the transfer is aborted.

Document Reinterpret changes persistent
When doing Reinterpret in case the document was modified, the changes where not persisted. Now the
user is prompted if it desires to save the changes.

When only Voucher date and Supplier fields are found during interpretation the Due date is set according
to Standard payment terms in Visma Business.

Cost unit responsible name
The cost unit responsible name is now displayed in the cost unit search form.

Ignore leading and trailing spaces when entering the CustomerID and Activation Key
In order to ease the license activation, the leading and trailing spaces will be ignored when entering the
CustomerID and Activation key in the License activation window.

PDF import improvements

Support for a larger range of PDF documents.
Visma Document Center has upgraded the PDF reader so it supports a larger range of PDF documents.

PDF - drag and drop
PDF's with a color-logos are now handled more gracefully.

PDF import - large number of pages
Visma Document Center now handles the import of large PDF documents.

Scanning and OCR interpretation

Danish OCR - Interpretation of alphanumeric invoice number
Alphanumeric invoice number is now correctly interpreted in Danish OCR.

Danish OCR - space used as separator in number
White spaces are now ignored in numbers, e.g. 1 000 is interpreted as 1000.

Improvements on Swedish CID check
The Interpretation results screen now handles Swedish CID numbers more gracefully.

Norwegian OCR - "/" supported in invoice number
The xxxxxx/xxxxxx invoice number format is now supported.

Dutch OCR - Interpretation of Amount
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Amount is correctly interpreted on invoices using the following keywords: incl. BTW, Totaal bedrag, Totaal
and Totaal E

CID not interpreted correctly
When interpreting a CID field separated by dots, the interpretation would fail. We now allow for dots in the
CID field (ie: the Dutch "Onze referentie") and the field will now be interpreted correctly.

E-mail improvements

E-mail scheduler - change of date format
Changing date format influence the e-mail sending functionality. When there are scheduled e-mail sending
tasks on the server, and date format is changed, those tasks will not be executed. Relevant information will
be posted in the Server log files.

E-mail reminder - only for overdue documents
Reminder will now be sent only for overdue documents and not be sent for all documents the user has for
approval.

E-mail notification - scheduled time
The notification e-mail is sent to the recipient at the first "tick" of the server after the scheduled time.

E-mail notification - when recipient are removed from the flow
Only the recipient-B receives the e-mail notification if recipient-A is removed from the flow.

E-mail attachments - multiple pages as one tif file
Multiple-page invoices are now attached to e-mails as one tif file with multiple pages.

E-mail settings - global and company specific settings
Global e-mail settings and Company specific settings can be saved and loaded, based on the user options.

E-mail template - texts are available in all supported languages.
The Subject and Message text fields will now change based on the language selected.

Note:  When upgrading to Visma Document Center 8.00.0 all customized e-mail notification
templates will be deleted and overwritten with default templates.

AccountView

Due Date and Payment terms
When working with AccountView the Due date is calculated based on the supplier's payment term, even if
a due date is already set.

Visma Global

Calculation of VAT - Tax deductable input VAT
There was an inconsistency in calculating VAT amount when Tax deductible input VAT was different
from 0. This is now fixed and Visma Document Center is now consistent with Visma Global when
calculating VAT amount field.

User rights on OrderMatch users
When a user that has the role Approver tries to update an order, the Insufficient privileges message box
now will appear. Document status does not change and no data is transferred to Visma Global. The user
must have at least APPROVER EDIT COST UNITS role (13)

Quantity field - transfer of decimal to global.
The Quantity filed is now correctly transferred to Visma Global, including decimals.

Receiving goods in Visma Global when performing order match in Visma Document Center.
When performing order match in Visma Document Center with the option Receive goods on order match
enabled, the stock in Visma Global is now updated.

Visma Business

Search on column R7 to R12
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Fixed a problem where the user was unable to search on column R7 to R12.

Display of VAT amount in Document list
The VAT amount was incorrectly displayed for Visma Business. This is now corrected. VAT amount and
Description is available only when working with AccountView.

VAT amount value not deleted when Amount Excl VAT is input
VAT amount value is not deleted when Amount Excl VAT is input and the amount field is updated with
VAT amount + Amount Excl VAT value.

Voucher type and Ignore VAT code
Ignore VAT code is now taken in account. VAT code will not be displayed on the voucher line, but VAT
amount is still calculated.

Visma.net Approval

Duplicate cost units sent to Visma.net Approval from Visma Business
The on demand bridge is no longer transferring duplicate cost units from Visma Business.

Reminder mail is not sent when Visma.net Approval is activated.
If a company starts using Visma.net Approval for approving documents no e-mails are sent from Visma
Document Center.

Rejected flows that are re-sent create "Unknown pending handle"
Unknown pending handle messages are no longer displayed when a work flow is sent multiple times
to Visma.net Approval.

Visma.net Approval dates are incorrect
When a workflow is sent to Visma.net Approval the dates in the Workflow are now correct when the
document is sent back to Visma Document Center.

Known Issues, Limitations & Restrictions 8.00.0

SQL Server 2012

Document ID - Consecutive values after Microsoft SQL Server 2012 restart
Microsoft SQL Server 2012 might cache identity values for performance reasons and some of the assigned
values can be lost during a database failure or server restart. This can result in gaps in the identity value
upon insert. You may observe that the Document ID jumps in steps of 1000 (ex. from 26 to 1027), when
using Microsoft SQL Server 2012. This does not have any impact on the operation of Visma Document
Center.

Booking periods on documents after upgrade of server

Transfer of document with missing booking period fails
Default booking period will not be set for documents with flow status Approving or Complete after an
upgrade of Visma Document Center to version 8.00.0.

The booking period is not set since the booking period is only set when applying the document profile.

Missing booking period on the documents cause an error when trying to send document to the ERP.

The workaround for this is to open the Edit document properties window and set the booking period on
the document.

Cross reference with Visma Global

Cross Reference in Visma Global Visma Global
With the changes for supporting lookup on invoice number without Debit or Credit account set the
functionality for Cross reference is changed.

To be able to registrar a cross reference in Visma Document Center 8.00.0 one of the following  methods
must be used:
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Set a GL account in the Debit field. Credit field must be empty. Type an invoice no. for an existing
customer transaction in theCross reference field. It is also possible to perform a lookup F12 on the Cross
reference field to get all customer transaction for all customers.

Set a GL account in the Credit field. Debit field must be empty. Type an invoice no. for an existing supplier
transaction in the Cross reference field. It is also possible to perform a lookup F12 on the Cross reference
field to get all supplier transaction for all suppliers.

The original cross reference functionality with regards to filtering of the Cross reference field based on
ledger will be fixed in a future version.

Interpretation quality after upgrade of Omnipage component

After upgrade of the Omnipage component the interpretation result can vary dependent of the layout
of the imported invoice.
In case of reduced quality in the interpretation results, we recommend using templates if possible.

Links to other documentation page

Links to other documentation is not working in the Visma Help Viewer.
The links to other documentation page is not working in the Visma Help Viewer when Offline mode is
selected. Please use Online mode. The Offline mode will be fixed in a future version.
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Extended information

Topics:

• Additional voucher types
with Visma Contracting

• Import of documents from
Visma.net Approval

• Accrual accounting and
Apportionment with Visma
Contracting

• PDF import
• System status

This section give you a short introduction to some of the features since
version 8.00.0.
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Additional voucher types with Visma Contracting
When Visma Document Centeris integrated with Visma Contracting the following voucher types are
supported.

Visma Document Center supports the following voucher types in Visma Contracting:

• Payments
• Incoming invoice
• Outgoing invoice
• Cash
• Sundry

The combination of voucher type and sign (+ or -) decides how the lookup behaviour in VDC accounting
grid behaves when it comes to default lookup lists for debit and credit.

Import of documents from Visma.net Approval
When Visma Document Center is integrated with Visma.net Approval it is possible to import documents
uploaded to Visma.net Approval

Accrual accounting and Apportionment with Visma
Contracting
When Visma Document Center is integrated with Visma Contracting both Accrual accounting and
Apportionment can now be defined in Visma Document Center.

Accrual accounting

In version 8.01.0 a field in the Accounting grid with the name Period key is available. The Period key
makes it possible to use the period keys from Visma Contracting to perform accrual accounting. The Period
key is set automatically if a General Ledger account is set in either the Debit account or Credit account
field with a reference to a period key in Visma Contracting.

If the selected General Ledger account has a reference to a period key, the period key can be changed or
deleted. If the General Ledger account does not have a reference to a period key, it is not allowed to set a
period key.

Note:  The accounting lines for accrual accounting is not created until the batch is transferred to
Visma Contracting.

Apportionment

In version 8.01.0 a field in the Accounting grid with the name Department key is available. The
Department key makes it possible to use the department keys from Visma Contracting to perform
apportionment. The Department key is set automatically if a General Ledger account is set in either the
Debit account or Credit account field with a reference to a department key in Visma Contracting.

Note:  The accounting lines for the apportionment is not created until the batch is transferred to
Visma Contracting.

PDF import
As of version 8.00 for Visma Document Center we have broader support for PDF files and allow for PDF
import via the Auto-Import folder and through Visma AutoInvoice.
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The handling of PDF files is now available on the Visma Document Center server side. You can place PDF
files in the Auto-import folder and these will be automatically imported.

With Visma AutoInvoice the invoices are imported with the selected XML format. Before version 8.00 the
PDF files supplied with the XML Invoices (if any) by Visma AutoInvoice were converted by the Visma
Document Center server to the .Tiff format. This was causing problems in certain occasions and this is now
no longer needed as we accept the PDF files now.

System status
We have created a new view, accessible to the Administrator where we display information about the system
state. The information displayed here could be useful before changing the system configuration. This
window also allow quick download or sending of the active log files. To access the System status dialog, go
to Tools > System status.

The System Status dialog present the following information and also allow log file handling:

• Approval Integration Status: see more details in the Approval Integration Status Section.
• Server status.
• Number of clients started on the server and the user names of the users logged on.
• Companies available in Visma Document Center .
• Log Files handling. The following operations are accessible on the right click menu:

View log
allow view of active log files from Visma Document Center client.

Save log
allow download of active log files and store them on the location chosen by the user.

E-mail log
allow sending of active log files on mail.

The refresh button will only update the information in the dialog if any new data is made available to the
Visma Document Center server.
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Appendix

A
Shortcuts

An overview of all available shortcuts

CTRL + F Activate first cell in blue search line when document list
is activated

CTRL +
SHIFT + F

Open the search form

CTRL + 1 Focus on active document in document list

CTRL + 2 Activate the accounting line

CTRL + 3 Duplicate selected row(s)

CTRL + H Open “select columns” (dependent on witch control is
active)

CTRL + U The same as CTRL + H

CTRL + I Insert row in accounting row

CTRL + O Import document from file with move

CTRL +
SHIFT + O

Import document from file with copy

CTRL + Q Import documents with blank page as a divider with move

CTRL +
SHIFT + Q

Import documents with blank page as a divider with copy

CTRL + M Merge documents in the document list

CTRL + T Apply a processing rule to a document

CTRL +
ENTER

Activate flow

CTRL + E Alter document flow

CTRL +
SHIFT + E

Send document(s) to ERP

CTRL + Y Approve a document

CTRL + R Reject a document

CTRL +
SHIFT + R

Forward a document

CTRL +
SHIFT + Y

Review a document

CTRL + N Add a new note to the document

CTRL + L Activate the login form

CTRL + D Split a document



Visma Software International AS | Shortcuts

© Visma Software International AS | 233

CTRL + S Save note (when it is not written during approval)

CTRL + K Move to the first cell in the accounting row wherever you
are

CTRL + G Make the accounting row tab active

CTRL + W Make the workflow tab active

CTRL + A Select all documents. Works only when document list has
focus.

  

F1 Help

F2 Edit fields in the document list

ALT + F4 Quit the application

F7 OCR & Interpret

CTRL + F7 OCR & Interpret on all pages

F8 Scanning series

CTRL + F8 Scanning series with divider

CTRL +
SHIFT + F8

Scanning new

F6 Navigate between controls in this order

• The four different lists
• Document list
• Picture viewer
• Comments
• Accounting line

SHIFT + F6 Navigate in the opposite direction of F6

  

Page Down Moves downward one page at a time in the document list
or accounting row, depending on which item is active

Page Up Moves upward one page at a time in the document list or
accounting row, depending on which item is active.

  

CTRL +
“+” (CTRL
and +)

Zoom in functionality in the image viewer

CTRL +
“-“ (CTRL
and -)

Zoom out functionality in the image viewer

  

CTRL +
ALT + End

Move to the bottom in the image viewer

CTRL +
ALT + Home

Move to the top in the image viewer

CTRL +
ALT +
PageUp

Move to the top of the current page of the document in the
image viewer
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CTRL +
ALT +
PageDown

Move to the bottom of the current page of the document
in the image viewer

  

CTRL +
SHIFT +
Right Arrow

Move to the right in the image viewer

CTRL +
SHIFT +
Left Arrow

Move to the left in the image viewer

  

CTRL + End Move to the bottom in the document list.

CTRL +
Home

Move to the top in the document list.

  

ALT Activate the menu
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